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Radio and television interference
The equipment described in this manual generates and uses radiofrequency energy. I f it is not installed and used properly-that is, in strict
accordance with Apple's instructions--it may cause interference with radio
and televisio n receptio n.
This equipment has been tested and complies with the l imits for a Class 11
computing device in accordance with the specifications in Subpart J,
Part 15, o f FCC rules. These rules are designed to provide reasonable
protectio n against such interference in a residential installatio n. H owever,
there is no guarantee that the interference will not occur in a particula r
installatio n , espec ially if a "rabbit-ear" television antenna is used . (A
rabbit-ear antenna is the telescoping-rod type usually fo und o n television
receivers.)
You can determine whether your computer is causing interference by
turning it off. If the interference stops, it was probably caused by the
computer or its peripheral d evices.

n

If your computer does cause interference to radio or television receptio n,
you can try to correct the interference by using o ne or more of the
following measures:
o Turn the television o r radio antenna until the interference stops.
o Move the computer to o ne side or the other o f the television or radio .
o Move the computer farther away fro m the television o r radio.
o Plug the computer into an o utlet that is on a d ifferent circ uit than the
television or radio. (That is, make certain the computer and the radio or
telev ision set arc o n c ircuits controlled by different circuit breakers or
fu ses.)
o Consider installing a rooftop televisio n antenna with a coaxial cable leadin between the antenna and televisio n set.
If necessary, consult your authorized Apple dealer or an experienced
radio/television technician for add itional suggestions.
You may find helpful the following book let, prepared by the f-ederal
Communicatio ns Commissio n: " H ow to I dentify and Resolve Radio-TV
Interference Pro blems." This booklet is available from the U.S.
Government Printing Office, Washington, DC 20402.

Important

X

This product was FCC-certified under test conditions that included use of
shielded cables and connectors between system components. It Is
important that you use shielded cables and connectors to re duce the
possibility of c ausing Interference to radios. t elev ision sets. and other
electronic devices. For Apple peripheral devi ces. you c a n obtain the proper
shielded cable from your authorized Apple dealer. For non-Apple peripheral
devices. contact th e manufacturer o r dealer for assistan ce.
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Preface
Welcome to Macintosh II

-

In 1984 Apple introduced a computer unlike anything before it-the
Apple® Macintosh™ computer. Easy to learn and use, the
Macintosh revolutionized the world's perceptio n of compu ters. But
the innovations didn't stop there. The Macintosh has become more
and more powerful: Now it has eight times the memory capacity of
the original Macintosh 128K, it's expandable, and it uses more
sophisticated system software. And with hundreds of application
programs and a generous variety of optional devices to support it,
the Macintosh can do more work-faster and better than ever.
This manual introduces you to the new Apple Macintosh II
computer. Use the manual now to learn basic Macintosh skills, and
pick it up again later to use as a reference. You don't need to know
anything about the Macintosh II o r any other computer to use this
manual. And you won't have to keep l earning new ways of doing
things. Once you've mastered a few new techniques, you'll use them
w henever you use your computer.

•!• Computer-guided tour: You can also take a gu ided tour of the

-

Macintosh II by using the training disk called Your Apple Tour of
the Macintosh II In the tour , your Macintosh II demonstrates
itself, introducing-in a different way-some of the same skills
this manual teaches.
Here's an overview of what's where in this manual:
Chapter 1, "Setting Up Yo ur Macintosh II," shows how to put
wgether the mo dules of your computer-the monitor, the mouse
and the keyboard-a nd how to install the v ideo card for you r
monitor.

XV

Chapter 2, "Learning About Your Macintosh II," teaches you how to
use the mouse and keyboard to operate your computer, and to get
started with your own work (including how to create it, make changes
to it, and store it to disk). It also shows you how to start the training
disk Your Apple Tour of the Macintosh Il
Chapter 3, "Your Macintosh II Step by Step," provides easy stepby-step instructions for organizing, managing, and storing the
things you create.
Chapter 4, "Macintosh II Reference," explains the Macintosh
interface-the way you interact with the computer no matter what
programs you're using.
Chapter 5, "Expanding Your Macintosh II System," tells you how
your computer's capabilities can grow with the addition of new
products. It also explains some of the applications you can get, and
what those applications can do for you.
Chapter 6, "Taking Care of Your Macintosh II," gives you
information on how to keep you r computer running at peak
efficiency-and what to do in case something goes wrong.
Appendix A, "Working With Hard Disks," shows you how to get your
hard disk ready for use, and how to use it most effectively once it's
set up.

n

Appendix B, "Macintosh II Specifications," provides the technical
details of your computer.
Appendix C, "Expansion Cards and Power Requirements,"
explains how to figure the power available for the expansion slots.
The glossary defines all the special Macintosh terms you'll come
across in this manual.
The index lists the page references for all the topics covered in this
manual.
•!• 7he Quick Reference Card: The Quick Reference Card that

accompanies the manual describes some shortcuts you may want
to learn as you become more familiar with your Macintosh 11.

How to use this manual
No matter how much experience you've had with computers, read
Chapter 1 to see how to set up you r Macintosh II. What you should
do next depends on your level of computer expertise.

xvi
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For the beginner
To start learning about your computer, you can use the training disk
called Your Apple Tour of the Macintosh II; where you'll learn the
basics of using an Macintosh II, with the computer itself as your
tutor. (Chapter 2 tells you how to get the disk started.) Using the
training disk is an entertaining, fun way to learn, and if you make
any mistakes, the computer lets you know and gets you back on
track. Or you might prefer to go through the written tutorial in
Chapter 2 instead. They cover the same material, but in a slightly
different way. Many people go through the disk and the tutorial.
The idea is to learn in ways that are most comfortable for you.

After the tutorial

....

When you've finished Your Apple Tour of the Macintosh II or the
tutorial (or both), you have several options. You can start up the
second training disk, Your Apple Tour of Macintosh II
Applicatlonsi this disk will give you an overview of the kinds of
applications available for your Macintosh II and how they're used.
Then you can continue on with this manual or go to the manual that
came with the application you're going to use.
Return to Chapter 3 of this manual when you want to know more
about organizing your work or performing specific tasks. Chapter 3
gives step-by-step instructions.
Use Chapter 4 for reference; it covers material you're less likely to
need right now.
Chapter 5 explains the optional equipment and application
programs available for the Macintosh II.
Read Chapter 6 sometime soon to learn how to keep your computer
clean and running up to snuff.

...

You'll also probably want to use the glossary of Macintosh terms
and the index at the back of the book. The index is especially helpful
when you need to find step-by-step instructions for carrying out
specific Macintosh IT tasks.

How to use this manual

xvil

For the already initiated
If you've already had some experience using a Macintosh
computer, you can probably skip the training disk and the tutorial in
Chapter 2. The keyboard layout on the Macintosh II is somewhat
different from most earlier models, however; see The Keyboard"
in Chapter 4 and, if it applies to you, "Apple Extended Keyboard"
in Chapter 5.
11

Depending on which Macintosh you've used, you might not have
experience with the hierarchical me system. This me system lets
you organize your folders, applications, and documents in a more
efficient way than was possible on older Macintosh computers.
You'll find details in The Hierarchical File System" in Chapter 4.

~
I

'

11

Your Madntosh II works with a number of optional devices: two
styles of keyboard, internal and external hard disks, a second
internal 3.5-inch disk drive, and more. Additionally, it can work
together in new ways with printers, file servers, and other computers
on the AppleTalk® Personal Network. Read Chapter 5 for details.
Important

If you already own a Macintosh and have application disks you
use as startup disks, you'll want to update the system files on
those disks to take advantage of new features. However, If you
plan to use the same application disk as a startup disk on the
Macintosh II and on an earlier model of Macintosh computer,
don't update the disks until you have read "'Startup Disks" in
Chapter 4.

For the advanced user
This manual is not a technical reference manual. (You may already
have noticed that.) Appendix B contains some technical
information about the Macintosh II, but if you need more, look for
the Apple Technical Library-a series of official technical
publications from Apple Computer, Inc., and published by
Addison-Wesley Publishing Company, Inc. You'll find the Apple
Technical Library in most well-stocked bookstores.

xviil
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Another source for technical information abou t the Macintosh II
(and other Apple products) is the Apple Programmer's and
Developer's Association. For information about the association,
call (206) 251-6548. You can also write to
Apple Programmer's and Developer's Assodation
290 S.W. 43rd Street
Renton, WA 98055
You'll find a membership application for the Apple Programmer's
and Developer's Association in the box with your computer.
If you're an applications developer intereste d in creating programs
for the Macintosh, ask your authorized Apple dealer about the
Macintosh Programmer's Workshop-a programming
environment for the Macintosh that includes an assembler and C
and Pascal compilers. Version 2.0 (and any later version) supports
the Macintosh IT. If you plan to develop applications fo r sale
through retail channels, you can get valuable support from Apple
Developer Relations. Write to
Apple Developer Relations
Mailstop 27-W
Apple Computer, Inc.
20525 Mariani Avenue
Cupertino, CA 95014

User groups
Ask your dealer for the name of a Macintosh user group near you. If
you live in the United States, you can call (800) 538-9696 for the
name, address, and telephone number of up to three Macintosh
user groups in your geographical area.
Outside the United States, ask your dealer to get in touch with
The Boston Computer Society
One Cente r Plaza
Boston, MA 02108
(617) 367-8080

Berkeley Macintosh User Group
1442-A Walnut Street #62
Berkeley, CA 94709
(415) 849-9114

Either of these organizations can provide you with the name of a
Macintosh user group near you. You can also join either of these
groups or ask them for info rmation on starting your own Macintosh
user group.

User groups

xix

Setting up your Macintosh II computer is easy and takes only a few
minutes. If somebody has already set up your computer for you, you
can skip this chapter and go right to Chapter 2; there you'll learn
how to use your Macintosh II.

Unpacking
The frrst thing to do is to make sure you have everything you need to
set up a complete system. Take all the mate rials out of the packing
boxes and see if you have everything shown in Figure 1-1:

Monitor
Main unit power cord
~
...--'/:

---n~~~~-

(_ /~~

Figure 1-1
What you should have
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Check your packing lists to make sure you have everything. Then fill
out the registration card and mail it in. (The registration card asks
for serial numbers; you '11 fmd them either on the bottom or at the
back of each module.) In the unlikely event that something is
missing, call your authorized Apple dealer immediately.
•!• Different keyboard? Your keyboard might look different from
the one in Figure 1-1. Apple offers two keyboards: the Apple
Keyboard and the Apple Extended Keyboard. You can find out
more about the extended keyboard in Chapter 5, "Expanding
Your Macintosh II System."

Choose a sturdy place to set up your system-no card tables or
other surfaces that could be tipped or knocked over. To avoid glare,
pick a place where light won't be reflected into your eyes and you
won't be facing bright light.

....
I

Your computer needs to be plugged into a three-hole grounded
outlet. If you have more than two devices that need to be plugged
into the wall, you should get a grounding power strip. Available at
any electronics or hardware store, a power strip is like a wall socket
with four to eight outlets; many of these power strips come with an
on/off switch for convenience and a surge protector (which acts like
a circuit breaker if there's a surge of power on the incoming
electrical lines) .
•!• Save the packing material: Store away the boxes and all the

packing material. Repack your computer system if you have to
move it over long distances (that is, any distance that requires a
car or airplane) to protect the system from rough handling and
jarring. It's especially important to repack your computer if it
has an internal hard disk.

~
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Unpacking
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Before you go on, turn the main unit so that you're looking at the
back of it. Figure 1-2 shows you what the ports, connectors, and so
on are all about:

Monitor power output --------;::==================~--Expansion slot covers

Malnpawe,lnp~

/
~

"~~

l l lll lll lllllllllillll [C
iJTUY'O/

Power switch ---------+'~

~1

Soundjack- - - - -- - - - ----J
Apple DeskTop Bus ports- - - - --'--'
Apple Serial Interface ports _ _ _ _--£_,
SCSI port - - - - -- - - - - - - . . . . /

Figure 1-2
Back of the main unit

-

You will be using a number of these ports and receptacles as you set
up your Macintosh II. One item you'll fmd on the back of the main
unit, the power switch, is the re when you have to use it but is not
inte nded for regular use. In the normal course of events, you turn
on the compute r with the Power On key at the top of the keyboard,
and you turn it off by choosing Shut Down from the Special menu
that appears on the Finder screen. (Don't worry if these te rms are
new to you. You'll learn exactly w hat to do in Chapter 2, "Learning
About Your Macintosh 11. ")
If you e ncounte r a problem with the computer and for some reason
cannot use the Shut Down command to turn it off, you can push the
power switch instead. (Be sure you only push it once.) Wait a few
seconds, and the computer will turn itself off. Then you can start it
again by pressing the Power O n key. Note that this method of
turning off the compute r can be fairly drastic, and you may lose any
work you had not previously saved on a disk.

4
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Important safety instructions
You're almost ready to plug in your Macintosh ll, but first read these
important safety instructions.
Warning

This equipment Is Intended to be electrically grounded. Your
computer Is equipped with a three-wire grounding plug- a plug
that has a third (grounding) pin. This plug will fit only a
grounding-type AC outlet. This is a safety feature. If you are
unable to Insert the plug Into the outlet. contact a licensed
electrician to replace the outlet with a properly grounded plug.
Do not defeat the purpose of the grounding plug!

For your own safety and the safety of your equipment, always take
the following precautions:
Disconnect the power plug (by pulling on the plug, not the cord)
under these circumstances:
o if the power cord or plug is frayed or otherwise damaged
o if anything is spilled into the case
o if your equipment is exposed to rain or any other excess moisture
o if it has been dropped or if the case has been otherwise damaged
o if you suspect that your computer needs servicing or repair
o whenever you clean the case
Be sure that you always do the following:

-

o Keep all air vents clear. Leave 4 to 6 inches of clearance between
the vents on both sides of the main unit and any object that may
restrict air flow. If you place your monitor on top of the main
unit, it should not lie "flat"; make sure it sits at least 8 mm (.314
inches) above the surface of the main unit. (Apple monitors
come with little rubber "feet" to raise them the correct distance,
allowing for air to circulate properly.)
o Keep your equipment away from any source of liquid (such as
wash basins, bathtubs, and shower stalls). If you drink coffee
while you're at your computer, take care not to spill.
o Keep it protected from damp or wet weather.

Important safety instructions
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o Read all the installation instructions carefully before you plug the
product into a wall socket
o Keep these instructions handy for reference.
o Follow all instructions and warnings dealing with your system.
Warning

Electrical equipment may be hazardous If misused. Operation of
this product or similar products must always be supervised by
an adult. Do not allow c hildren access to the Interio r of any
electrical product . and do no t permit them to handle cables.

To clean the case:
1. Disconnect the power plug by pulling on the plug, not the
cord.
2. Wipe the case with a clean, soft cloth moistened with water.

Wipe the surfaces lightly, but do not wipe the monitor screen.
For cleaning the screen, use only a dry, sofl cloth.

Plugging it all together
Now you can begin to pull together the modules of your computer
system. Assemble the system in the order given in the next few
pages.

Connecting the power cord
The first step in assembling your compute r system is attaching and
plugging in the power cord. The plugged-in power cord acts as a
ground for the system, protecting its components from static
electrical discharge.

6
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To connect the powe r cord:
1. Connect the socket end of the power cord Into the main
power Input-the bottom receptacle on the right side,
viewed from the rear. (See Figure 1-2.)

The connector above the main power input is for the monitor
power output; you'll read about that in a moment.
2. Plug the other end of the power cord into a three-hole
grounded outlet.
Warning

Do not turn on the computer system until you've completed
the entire Installation process. Turning on the system at the
w rong time could result In electrical shock to you or cause
damage to your computer system's components.
If the power has been on. turn it off and wait at least 5 minutes
before connecting anything to or disconnecting anything from
your computer. There are several ways to turn off the
computer. If you know how to c hoose Shut Down from the
Special menu. do that. If you're still unfamiliar with how to use
such commands, push once on the external power switch
(found on the back of the main unit) and walt for it to shut Itself
down. (See Figure l-2 if you need help locating the power
switch.) If all else falls, pull the plug on the power cord (from the
three-hole grounded outlet).

Connecting the monitor
Apple provides color and monochrome monitors to go with your
Macintosh II. (They're described under "Monitors and Video
Cards" in Chapter 5.) Basic installation is the same for all the
monitors. The monitor connects to your computer through the
socket on a peripheral card (in this case, a video card) installed in
an expansion slot in the computer's main unit.
Here are the stages you'll go through to install your monitor. Right
after this general list, you'll find specific steps for each stage of the
procedure:
o installing the video card in the main unit
o connecting the monitor's video cable
o connecting the monitor's power cord

Plugging It a ll together
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Installing the video cord in the main unit
Follow these steps to install the video card.
1. Remove the lid from the computer's main unit. (See
Figure 1-3.)

o Using a Phillips-head screwdriver, loosen and remove the
security screw holding the lid to the main unit (It's at the top
center of the rear panel.)
o Wrap your hands around the rear corners of the case (as
shown in Figure 1-3).

Figure 1-3
Removing the lid

o Press on the latches as you lift up on the back of the lid.
o When you feel it release, lift the lid all the way off the case and
put it aside.
2. Touch the power supply case Inside the computer to
discharge any static electricity that might be on your
clothes or body. (See Figure 1-4.)

8

Chapter 1: Setting Up Your Macintosh II

Warn ing

It's OK to touch the power supply If you've just unpacked it.
However, the power supply can get hot In normal use. If the
computer has been on , shut It off and walt at least 5 minutes
before touching the power supply.

I
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Power supply case
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Figure 1-4
Touching the power supply case
3. Choose the expansion slot you want to use. (See
Figure 1-5.).

The expansion slots are the narrow, plastic strips running along
the bottom of the main unit, ne ar the b ack. Which one you use
doesn't matte r.
I/O shield
Expansion slots
Install vide o card.

'\.,
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Expansion
cover
shield ----+-
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c

Figure 1-5
Expansion slots and
e xpansion cover shield
Plugging it all together
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4. Remove the expansion cover shield that's behind the
expansion slot you plan to use by lifting up until the shield is
free of the guide and pin.

Save the shield; you will need it later if you take the card out of the
slot. The card itse lf has a shield attached to it that will replace the
shield you just removed.

J

5. Push out the plastic hole cover that lines up with the slot
you plan to use. (See Figure 1-6.)
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Hole cover

Figure 1-6
Re moving the plastic
ho le cover

o Grasp the cover with your thumb inside the computer and your
fingers outside.
o Push the cover out with your thumb and set it aside.
6. Insert lhe video card lnlo Ihe expansion slol.

o Pick up the video card by the top of the metal bracket and the
top of the card's other end. (Be careful not to touch the pins
on the bottom of the card.)
o The expansion cover shield on the card attaches to the inside
of the back panel in the same way as the shield you removed in
step 4. Align the card so that the guide fits through the lowe r
slot in the shield on the card and the p in sticks up slightly
through the hole at the lop of the shield. (See Figure 1-7.)

Figure 1- 7
Aligning the card
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o Align the connector on the bottom of the card, directly over
the slot.
o Place one hand along Lhe top edge of the card, directly over
the connector area, and push down firmly until the connector
is fully seated. (See Figure 1-8.)
Important

Don't force the card. If you meet a lot of resistance, pull the
card out and try again.
Don't wiggle the card from side to side when you Insert it.
Wiggling the card puts unnecessary stress on the card and slot.

Figure 1-8
Inserted card

You can test to see if the card is properly connected by lifting the
card gently. If it resists and stays in place, it's connected.
•!• Universal card installation: If you have purchased other

peripheral devices that require cards, install them now, too.
You can use this same method (that is, repeat steps 1 through 6)
for installing all expansion cards in your Macintosh II at any
time. Remember: if the computer has been running, let it cool
down for 5 minutes before you open up the main unit. Of
course, you should also read and follow any instructions that
come with other expansion cards you may have.

Important

If you plan to Install more than one card, see Appendix C for
details on the power available for the expansion slots.

Plugging It all together
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7. Replace the lid on the main unit. (See Figure 1-9.)
o Tip the front of the lid down so that it catches the three hooks
under the lid in the front of the main unit's case.
o Lower the back of the lid onto the case until the rear latches
snap into place.
o Replace and tighten the security screw.
Caution

When reinstalling the lid, ensure that It Is properly seated
before turning on the power. To check, press firmly down at the
two rear and three front latch positions.

Figure 1-9
Replacing the lid

Connecting the video cable
With the back of the main unit still facing you, place your monitor
near the main unit. Turn the monitor so that its back is also facing
you. Then follow these steps to connect the video cable. (See
Figure 1-10.)

1. Push one end of the video cable (both ends are the same)
Into the video socket on the back of the monitor.
The socket is marked with a video icon.
2. Tighten the thumbscrews on the jack to prevent the
connection from coming loose and to prevent radio and
television interference.
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3. Connect the other end of the video cable to the socket on
the video card, and tighten the thumbscrews.

Connect the cable to the card through the opening in the rear of
the computer.
•!• More than one card? If you have installed more than one

expansion card, be careful to plug the video cable into the
video card.
,_ j

l_

_

J

Figure 1-10
Connecting the video cable

Connecting the monitor's power cord
Follow these steps to connect the monitor's power cord. (See
Figure 1-11.)
1. Push the socket end of the monitor power cord into the
monitor power Input receptacle on the back of the monitor.

The plug is marked with a power icon.

Figure 1-11
Connecting the monitor power cord

Plugging It a ll together
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2. Connect the other end of the power cord to the monitor
power output receptacle on the back of the main unit.

The monitor power output is on the right side of the main unit,
just above the main power input receptacle.
For information about adjusting brightness and contrast (and
alignment, in the case of the color monitor), see the manual that
came with your monitor. But don't adjust anything yet; to save
yourself the trouble of turning around the monitor and main unit
again, wait until you've attached the keyboard and the mouse.

Connecting the mouse and the keyboard
There are several ways to connect.the mouse and the keyboard. The
steps below show how to connect the mouse to the keyboard and
finally how to connect the keyboard to the main unit. When you've
completed this procedure, you'll find information on alternative
ways to connect these devices.
•!• Avoid premature power on: The steps are presented in this

order so that the last thing you do is connect the keyboard to a
power source. Once the keyboard has power, anyone could
accidentally press the Power On key and turn on your computer
before it's appropriate.
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Place your keyboard near the back of the main unit with the
keyboard facing you. Then follow these steps.
1. Plug the mouse cable into the connector on the right side of
the keyboard. (See Figure 1-12.)

If you're left-handed, plug it into the connector on the left side.
This kind of arrangement is known as a daisy chain. an effect,
the mouse will be connected to the computer through the
keyboard.)

l_l
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Figure 1-12
Connecting the mouse
2. Plug one end of the keyboard cable Into the remaining
connector on the keyboard.

Plugging It all together
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3. Plug the other and of the keyboard c able into either of the
two round connectors on the back of the main unit. (See
Figure 1-13.)

The connectors are just to the right of the sound jack.
Your Macintosh II works with a variety of keyboards. Keyboards
may look different, but you attach them to the main unit in the
same way.

_j
; _ - GY-:;;W
Apple DeskTop Bus connectors - - - - -H-..........U

"'

IIIIIi

Figure 1-1 3
Connecting the keyboard to the main unit

Why two connectors?

The official name for this set of connecto rs is the Apple DeskTop
Bus™. It's called a bus because several different devices (the
keyboard, the mouse , and other Apple DeskTop Bus devices such as
a graphics tablet, a joystick, or another keyboard) can send information along one "bus : ne" to the compute r. Your Macintosh II
has two of these connectors. Figure 1-14 shows different ways to
connect other Apple DeskTop Bus devices.
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Figure 1-14
Alternative configurations

You might prefer to plug the mouse into the other connector on the
back of the Macintosh II, leaving the second connector on the
keyboard free for now. It's up to you. Figure 1-14 shows two possible
arrangements.
If you have other Apple DeskTop Bus devices to attach to your
system, you can either daisy-chain them to the keyboard or use one
of the back panel connectors.

Ready to go?
O nce you're satisfied that everything is connected prope rly, you'll
want to arrange your Macintosh II components conveniently in your
work area. Turn the main unit so that it's facing you . Place the
monitor where you want it (on top of the main unit is fme), and
position the keyboard and mouse where you can reach them
comfortably.

Plugging It all together
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Warning

Always keep your computer's main unit flat. sitting on its rubber
feet. Sta nding It on edge defeats the cooling design and is
like ly to make your computer overheat . This may eventually
damage the main unit. (See Figure 1-15.)

~~~-I - I(J
Right way

Wrong way

Figure 1- 15
Leave room for air to circulate

Other devices
You may have purchased other equipment, such as a printer, an
external disk drive, or a modem. You'll find instructions for
connecting those devices in the manuals that came with them.
Warning
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There Is one SCSI port o n the back o f the main unit. (SCSI.
commonly p ronounced ~skuh '-zee: Is short for Small Computer
System In terface.) If you're using an external SCSI device of any
kind. you must connect that device to the SCSI port.
Connecting a SCSI device to the wrong port can damage your
system . You can also damage the system If you mistakenly
connect a non-SCSI device (with an RS-232 p lug, for example)
to this port. Read the manual that came with the device; a lso
read ~Adding SCSI Terminators· in Appendix A for Important
instructions about SCSI terminators.

Chapter 1: Setting Up Your Macintosh II
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lnternaf hard disk users
If your system includes an internal hard disk, you might need to
prepare it for use; this is explained in Appendix A, "Working With
Hard Disks." For the veteran Macintosh user, that's easy-go to
Appendix A now. But if you're new, the procedure requires a few
techniques you need to learn first. Skip setting up your hard disk for
now and go on to Chapter 2, "Learning About Your Macintosh II."
After you've mastered some Macintosh techniques, go to Appendix
A and get your hard disk ready for use.

Let's get startedl
Now that your system's all set up (or set up as much as it needs to be
for now), go on to Chapte r 2 and learn how to start using your Apple
Macintosh II computer.

Let' s get started!
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If you've used "traditional" computers, you'll really appreciate the
Macintosh difference. No more guessing w hat the computer wants.
No more memorizing long commands with names only a
programmer could love. With Macintosh, you're in charge.
Macintosh removes a lot of the mystery about using computers.
Every action you take has an effect you can see-so you're always in
control of what happens. And you don't have to keep tedious details
in your head, because Macintosh keeps track of them for you.
You're free to think about what you want to do rather than how to get
your computer to do it.
Documents are whatever
you create with
Macintosh applicationsinformation you enter.
modify. view. or save.

An application is a
software program that
helps you perform your
work. It's short for
application program. and is
often used interchangeably with program.

This chapter teaches what you need to know to use your Macintosh
II-how to create documents, make changes to them, and put
them away. It all happens w ith a few basic techniques, the same
Macintosh techniques you'll use w heneve r you work with almost all
Macintosh applications on your Macintosh II.

Training disk or tutorial?
You're almost ready to start up your Macintosh ll computer and sec
it in action, but first you have a choice to make. The material
presented in this chapter is also taught on one of the training disks
that came with your computer- Your Apple Tour of the Macintosh
If. Both the book and the disk are designed to give you first-hand
experience using the compute r, but in different ways.
The training disk is an interactive guide to the Macintosh II. That
means it teaches you Macintosh concepts and techniques, prompts
you step by step, and corrects you when you've made a mistake. It
provides you with an e nte rtaining but controlled learn ing
environment.
The tutorial in this chapter uses real software applicatio ns to teach
you the same techniques. He re, you're in the actual working
environment that you'll usc w he never you work with your Macintosh
II. Even with the actual software applications, you won't make any
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mistakes if you follow the directions step by step. Whether you use
the disk or the tutorial is up to you. You may find it helpfuJ to use
both.
If you would like to take the guided tour, follow the steps below in
"The Training Disk." If you'd rathe r stay with the printed page, skip
now to the section "The Tutorial." Either way, you'll be a confident
Macintosh user in no time.

The training disk
Follow these steps to start up Your Apple Tour of the Macintosh II.

-

1. Turn your computer on by pressing the Power On key (at the
top of the keyboard).
Power O n key

I~
Important

A beep leiS you know it's started. If this is the first time you've
turned on the power, a small yellow sheet of plastic will pop out
of the disk drive (or drives, if your system includes the optional
second internal drive). Re move the plastic piece from the disk
drive, but don't discard it; if you ever need to transport your
Macintosh II, you'll want to insert the plastic piece to prevent
damage during shipping.
An icon (a small picture) representing a Macintosh disk appears
on the screen. The blinking question mark shows that the
Macintosh II is ready for you to insert a disk.
If the Icon with the blinking question mark does not appear and
your system Includes the Internal hard disk, someone may
a lready have prepared the hard d isk for you. For now. turn off
the Macintosh II. (To turn the system off at this time. push once
on the power switch on the back of the main unit. Facing the
back of the main unit. you'll see the power switch In the
bottom-left corner. (See Figure 1-2.) Once the power is off. walt
a few second s a nd follow step 2. Then press the Power On key
to turn the computer back on again. If that doesn't work. go
on to "Problems Starting Up? " later in this chapter. If none of
the suggestions there works, contact your authorized Apple
dealer or representative.

The training d isk
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2. Insert the d isk labeled Your Apple Tour of the Macintosh II
into the d isk drive, metal end first, label side up.

If you have two disk drives, insert the disk into the one on the
right.
When the disk is most of the way into the disk drive, the
Macintosh II automatically pulls it in, and the disk "kerchunks"
into place. As the Macintosh II starts up the guided tour, you'll
hear a series of soft noises. After a few moments, you should see a
display welcoming you to Macintosh II.
3. Adjust the brightness and contrast controls on your monitor
to the level you want.
Label side up, metal end first

See the manual that came with your monitor for instructions.

Figure 2-1
Inserting t he training disk
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Figure 2 -2
Monitor b rightness a nd contrast controls
4. Follow the Instruc tions that appear on the screen.

You've already begun to learn about Macintosh II.
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Welcome to your Apple~
Tour of the MacintoshMII

If vou've- used this: tour btfor•, vou m•y sk;p to
th• m•ln monu bv oHckln9 lht moun button.

-

-

~~ 987

Computtr, lne.

Figure 2-3
Opening screen of the training disk

Use the training disk as long as you like. Anything you need to know
to use the disk will be explained right on the screen.

Problems starting up?
If what's in Figure 2-3 doesn't appear on your screen, go through
this checklist to see if you can identify the problem:
o Is the computer plugged into a power source?
o Is the power cord plugged into the computer?
o If your compute r is plugged into a power strip, is the power strip
turned o n?
o Is the monitor connected to the computer p roperly?
o Is the monitor powe r cord plugged in?
o Is the computer turned on? (Look for a light on the front left side
of the main unit.) If there's no light, push the Power On key.

-

The training disk
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o Is the monitor on? (Look for a light on the front of the monitor.)
See the manual that came with the monitor if you need help
turning on the power.
o Is the brightness control adjusted correctly? See Figure 2-3 to
locate the brightness control on the monitor.
o Are you using the correct disk? To check, hold down the Apple
and Shift keys while you press the 1 key on the main keyboard.
This will eject the disk. Make sure it's titled Your Apple Tour ofthe
Macintosh Il
o If you have an internal hard disk, did you turn off the Macintosh II
before inserting the training disk? (See the "Important" message
at the end of step 1 of the procedure.)
If you can't identify the problem yourself, get help from your
authorized Apple dealer or representative.

What to do when you're finished
When you're ready to stop using the training disk:
1. Choose Let's Quit from the main menu.

This will shut down the computer and eject the training disk.
2. Take the training disk out of the drive.
3. To continue working with the Macintosh II, you can do one
of the following:

o Go through the written tutorial (below) for some additional
practice.
o Insert the second training disk, Your Apple Tour of Macintosh
II Applications. Then press the Power On key (at the top of the
keyboard) to restart the computer and learn about some of the
many applications you can run on your Macintosh II.
The System Tools disk

contains Important
utilities you can use to
maintain and update your
computer system and
application disks.
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o Press the Power On key to restart the computer, insert the
System Tools disk, and experiment with the Finder.
o Start any of your applications (following the instructions in the
manual that came with the application).

Chapter 2: Learning About Your Macintosh II
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Impo rtant

You may have to use the Installer on the System Tools d isk to
update the system software on your a pplication disks before
they'll work on the Macintosh II. (It's easy!) You'll find
instructions for using the Installer in Chapter 3, "Your Macintosh
II Step by Step .•

If your system includes the internal hard disk, go now to Appendix A
to get your hard disk set up and running.

The tutorial
If you used the training disk Your Apple Tour of the Macintosh II,
you already know how to get your system started, so the following
steps will sound familiar. Just follow the numbe red steps until you
get into new territory.
Follow these steps to start up the Macintosh II.
1. Turn on your computer by pressing the Power On key (at the
top of the keyboard).
Power On key

A beep lets you know it's started. If this is the first time you've
turned on the powe r, a yellow sheet of plastic will pop out of the
disk drive (or drives, if you r system includes the optional second
internal drive). Re move the plastic piece from the disk drive, but
don't discard it; inserting it in the disk drive p revents damage
during shipping if you ever need to transport your Macintosh II.
An icon representing a Macintosh d isk appears on the screen.
The blinking question mark shows that the Macintosh II is ready
for you to insert a disk.

Important

If somebody has a lready set up your system fo r you a nd your
system includes the Internal hard disk, your screen might not
show the disk icon with the b linking question mark. Instead It
might look look like the one In Figure 2-5. Don't paniceverything Is still all right.

The tutorial
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2. Insert the disk labeled System Tools Into the disk d rive, metal
end first, label side up.

If you have two disk drives, use the one on the right. \'{{hen the
disk is most of the way into the disk drive, the compute r
automatically pulls it in , and the disk "kerchunks" into place.
The soft hum means your computer is getting information fro m
the disk. A message appears, welcoming you to Macintosh, and
after a few seconds you'll see this screen:

c
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Figure 2-4
Inserting the System Tools d isk

l con -------------------------r--------------------------------------~

Figure 2-5
Finder sc reen

This is the Maci ntosh II Finder, a special application you use to
organize and manage your docume nts, and to start other
applications. You use the Finde r every time you start you r
Macintosh II or move from one application to another. It's like a
"home base" for operating your co mpute r's applicatio ns.
3. Adjust the brightness and contrast c on tro ls on your monito r
to the leve l you want.

See the ma nual that came with your monitor for instructions.
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The working environment is called the desktop. While most
computer screens look like the departing flight schedule at a busy
airport, the Macintosh desktop can be as clear and clean as you
want to make it; it's yours to arrange any way that pleases you. You
can slide documents around, organize your work in folders, throw
things away, or get what you want to work on next-just by moving
the mouse and pressing the mouse button.
The bar at the top of the screen contains menus; you'll see how to
use them a little later. The icons on your desktop always let you know
what's available. Right now you see icons that represent

o the System Tools disk you inserted
o the Trash, where you can discard what you don't need anymore
•!• Different screen? If your screen doesn't look like this, someone
else has probably used this lesson and arranged the desktop in a
different way. After you learn in the next section how to use the
mouse, see "Handling Windows'' in Chapter 3 to close all
windows that may have been left open. If someone has already
set up the optional internal hard disk, you'll see an extra icon.
For the time being, just ignore the hard disk icon as you go
through the rest of this tutorial. If you have other troubles
starting up, read the suggestions in Problems Starting Up?"
earlier in this chapter.
11

Mouse basics
Your Macintosh II responds instantly to every movement you make
with the mouse. You can start applications and get documents,
work on them, and put them away again-just by moving the mouse
and pressing the mouse button. The best way to see how this works
is to try it.

The tutorial
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Figure 2-6
Controlling the pointer

Moving the pointer by moving the mouse
1. Watch the screen while you roll the mouse on a flat surface
next to your computer. For now, don't press the mouse
button.

Every move you make w ilh the mouse mo.ves the pointer in
exaclly the same way.
Usually the pointer is shaped like an arrow, as it is now, but it
changes shape depending on w hat you're doing. For instance, it
becomes an 1-beam when it's positioned over text you can edit,
or a wristwatch when the Macintosh II is doing something that
takes a little time.
You 'II have the best control if you hold the mouse with the mouse
cable pointing directly away from you.
2. Pick the mouse up and put it down in a different place.

If you run out of room fo r the mouse- if it goes off the table, for
instance, or runs into the Macintosh II itself-lift the mouse and
put it down again where you have more room. Lifting the mouse
doesn't move the pointer.
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Using the mouse might feel a little awkward at first, but it will soon be
second nature.
Selecting by clicking an icon
Macintosh lets you organize your desktop any way you want, so the
first thing to do with your mouse is arrange the desktop to suit you.
This may not seem like a big deal now, but you'll appreciate it when
your desktop gets cluttered with icons. To move an icon, you first
select it to let your Macintosh n know this is what you want to work
on next. You select icons by using a technique called clicking.
1. Posi tion the pointer on the Trash ico n.

Make sure the tip of the pointer is o n the icon.
2. Click the icon by pressing and immedia tely releasing the
mouse button.

-

-

Figure 2-7
Select ing an icon

The t utorial
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As you dick the icon, it becomes highlighted. What was white is
now black, and vice versa. The highlighting shows that you
selected it. Notice that the System Tools icon is no longer
highlighted. Selecting has a specific meaning in the Macintosh
vocabulary: you always select the information you want to work
on next.
3. Click the System Tools icon.

Now the System Tools icon is selected, and the Trash icon is no
longer selected.
When clicking, try not to move the mouse as you release the mouse
button. Practice clicking each icon in turn until you can click without
moving the mouse at all .
Dragging an icon
Once you've selected an icon, you can use the mouse to move the
icon with a technique called dragging.
ti
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Special

Figure 2-8
Dragging an icon
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1. Position the pointer on the Trash Icon.
2. Press and hold the mouse button while you move the
mouse.

When you press the mouse button, you select the icon. As you
move the mouse, the pointer moves and drags an outline of the
icon and its name along with it. So you always know where you
were-and where you're going.
3. Release the mouse button.

The icon snaps to its new place.
Try this again with the System Tools icon. Move the icon all the way
to the left. Notice that it won't go off the edge of the screen, so you
don't have to worry about losing it. Remember, lifting the mouse
has no effect on what you're doing (but releasing the mouse button
does end the current dragging and places the icon where it was when
you released the mouse button).
If you change your mind, you can cancel a drag in process by
moving the pointer into the menu bar at the top of the screen and
releasing the mouse button. Practice dragging until you can easily
put the icons wherever you want them.
You've learned how to use the mouse to point to and select
information you want to work on, and you've seen how you can drag
icons to arrange your desktop. Next you'll learn how to act on what
you select by choosing a command from a menu.
•!• Take a break: You can take a break from this lesson at any
point. just leave the Macintosh II switched on and pick up where
you left off. If the computer has been switched off, make sure the
System Tools disk is inserted, switch the computer back on, and
pick up where you left off.
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Selecting and choosing
Whenever you work w ith your Macintosh II, you tell it two things:
what you want to work on, and what you want to do. f irst, you tell the
Madntosh II what you want to work on by selecting it as you've been
doing with icons on the desktop. Then you tell the Macintosh II what
you want to do with the selection. You usually do this by choosing a
command from a menu.
Now you want to work on the System Tools disk, and you need to
open its icon to examine its contents.

Selecting the System Tools icon
•

Position the pointer on the System Tools icon and click.

This is the same thing you did before. Now the System Tools icon is
selected, and you can choose a command for it.

Pulling down a menu
Along the top of the screen, in the menu bar, are titles of the

menus.
Menu bar --------------------~
:)(: N

3€0
Print
1: lose

Get Info

Dimmed command (you can't
ouplli:<J1<!
use It right now)-----------------+- -+ Pu t numq

3€ 1
:)(:I)

l' i!IJP S<!hlll ...

Print [

11 tnloq ...

Figure 2-9
Pulling down a menu
1. Position the pointer on the word File In the menu bar.

Among other things, the f ile menu lets you open icons.
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2. Without moving the mouse for now, press and hold the
mouse buHon. Re lease It when you're finished looking.

-

Pressing the button while you're pointing to a menu title causes
the title to be highlighte d and a menu to appear. The menu
contains commands you can carry out o n w hat you've selected .
(Commands that you can't use right now-the Print command,
for instance-appear dimmed in the menu.) When you release
the mouse button, the menu disappears.

Choosing a command from a menu

-

To choose a command from a menu, you use the same d ragging
technique you used to move icons.
1. Position the pointer again on the word File in the menu bar.

2. This time, press the m o use button and hold it d own while you
drag the pointer to the word Open ; then release the mouse
button.

r lose
Ge t Info
-....

ll1J()I!t:d1<!
""• • - - • UHIIl Jl

........_....

~~-

.. _........

-...._... _,._ .

Figure 2- 10
Choosing a c o mmand

As you drag through a menu, each usable command is
highlighted in tu rn. If you change your mind ab out choosing a
command, move the pointe r off the menu and release the mouse
button. Nothing is chosen unless you release the mouse button
while one of the commands is h ighlighte d.
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When you release the mouse button with the Open command
highlighted, an outline zooms out of the System Tools icon, and
the screen is almost filled by a window. This window displays a
directory of icons that represent the contents of the S)lstem
Tools disk. (If a window doesn't appear, make sure the System
Tools icon is selected before you choose Open from the File
me nu.)
The System Tools icon is hollow now to show that the icon has been
opened into a window.
Zoom box --------------------------------------------------,

System Folder

Folder icon --------------------""-+---------+

Size b ox

----------------------f----------------------------------

Figure 2-11
System Tools w indow

The title of the System Tools window appears in the title bar at the
to p of the window. Below the ti tle bar is information about the
w indow's conte nts. Along the right and bottom arc scroll bars that
let you get around in large d irectories or docume nts. In the bottomright corner is the size box you usc to change the size of a window.
At the top-left corner is a close box, and at the top-right corner is a
zoom box that zooms the window out so it nearly covers the screen.
In a few minutes, you'll sec how to use these parts of a window to
ma ni pulate it.
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-

To sum up what you've done so far: first you selected something (the
System Tools icon), then you chose a command (Open). You'll
follow this same pattern whenever you work with your Macintosh II:
select some informatio n, then choose an action fo r it.
Folders hold documents.
applications. or other
folders on the d esktop.
Utility prog rams ore
special applications that
usually change something
in a system file. You'll
learn more about utility
programs In Chapters 3
and4.

There are four icons in the System Tools window; they re present
folde rs and an application that are on the System Tools disk:
o The System Folder ho lds the system software the Macintosh li
needs to operate.
o The Utilities Folder contains special utility programs you'll use
later, after you've worked with your system for a while.
o The Update Folder contains docume nts that give you latebreaking information about your computer or software.
o TeachTe.."'l:t is the application you use to read the documents in
the Update Folder.
You'll learn more about the Update Folder and TeachText as you go
through this tutorial.

-

-

•:• Other utilities: You r Macintosh II comes with lots of utilities;
some are included on a separate utilities disk and are explained
in the Macintosh System Utiltties User's Guide.

Manipulating windows
Just as you can arrange icons on the desktop to suit you, you can also
arrange windows to your liking.
Changing the size of a w indow
\'V'hen you're working on a document on your desktop, it's great to
have a wide-open window so you can really see what's there. But
small windows also have advantages. You can move small windows
around on your desktop to see the conte nts of more than one
window at a time. Large or small, to change a window's size, you use
the size box in the bottom-right corner of the window.

The tutorial

37

Ill!

Tn

Figure 2-12
Using the size box
1. Position the pointer on the size box, and drag it up and to
the lett.

-

As you drag, a dotted outline follows. The farLher ro the left you
drag, the narrower the outline becomes; the farther upward you
drag, the shorter it becomes. When the outline is as small as you
can make it, it stops moving. W hen you release the mouse
button, the w indow changes size.
The contents of the w indow don't change at all when you change
a window's size. The only thing that changes is how much you can
see.
2. Position the pointer on the zoom box and click .
The w indow zooms our to nearly fill the screen.
3. Click the zoom box again.
The window returns to its former size. Using the zoom box l ets
you use every square inch of the screen for what you're currently
working on and, with a single click, brings you back to your
former view.
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-

-

Experime nt with controlling the size of the System Tools window.
Drag the size box down and to the right to make the window bigger
again. The n try all diffe rent lengths and widths. Usc the zoom box
and notice how the Macintosh IT always shrinks the wi ndow back
down to whatever size it was before you zoomed it out.
Moving a window
You can move windows on your desktop just as you moved icons. To
move a window, drag it by its title bar. Don't, however, drag it by
the zoom box or the close box, the small box on the left in the title
bar. The close box is just for closing the window.

I

i
t......... ······· ..........................................................................---·--···----·..-·.

Figure 2- 13
Moving a window
1. Position the pointer anywhere on the title bar of the System
Tools window (except In the zoom or close box).
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2. Drag the System Tools window by pressing and holding down
the mouse button while you move the mouse.

Just as when you dragged icons, a dotted outline of the window
follows your movements. When you release the mouse button,
the window moves to the new location.
If you release the mouse button before you have the window
where you want it, just "pick the window up" again. If you change
your mind about moving it, cancel the drag by moving the
pointer into the menu bar and releasing the mouse button. Just as
icons stayed within the limits of the desktop, so do windows. You
can't lose them by dragging too far.

-.
I

i

I

Practice your new skills. When you can manipulate the window
easily, making it any size and putting it anywhere you want on (or
partially ofO the desktop, go on to the next activity.

r-'

Opening another icon

I

Use your new window-handling expertise to get the System Tools
window out of the way if you need to. Shrink it down and move it
around so you can see the Trash icon.
1. Select the Trash Icon (by clicking it).
2. Choose Open from the File menu.

Position the pointer on the menu title, press the mouse button
and drag to the Open command, and then release the mouse
button.
A second window appears on the desktop, probably overlapping
the first (depending on where you left the first window and what
size you made it).

Making a window active
With Macintosh, you can have many windows on your desktop at a
time. When there's more than one window, the Macintosh II needs
to know which one you're working on at the moment so that the
commands you choose and the text you type end up in the right
place. The window you're working on is always in front of all the
others. It's called the active window, the place you want the next
action to happen.

I
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.

The active window's title bar is highlighted with narrow horizontal
lines on either side of the title. The active window also usually has a
size box in the bottom-right corner and scroll bars on the right side
and on the bottom.
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File

Edit
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SIH'C iill

Sys I em
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Tool~

Trash

0 it•ms

Active window--------+-

Figure 2-14

Overlapping windows

When you opened the Trash icon, it automatically became the
active, frontmost window-the window you're working in. The
System Tools window is also open on the desktop, but it's no longer
the active window. To work in the System Tools window again, you
make it active by clicking anywhere inside it.
If you left the System Tools window small before you opened the
Trash window, it may be completely hidden by the Trash window
now. You know how to move windows and change their size, so if
you can't see the System Tools window, move the Trash window or
change its size until you can see the System Tools window again. It
doesn't have to be completely visible. As long as you can see part of
it, you can make it active.
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1. Click In the System Tools window.

The window is brought to the front of the desktop. Its title bar is
highlighted, and scroll bars and a size box appear to show it's lhe
active window. Whenever you want to work in a window that isn't
already active, you first make it active by clicki ng in it.
(
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Figure 2- 15
Making a window active

Your desktop might not look exactly like the one he re. You r
Madntosh II does exactly what you tell it to do; the size and
position of your windows are up to you.
2. Click In the Trash window.

Now it moves in front of the System Tools window again.
Experiment with arranging your desktop-making each window
active in turn, changing its size, and moving it.
•:• Hint:· Sometimes you need to move a window in order to see its

size box. And you sometimes need to change a window's size,
or move it, to see a window it's covering.
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Opening other icons

-

Yo u can open icons in a directory window, such as the System
Tools window, just as you opened icons on the desktop . You know
how to ope n an icon by selecting it and choosing O pen from the
File me nu. The re's a shortcut: you can do the same thing with a
technique called double-clicking. Try it to open the System Folde r
in the System Tools window. (If necessary, first make the Trash
window smaller; then make the System Tools window active and
large e nough that the Syste m Folder icon is visible.)
1. Position the pointer on the System Folder, and quickly press
and release the mouse button twice.

td•
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Figure 2 - 16
Opening an Icon in a w indow

Ins ide the Syste m Folder are icons that represent system files;
these contain info rmation the Macintosh II needs.
If the System Folder window doesn't appear w he n you doubleclick, shorte n the interval be tween your clicks. That way the
Macintosh II will be able to interpre t you r actions as a doubleclick, and not just as separate single clicks. Now you have two
ways to open icons.
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2. Open the Utilities Folder, either by double-clicking It or by
selecting It and choosing Open from the File menu.
See ·using the Hard Disk
Installer· In Appendix A
and ·using the Installer· In
Chapter 3 for more
information on haw to use
these utility programs.

If necessary, first move the System Folder window. The Utilities
Folder contains icons that represent utility programs-system
tools you'll use later to set up your internal hard disk (if your
system includes that option) and to install printers and
Macintosh II system software on other disks.

~
I

Closing a window
You can have as many as 12 windows open on your desktop, but to
keep things tidy, you might want to close some when you're finished
working on them, and open them again when you need them.
1. Make the Trash window active by clicking In it.
2. Choose Close from the File menu.
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Figure 2-17
Choosing Close

The window collapses back to an icon. Whenever you choose
Close from the File menu, the frontmost, active window is
closed, and the next window behind it becomes active.
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'

Now close the Utilities Folder window by using another shortcut.
The close box in the title bar lets you close an active window with a
single click.
3. Make the Utilities Folder window active if It's not already.
4. Click the c lose box.

It's the same as choosing Close from the File menu.
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Figure 2- 18
Using the close box

Using the scroll bars to see more
Windows on the desktop often can't show you the entire directory or
document all at once, even when you've made the window very
large. There's often more information than can fit in the window at
one time.
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The scroll bars in an active window let you move what's in the
window so you can see more of iL

i

1. Make the System Folder w indow active if it isn't already .
2. Make the System Folder w indow small enough that some of
the icons are hidden from view.
T1

3. Click the scroll a rrow that points down.

More icons come into view. You can also scroll up, right, or left.
You can also scroll by dragging the box in the scroll ba r.
Figure 2-19
Scrolling a d ocume nt

"

f tie

ldt t

llteu•

-

Spec tdl

0·

i

Figure 2-20
Using scro ll a rrows

n
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If you want to know more
about scroll bars. see
·scrolling· in Chapter 3.

4. Drag the box in the vertical scroll bar to the top of the scroll
bar and release the mouse button.

Nothing in the window moves until you release the mouse button.

-
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Figure 2-21

Using the scroll box

Using applications
You might be wondering what all of this has to do with your
work- the documents you'll create with Macintosh applications.
You 'll use the skills you just learned in nearly all applications. You
usually select information and choose commands in consistent
ways. And windows are always opened and closed, changed in size,
moved, and made active by using the same techniques you just
learned.
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In addition to helping you manage your documents-copying
them, renaming them, removing them, for example-the Finder
lets you start applications and get documents, and then put your
doruments away when you're finished working on them.

Starting an application
In this section, you'll learn how to start up an application and use
that application to create a new document.

Startup disks contain the
system files-at least
Finder and System-that
the Open Macintosh
needs to start itself.

Most of the applications you'll use with the Macintosh II come on
their own disks. The application you'll use in the next few
sections-TeachText-is already on the System Tools disk, the disk
you used to start this tutorial. (You'll also find TeachText on the
Utiltlies disk.) Like the System Tools disk, most application disks can
be startup disks.
Usually you just insert the application disk into the disk drive and
switch on the computer. If your system includes a hard disk, you can
make it a startup disk and copy the application onto the hard disk.
That way, you won't have to insert any disk to start up the computer.
(See Appendix A for the details after you finish this tutorial.)
•!• Copy-protected disks: Some application manufacturers copy
protect their disks. That means you can't make another copy of
the disk. But most copy-protected applications can be used with
a hard disk. The application's manual should explain how.
1. Close the System Folder window if you haven't done so
already.
2. Make the System Tools window larger, if necessary, to see
the TeachText Icon.

Use the technique you learned earlier for changing the size of a
window.

~
I

•

3. Open the TeachText icon. either by double-clicking it or by
selecting It and choosing Open from the File menu.

You see the TeachText screen-an empty window ready for you
to type in some text.
·

_,
I
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Figure 2-22
TeachText screen

For now, you'll use TeachText as a sample application to learn how
to use applications. You'lllearn about other ways to use TeachText
later in this tutorial.
Like most applicatio ns, TeachText has its own menus, title bar,
close box, size box, and scroll bar. Also like most applications,
TeachText always opens with an "Untitled" window. You create
whatever you want with the application and then name the
document when you save it.

Creating a new document
Now that you've started TeachText, you need to use the keyboard to
create a new docume nt. The Macintosh II keyboard, similar to a
typewriter keyboard is used mainly for typing text and numbers. On
the screen, a blinking vertical bar marks the insertion poin t where
text you type will be inserted. If you make a mistake, use the Delete
key to erase and then start typing agai n. You don't have to use the
Retu rn key to start a new line. 1he application starts new lines for
you.
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~

• Use the keyboard to type this sample paragraph:

I

The following is my best guess for a production
schedule. Please keep in mind that it is
subject to change once reality gets underway.
Let me know if I'm cheating anyone of the time
he or she needs, or if I'm not allowing for
black holes.

Most applications that let you enter and edit text-such as word
processing applications-start the new lines for you. This feature is
word wraparound, so called because if a word is too long to fit at
the end of a line, the word wraps around to the next one
automatically.
You'll have a chance later to learn more about adding and editing
text, but now you need to give the document a name and save it on
the disk.
Saving your work on a disk
With most applications, the work you do at your keyboard is stored
as you do it in a special area of the computer's memory, where it
stays temporarily until you save it on a disk, start another
application, or turn off your computer. Saving the information on
a disk makes a permanent record of what you've done-a file you
can duplicate, modify, print, and so on. If you don't save your work
on a disk but do change applications or turn off the computer, any
work that was in the computer's memory will simply be erased; you
will not have a permanent record of what you did. Sometimes that's
appropriate, but be sure you understand the implications of saving
or not saving your work.

~
I

I

1. Choose Save from the File menu.

A dialog box appears. Whenever your Macintosh II needs more
information from you, it presents a dialog box with buttons to
click, such as OK or Cancel, and sometimes with a place for you
to type additional information. Dialog boxes can also alert you if
you're about to do something that could cause you to lose
information; they give you a chance to cancel what you were
about to do. When the messages are alerting you, they're often
accompanied by an Alert Sound.
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The dialog box that appears now gives you the chance to save
your document on any disk. This time, you'll save your
document directly on the System Tools disk, without placing it
inside a folder. (For now, just ignore the list of files in the dialog
box window.)
There's a text box for you to type the name of your document.
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Figure 2-23
A dialog box
2. Type

First Memo.

3. Click the Save button.

Your document is saved on the disk just as it appears on the
screen. After the Macintosh II saves the document, it returns you
to the document window. Now the title bar shows the name you
just gave to the document.
Once you've given you r document a name , if you continue
worki ng on it, make a habit of choosing the Save command from
the File menu about every 15 minutes or so. Cit's a good thing to
do while you're waiting for your next inspiration.) That way, if
your Macintosh II gets switched off or there's a power failure,
you'll never lose more than 15 minutes' worth of work.
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With your work saved on the disk, you can quit TeachText and return
to the Finder.
4. Choose Quit from the File menu.

The desktop appears again. But now the icon of your new
document appears in the System Tools window.

Sys tern Tool s

0~

T••. t.· • •

Figure 2-24
New document Icon

This new icon represents the document you created, and below it is
the name you gave it. All documents you create have a specific icon
related to the application you used to create them. This helps you
identify which application you used to create each of your
documents. When you work on this document again, you'll select
and open its icon just like any other icon.

Editing text
Now you know how to create and save a document. In this section,
you'll use your first Macintosh memo to learn how to make changes
to what you've just written.
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1. Open the First Memo Icon.

Opening the document you want to work on also starts the
application you need to do the work. You don't have to open the
application in order to open the document; once a document
has been saved, you can open it directly from the Finder (and it
will automatically open the application).
The TeachText application starts, and the document you saved
earlier reappears, just as it was when you saved it.
2. Select a new Insertion point by clicking In front of the word
subject.
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Figure 2-25

TeachText document

You're moving the insertion point to where you want to add text.
3. Type not.

What you type appears at the insertion point. (Don't forget to
add a space after not.) You probably noticed that when you
added text, the words on the other lines rewrapped to
accommodate the extra word.
Now you'll select some text and move it to another part of the
document.
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4. Select the entire second sentence by positioning the pointer
otter the period that follows the word schedule and dragging
to the end of the sentence.
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Figure 2-26
Selecting text

First drag down, and then drag to the right. (Be sure you include
the period at the end of the sentence.) If you move the pointer
off the sentence, you might select more than just the sentence. If
this happens, just start dragging over again; nothing unexpected
can happen while you're just selecting text.
When you drag through text, you're selecting information to
work on, as you did when you selected icons. You selected icons
by clicking them; you select text by dragging across it or down
through lines of text.
5. Choose Cut from the Edit menu.

The sentence vanishes. Whenever you choose Cut or Copy from
the Edit menu, whatever you cut or copy is put in a holding place
called the Clipboard, ready for you to paste to a different
location if you want. (You use Copy when you just want to copy
text, rather than move it somewhere else. Copy works just like
Cut, except it leaves the text you selected in the document.)
6. Select a new insertion point by clicking after the period that
follows the word holes.
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Figure 2 -27
Moving the Insertion point
7. Choose Paste from the Edit menu.

The contents of the Clipboard-in this case, the sente nce you
just cut-are pasted into the location you selected.

See ·Editing Text" In
Chapter 3 for a summary
of how to enter and edit
t ext.
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Figure 2-28
Pasting In text

-

The conte nts stay on the Clipboard until you choose Cut or Copy
aga in, so you can continue to paste them. You can paste within
one document or between two documents created with the same
application. The contents also stay on the Clipboard when you
leave an application, so you can cut and paste between
applications.
For example, you can draw a picture with MacPaintTMand use it to
jazz up a report you create w ith MacWrite™. O r borrow a passage
from a MacWrite document and paste it into an overhead slide
you're preparing with MacDraw™.
Whether you're using the Finder or anothe r application, you can
usually view the contents of the Clipboard. (Some app lications
provide a menu selection fo r this.)

-
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Saving a document with a different name
Now that you've edited your original memo, you need to save your
revision. When you're fmished making changes to a document, you
have two choices for saving. You can choose Save from the File
menu, and the revised document is saved with the same name you
gave the original. That's fme if you don't want to keep a separate
copy of the original document; but you may want to save the
revision and keep the original, too. (For example, you may have a
form letter that you keep as an original; you can personalize the
letter and save different versions with new names.) For that you
choose Save As from the File menu.
1. Choose Save As from the File menu.

A dialog box appears. (lt's the same one you saw when you·
named your first memo.) The name of the original document
appears highlighted in the text box.
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Figure 2-29
Save As dialog box

-.
I

You can edit the names of documents just as you would other text.
(If you want, you can just type a new name for the document rather
than edit the old one.)

,....
I
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2. Position the pointer at the beginning of the word First a nd
drag to the end of the word to se lect it.

3. Type

Second.
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Figure 2·30
Changing a document's name

4. Click the Save button .
You've saved the revised memo with a new name, ·and you return
to the docume nt you just re named. Notice that the title bar
changes again to show the name you just gave the revised memo.
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Figure 2·3 1
Docume nt w ith its new title
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5. Choose Quit from the File menu.

You return to the desktop, where you see an icon for the revised
memo with the name you just gave it.

Organizing documents
You've seen how to use the Finder to start an application and open a
document, save it, and quit the application to return to the Finder.
The Finder also helps you organize your documents-group them
together with related documents, duplicate them, rename them,
copy them to another disk, or throw them away.

Using folders
You'll soon accumulate many documents on the disks you'll be
using. At some point, you might want to arrange your desktop so
that related documents are grouped together. Macintosh folders
work just like ordinary file folders to help you organize your
documents. For instance, you can keep all your monthly status
reports together in one folder. Or you can group all your MacPaint
illustrations together, or keep each one with the report it illustrates.
Macintosh lets you organize your documents however you want
them.
You already have three folders on the System Tools disk. To
organize your own work, you have an endless supply of empty
folders.
1. Start a new folder by choosing New Folder from the File
menu.

-.
I

A folder named Empty Folder appears in the System Tools
window.

~
•
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Figure 2-32
Starting a new folder

The empty folder is automatically selected when you create it, so
you can rename it just by typing. (If you can't see the entire icon,
you can make the window larger or move the icon.)
If you already have a folder named Empty Folder on the desktop,
the folder you create will be named Copy ofEmpty Folder.
2. Type

Memos

Folder

and press Return.

Here you press Return to confirm your new folder name. Empty
Folder is renamed Memos Folder.
Usually you have to click icons you want to rename. This prevents
inadvertently renaming selected icons when you don't really
want to. But you don't have to click newly created folders to
rename them.
You can also select, cut, and paste the icon names, just as you
would other text. Usually, however, when you want to rename an
icon, it's easier just to select the icon and replace the old name
by typing a new one.

The tutorial

59

3. Drag the two document Icons to the Memos Folder Icon,
releasing the mouse button when the Memos Folder Is
highlighted.
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Figure 2-33
Dragging a document to a folder

\'V'hen you cover the folder icon with the outline of each
document icon, the folder icon is highlighted. You "drop" the
document icons into the folder by releasing the mouse button.
The folder icon is no longer highlighted, and your docu ment
icons disappear into the folde r.
4. Open the Memos Folder icon.

-

-

You see the icons that represent your two documents.
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Figure 2-34
Memos Folder opened

When you drag a document icon to a folder, you 'file the document
the re. You can also drag an icon into an open folder window; the
result is the same.

Nesting folders
Large-capacity disks-especially ha rd disks-can ho ld hundreds of
documents and folders. At some point, you may find it helpful to
place folders within other folders to keep your work organized. For
example , you may wa nt to keep an application and all the
documents you created with it in one folder. (You can put
applications in folde rs, too.)
1. Close the Memos Folder window if it's not already closed.
2. Choose New Folder from the File menu.

You see an empty folder in the System Tools window.
3. Name the new folder by typing
and pressing Return.

TeachText

Folder

4. Put the Memos Folder Icon and the TeachText Icon into the
TeachText Folder.

Use the technique you just learned for placing documents in
folde rs.
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5. Open the TeachText Folder.

You see both the TeachText application icon and the Memos
Folder in the TeachText Folder window.

Teo chTeHI Folde r

D

538K in disk

TE~achTtl'x t

241 K availabl•

Memos FoldE'r

----

-- -·-~-

Figure 2-35
TeachText Fo lder opened
6. Open the Memos Folder.
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Figure 2-36
Layers of w indows
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Notice that each folder has its own window. The active window is
the folder you just opened. (But you can still change the active
window by clicking anywhere in another window.)
7. Close the Memos Folder a nd then the TeachText Folder.
As you close each folder's window, it collapses back into its icon

in the previous window, until you reach the System Tools
window.
Placing folders within folders is called nesting. You can
continue nesting folders as deep as you want, but most people
find that retrieving documents and applications nested more
than four levels becomes tedious. Fortunately, you won't
misplace them; you can find any application, document, or
folder by using Find File, a desk accessory designed to help you
keep track of the contents of large-capacity disks. (See "Using
Find File" in Chapter 3 and "Find File" in Chapter 4.)
When you nest folders , you create a hierarchy. When all of the
folders on a disk are closed and the disk's directory window is
open, you're looking at the top level of the hierarchy. When you
open a folder on the top level, its directory window shows you the
second level of the hierarchy.
8. Open the TeachText Folder.

You see the second level.
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Figure 2-37
Second level of the file hierarchy

If there's a folder in that second level-in this case, the Memos
Folde r-when you open it, you see the third level, and so on.
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9. Open the Memos Folder.

You see the third level of the hierarchy-the two memos.
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Figure 2-38
Third level of the file hierarchy

Working in the hierarchical file system
When you're working with an application, moving around in the
hierarchical me system would be tedious (and confusing) if you
had to quit the application and use the Finder to go back and forth
through all those folder windows whenever you wanted to open a
new document. Fortunately, you can open and save documents
within an application.
1. Close the Memos Folder If it's not already closed.
2. Open the TeachText Icon.
3. Close the Untitled window.

Either click the close box or choose Close from the File menu.
You don't want to start a new document right now.
4. Choose Open from the File menu.

You see the following dialog box.
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Figure 2-39
Dialog box for the Open command

A directory title shows you the name of the folder you're
presently working in-in this case, the TeachText Folder. The
box beneath it shows you all the other items in the TeachText
Folder you can open with this application-in this case, only the
Memos Folder.
5. To open the Memos Folder, click the Open button.

As you open the Memos Folder, you move down through the

hierarchy. The directory title changes to remind you where you
are in the hierarchy, and the box shows you what's on the level
you just moved to-in this case, the two documents in the
Memos Folder. The selected document is the one that will open
when you click Open. If you want to open the other document,
click anywhere on the other document's name to select it, and
then dick Open.
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Figure 2-40
The next level in the hierarchy
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If you want to open a document that's located somewhere else in

the hierarchy, you can move to another level by using the pulldown list below the directory title.
6. Position the pointer on the directory title. and press and
hold down the mouse button.
---~1

,.r...

r-----,
[ orll el

1

Figure 2-41
Directory hierarchy

This pull-down list is similar to the menus you used earlier,
except rather than showing commands, this shows the path
through the hierarchy back to the top level. (The top level is
always the last one on the list.)
7. Choose the TeachText Folder.

You choose the level you want by dragging down the list to get to
it.
The directory title changes again, and you see the contents of
the TeachText Folder in the box-the Memos Folder.
8. Pull down the list below the directory title again and
choose System Tools.

The directory title changes again, and you see the folders on the
top level of the hierarchy-in this case, the System Folder, the
TeachText Folder, the Utilities Folder, and the Update Folder.

~

_..
'
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-

So far, all you've seen in the window are folders and the documents
you can open with TeachText. When you open a document from
within an application, the dialog box shows you only folders and
documents that you can open with that application. If you open a
folder and you don't see anything listed in the window, that's
because that folder doesn't contain anything you can open with the
application you're using.
You've been moving through the hierarchy on the System Tools
disk. For now, you'll work only on this disk, but if you wanted to
open a document on another disk, you could see what's on the other
disk by clicking the Drive button on the right side of the dialog box.
(If you don't have a disk in another drive, the Drive button appears
dimmed.) When you click the Drive button, you see the name of the
disk change in the top-right corner of the dialog box, and you see
the folders and documents on the top level of that disk in the
window.
If you have a one-drive system, or if you just want to switch disks in a
disk drive, you can click the Eject button. This ejects the disk from
the drive and lets you insert another disk. The new disk's name
appears in the top-right corner of the dialog box, along with its
folders and documents in the window.
Now open one of the memos.
9. Open the TeachText Folder.
10. Open the Memos Folder.
11. Open either of the two memo documents.

You use a similar technique in moving through the hierarchy
when you save a document.
12. Choose Save As from the File menu.

You don't need to make any changes to the document. Right
now, you just want to save a version of the document with a
different name.
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You see the familiar Save/Save As dialog box.
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Figure 2-42
Save As dialog b ox
13. Type

Third Memo.

This time, before clicking the Save button, you'll choose a
different level of the hierarchy to save the document on.
14. Pull down the list below the directory title and c hoose the
TeachText Folder.
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Figure 2-43
Choosing TeachText Fo lder

You see the contents of the TeachText folder-the TeachText
application and the Memos folder. The directory title changes
again to show you where you are in the hierarchy.
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When you're savtng a document, you see in the window all the
applications, folders, and documents on the same level. Seeing
everything gives you a chance to make sure you're not saving this
document with the same name as something else that's already
there. That way, you won't inadvertently lose anything by using
the same name.
15. Click the Save button.

You saved the new document in the TeachText Folder.
16. Choose Save As from the File menu.

Figure 2-44
Changing a document's name

Again, you see the dialog box. This time, you see the name of
the document you just saved listed in the window along with the
other items in the TeachText Folder. Now you have memos
saved at two differe nt levels of the hierarchy-one at the second
level in the TeachText Folder, and two at the third level in the
Memos Folder.
17. Because you aren't going to save anything, click the
Cancel button.

18. Choose Close from the File menu.

You're finished with this document.
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Selecting more than one icon
You've learned a lot about organizing your work, but there's more.
So far, whatever action you've taken has been on one document at a
time. You can also take most actions on several documents at once.
For example, you can move several documents from one place to
another, discard them in the Trash, or find out information about
them. One of the ways to select more than one icon is by using the
dragging technique.
1. Close the TeachText Folder window If It's not already closed.

I

(You'll need a window with lots of icons.)
2. Open the System Folder.
3. Use the size box or the zoom box to make the window
bigger so that you'll have plenty of room.
4. Position the pointer outside one corner of a group of Icons In
the window, and drag diagonally to the opposite corner of
the group.
As you drag, a dotted rectangle appears around the icons you're

selecting. When you release the mouse button, the icons are
selected. You can select any group of icons that can be enclosed
in a rectangle. Be sure you start dragging outside an icon. If you
position the pointer on an icon, you select just that icon.

~
I

70

Chapter 2: Learning About Your Macintosh II

~
,
I

-

Figure 2-45
Selecting a group of Icons

Now you can drag the whole group.
5. Position the pointer on one of the icons, and drag the whole
group to another part of the window.

-

Make sure the pointer is on one of the icons. (It doesn't matter
which one.) They keep their arrangement and move "in
formation." The icons stay selected until you click anywhere
outside any of them.
You can also choose a command to act on a group of selected
icons. For example, you can find out information about an entire
group of docume nts.

-
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6. Choose Get Info from the File menu.

An information window appears for each icon that's selected.
As each new window appears on the desktop, it overlaps the
window that appeared before it
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Figure 2-46
Overlapping information windows

You can move these information windows or make them active
like any other windows on the desktop, but you can't change their
size or scroll through them.
Software manufacturers sometimes use the comment box in the
information window to show the software's version number.
Applications and system software are often improved and
updated, and version numbers are assigned to these u pdates so
you can always see if you're using the most current version. Just
select the application's icon, and choose Get Info from the File
menu.
7. Close each information window in turn by c hoosing Close
from the File menu or by clicking the close box.

Each time you choose Close or click its close box, the active
window closes.
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There's another way to select more than one icon. Sometimes the
icons you want to select aren't lined up in such a way that you can
drag a rectangle around them. If they're scattered about, you can
select more than one by Shift-clicking.
If any icons are still selected, ftrst click outside any of them before
you select one again.

-

8. Select any icon by clicking it.
9. Hold down the Shift key on the keyboard, and click a second
Icon.

The second icon can be any icon in the same window. You can
even scroll to a different part of the window and Shift-dick.
You can continue to select more icons as long as you hold down
the Shift key when you click.
Any action you choose now will affect all the selected icons. You
can choose a command for them or move them by dragging the
whole group.

Changing your view

You can use the Finder's View menu to look at your documents in
different arrangements.
1. Choose the By Name command from the View menu.

The contents of the active window are arranged alphabetically by
name. You can also view them by date, by size, by kind, or with
small icons that give you more space in the directory window.

-

2. Choose the By Icon command from the VIew menu.

Now the items in the window are arranged the way they were when
you first started the system.
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Reading Read Me documents
Earlier in this tutorial, you used TeachText to learn how to start up
an application and create, edit, and save documents. But there's
another reason TeachText is included on the System Tools disk.
You can use TeachText to read ReadMe documents-without
having to use a full-feature word processing application.
With TeachText, Apple Computer and other manufacturers can
include Read Me documents with new applications and hardware
products, or with updated versions of system software, to make sure
the information you get is as up-to-date as possible. (It's a lot faster
to create a document on a disk than it is to produce an insert for the
book!) And some applications and desk accessories may not need a
whole manual to teach you how to use them: the document may be
all you need to learn how to use the product.
When you get a new application or system software disk and see a
Read Me document on the disk, use TeachText to open the
document. You can read the document on the screen, or (if you
have a printer attached to your Macintosh II) you can print the
document so you have a copy of it on paper.
Now you'll use TeachText to read a Read Me document on the
System Tools disk.
1. Close the System Folder window if it's not already closed.
2. Open the Update Folder.

You see a Read Me document in the window.

...

I

74

Chapter 2: Learning About Your Macintosh II

a

F11e

Edit

llleuo

Speudl

I iltm

Q

0
R•ad Mt

Figure 2-47
Read Me document Icon
3. Open the Read Me document.

-

This Read Me document gives you important information about
updating your application disks. You can read it now or come
back to it later when you've finished this tutorial.
If you have a printer attached to you r computer, you can print a
copy of the document. (Wait until you finish this tutorial.) See
"Printing" in Chapter 3 for instructions.
4. Close the Read Me document.
5. Choose Quit from the File menu.
6. Close the Update Folder to return to the desktop.
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Using a desk accessory
Macintosh desk accessories-the Alarm Clock and Calculator, for
example- are always available when you're on the Macintosh
desktop or in an application.
You choose desk accessories from the Apple menu on the far-left
side in the menu bar.
1. Choose Alarm Clock from the Apple menu.

The dock is displayed on the screen.
9:38:-11 A"1 e-t- - - - Lever

Figure 2-48
Alarm Clock
2. Click the "lever" on the right side of the clock.

The Alarm Clock expands to display and let you set whatever is
highlighted in the bottom panel-the time, date, or alarm.
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Figure 2-49
Alarm clock settings
See "Using Desk
Accessories· In Chapter 3
and "Desk Accessories· In
Chapter 4 for descriptions
of the other accessories in
the Apple menu.

You can click the icon that represents what you want to set, and !hen
click the digits you want to change. Click the up arrow to advance the
numbers, or click the down arrow to go backward. Click in the top
panel to set the clock
To display just the Alarm Clock again, click the lever. When you're
finished with the desk accessory, click its close box.
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Before you go
You're almost finished with this tutorial. Before you go, you may
want to drag TeachText from the folder you made earlier to the
System Tools window so you can find it easily later. If someone else
is likely to use the System Tools disk and this tutorial after you , it
might be helpful to the next person if you drag the TeachText Folder
to the Trash-but be sure to remove TeachText from the folder first!

Updating startup disks
At some point, you may need to update your other startup disks with
the system files on the System Tools disk so you can use them w ith
your Macintosh II. Some applications' startup d isks may have
earlier versions of Macintosh system software (the files in the
System Folder). They may no t work on the Macintosh II until you
update them. To update your startup disks, you use the Installer, a
utility program in the Utilities Folder on the System Tools disk. To
find out if your startup disks need updating, you can check the
version numbers for the two files Finder and System .
First check the Finder.
1. Choose Shut Down from the Special menu.
Your computer ejects the disk from the disk drive.
2. Insert the application's startup disk, and then press the
Power On key.
3. Choose About the Finder from the Apple menu.
A window will appear that tells you the version number of the
Finder o n that disk . (The lower the number, the earlier the
version.) The Finder should be version 5.4 or later.
Now check the System file.
4. Click anywhere in the window to close the window.
5. Open the application disk's icon if it's not already open.

r

-
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6. Open the System Folder.
7. Select the System icon, and choose Get Info from the File
menu.

'

'

~
I

Most application disks include the version number of the System
file in the comment box in the information window. If you don't
see a version number in the comment box, check the manual that
came with the application. The System file should be version 4.0
or later.
If the application's Finder and System files are earlier versions, see
"Using the Installer" in Chapter 3 for step-by-step instructions on
updating the disk.
Important

Once you update an application's startup disk. you will be able
to use the disk as a startup disk on most earlier models of the
Macintosh computer (the exception Is the Macintosh 128K). If
you plan to use the same application disk as a startup disk on
the Macintosh II and on an earlier model of Macintosh
computer. don't update the disk until you've read '"Startup
Disks· In Chapter 4. (Also be aware that some applications may
have compatibility problems with the new system software.)

I..,
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Starting your own work
You probably have some work you want to do on your Macintosh II.
But first, if your system includes the internal hard disk, go now to
Appendix A, "Working With Hard Disks, " to get your hard disk set
up and running. If you'd like to know more about the Macintosh II
before you start using an application, read Chapter 4, "Macincosh II
Reference." Be sure to use the InstaLler to update each startup disk,
and then read the manuals that came with the applications you want
to use. When you want some reminders or more informalion aboU[
using the Finder to organize your work, come back to Chapter 3 of
this book, "Your Macintosh II Step by Step." Enjoy!

Starting your own work
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This chapter tells you how to perform specific tasks. It summarizes
the basic techniques you'll use whenever you work with your Apple
Macintosh II computer-fro m clicking and dragging to using the
desk accessories in the Apple menu. It also describes the steps to
take when you want to use the Finder to manage your docume nts and
disks. For example, you'll read how to move a document fro m one
disk to another, how to copy a document or an entire disk, and how
to remove documents.

How to use this chapter
You don't have to read this chapter in any particular order; each
topic is independent of the others. When you want to know how to
do something (use the mouse, print or copy a docume nt, or
rename a folder, for example), go to the section on that topic.
There you'll find a brief, general discussion and step-by-ste p
instructions for performing specific tasks. Read the column labeled
for the task you want to perform and follow the steps, reading down
the column.
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A frame of reference

This chapter tells you in the most compact way possib le how to
perform Macintosh tasks. Depending on your level of e xpertise,
you might need more detailed information than you' ll find here.
Nearly everything In this chap ter is covered In greater depth in
Chapte r 4. "Ma cintosh II Reference: Look in that chapter to
see how each of these topics fits into the Macintosh II' s big
picture.

_ , - - - - - - - - - - - - - - - - - - - - - - Major topic
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Summary of mouse
techniques

You can do all your work on
the computer (except type
te xt and numbers) with five
mouse techniques:
o click, to select or make
active

To click

1. Position the pointer on what
you want to select or make
active.
2. Press and quickly release the
mouse button.

o press, to cause a continuous
actio n
o drag, to select or move
o double-click, to open icons
quickly
o Shift-click, to include a
selection in a group (or
deselect it)
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To press

1. Position the pointer on a
menu title, a scro ll arrow, o r
wherever you want the action
to happen.
2. Without moving the mouse,
press and hold down the
mouse button.
As long as you hold down the
mouse button, the effects of
pressing conti nue. Pressing
on scroll arrows results in
continuous scrolling.
Pressing o n a menu title pulls
down the menu and keeps it
down until you release the
mouse button.

-

-

To drag

1. Position the pointer on

something.
2. Press and hold down the

mouse button, and move the
mouse.

To double-click

To Shift-click

1. Position the pointer on

something.
2. Press and release the mouse

button twice in quick
succession.

1. Select something by clicking
or dragging.
2. Hold down the Shift key while

you continue to select (or
deselect) by clicking.

3. Release the mouse button.

-

You can usually cancel
dragging by moving the
pointer back to where it
started. Cancel dragging in a
menu by moving the pointer
off the menu . Cancel moving
a n icon or window b y moving
the pointer into the me nu
bar.

\

\
\

....... -.. -~:

\

\

\

\

\\

--- --'---- -- ... -- - - ~-- -

\ ~~~

--\

Summary of mouse techniques

85

n
Handling windows

A window frames its contents.
The contents can be a
directory of a disk or folder, a
des k accessory, or a
document you create w ith an
application.
A window always has a title bar
and may have
o scroll bars
oa close box

To activate a window

To move a window

1. Find an inactive window (one
w ithout horizontal lines in its
title bar).

1. Position the pointer a nywhere
in the title bar of the window
excep t the close box or zoom
box (if any).

2. Click anywhere in the window.

2. Drag the window to a new
location.

Activating a window brings it
to the front, w he re it can
overlap or completely cover
other windows. To see
covered windows, move the
active window or make it
smalle r.

The w indow becomes the
active window if it's not
already.

oa zoom box

To cancel the move, move
the pointer into the me nu
bar. You can't drag a window
comple tely off the desktop.

Each application's manual
tells you more about windows
in that application.

To move a window without
activating it, hold down the
Apple key while you drag.

o a size b ox

T ..
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To close a window

1 . Activate the window by
clicking anywhere inside it.
2. Choose Close from the File
menu or click the close box
on the le ft side of the title bar.

-

Some windows don't have a
close box. When that's the
case, you can usually close the
window by clicking an ywhere
inside it. If an application
doesn't have a close box or a
Close command, read that
application's manual to find
out how to close its window.

To zoom a window

To change a window's
size

1. To expand the window, click
the zoom box in Lhe top-right
corner of the Litle bar.
2. To shrink the window back to
its original (smaller) size,
click the zoom box again .
Some windows don't have a
zoom box.

1 . Activate the window by
clicking in it.
2. To use the size box, move the
window if necessary so that
the size box in the bottomright corner is visible.
3. Drag the size box or click the
zoom box.
Dragging horizontally
changes the width, dragging
vertically changes the height,
and dragging diagonally
changes both. The new
dimensions take effect only
when you release the mouse
button.
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Scrolling

Scroll bars let you see more of
a directory (that is, a list of a
disk's contents) or more of a
document.

To scroll line by line

1. Determine whether you want

to see the area preceding or
following the part of the
screen you're looking at now.
2. Click the arrow that points in
the direction of what you want
to see.
You can scroll continuously
line by line by pressing the
scroll arrow.

To scroll by the windowful

1. Note the position of the small
white box in the gray scroll
bar.
If the scroll box is at the very
top or bottom of the scroll
bar, you can only scroll in
one direction. If there is a
gray area above and below the
box, you can scroll in either
direction.
2. Click in the gray area of the
scroll bar.
You can scroll continuously
by the windowful by pressing
in the gray area of the scroll
bar.
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To scroll quickly to any
part of a directory or
document

1 . Determine what part of the
directory or document you
want to see.

""""'

The vertical scroll bar
represents the length of the
directory or document.
2. Drag the scroll box to a place

in the scroll bar that
represents that approximate
position.

For example, if you want to go
to about the middle of a
directory or document, d rag
the scroll box to the middle of
the scroll bar.
Some applications show the
page numbers in the scroll
box.

-

-
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Selecting icons

In the Finder, you select by
clicking or dragging.
See each application's
manual for instructions on
how to select information in
that application. See "Editing
Text" and "Renaming" in this
chapter for more about how
to select icon names and how
to edit them.

To select more than one
icon

To select an icon

When they're grouped
together:

• Click anywhere on it.
Clicking an icon's name also
selects the icon.

1. Position the poinler outside
one corner of a group of
icons.
2. Drag to the opposite corner.
You can choose Select All
from the Edit menu to select
all icons in the active window.
If you don't want to include
one of the icons, you can
deselect it; just hold the Shift
key down and click the icon.
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When they aren't grouped
together:
1. Select one icon by clicking.
2. Hold down the Shift key while
you continue to select icons
by clicking.
Holding the Shift key down
while you click a selected icon
deselects it.

a
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U1ew

You can also Shift-click to
select more than one item in
directories you 've arranged in
text views (that is, views other
than by icon).
You can select more than one
icon only whe n they're in the
same window or they're all on
the desktop.

Spenal
System Folde1

18 1ttms

'537~

m dt ;~

....

Selecting Icons

91

Editing text

In the Finder, you can enter
and edit
o the names of disks,
documents, folders, and
applicatio ns
o text in desk accessories such
as Scrapbook and Note Pad
o text in the comment box of
information windows (which
you open by choosing Get
Info from the File menu)
See each application's
manual for more on how to
enter and edit text in that
application.

To insert text

To select text

1. Click w select the insertion
point.
You can also use the direction
keys to move the insertion
point.
2. Type to add text at the
insertion point.

1. Drag across the text
(diagonally if there's more
than one line) to the end of
the text you want to select.
2. Double-click a word to select
it quickly.

When there's no existing text
(sometimes in dialog boxes,
for example), the insertion
point may already be
selected.
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To move text

To copy text

To replace text

1. Select by dragging across the
text.

1 . Select the text by dragging
across it.

1 . Select the text by dragging
across it.

2. Choose Cut from the Edit
menu.

2. Choose Copy from the Edit
menu.

3 . Select the insertion point by
d icking where you want the
text to go.

3. Select the insertion point by
dicking where you want the
copied text to go.

2. Type what you want to replace
the text with, or choose Paste
from the Edit menu to replace
the text with what was last cut
.or copied.

4. Choose Paste from the Edit
menu.

4. Choose Paste from the Edit
menu.
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To remove text
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1 . Select the text by dragging
across it.
2. Press the Delete key or choose
Cut or Clear from the Edit
menu.
If you really want to remove
the text (rather than move it
somewhere else), the Delete
key is the fastest way to do it.
Using the Delete key doesn't
affect the contents of the
Clipboard.
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Using desk accessories
Desk accessories, always available in the Apple menu, are miniapplications you can use in the Finder and in most applications.
Desk accessories let you do simple calculations while you're working
on a word processing docume nt, tell the computer which printe r to
use, and even keep a scrapbook full of your favorite illustrations or
text you use in a variety of documents.
Some desk accessories-the Alarm Clock, Calcu lator, Chooser,
Control Panel, Find File , Key Caps, and Scrapb ook-are installed
automatically on your application disks when you update them with
the system software on the System Tools disk. (See "Startup Disks"
in Chapter 4.) You can also use the Font/D A Mover to add or
re move desk accessories from your startup disks. (See the
Macintosh System Utilities User's Guide for informatio n on using
the font/DA Mover.)
The desk accessories installed on a startup disk are available in the
Apple me nu whenever that disk is the current startup disk. The
Utilities disk includes a desk accessory file with Note Pad and
Puzzle- desk accessories you might want to add to other startup
disks. You can also purchase additional desk accessories and add
them to your startup disks.
This section explains how to use the Chooser, the Control Panel,
Find File, and the Scrapbook. Sec "Desk Accessories" in Chapter 4
for information about othe r desk accessories.

Using desk accessories
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Using the Chooser

-

To connect or disconnect
AppleTalk

You use the Chooser desk
accessory (from the Apple
menu) to connect to o r
disconnect fro m an
AppleTalk network, to choose
between devices connected
directly to your computer's
Printe r or Modem ports, or to
choose printe rs, file servers,
or other devices on the
AppleTalk network. (See
"AppleTalk Personal
Netwo rk" in Chapter 5 for
more information.)

AppleTalk is a commu nications network you can use to
connect computers and to
share printers and other
devices on the network.
1. Click Active if you're
physically connected to
AppleTalk.
2. Click Inactive if you're
physically disconnected from
AppleTalk.

The Chooser shows icons for
the devices available to you,
based on the resources of the
current startup disk. In order
to ensure that you get the most
out of the Chooser, you'll
want to know about the
Installer-a utility program
that installs the Chooser so it
appea rs on the Apple menu
and updates the most current
resources on your startup
disk. For more information,
see "Using the Installer" late r
in this chapter.
If you use the Chooser from
within an application to
change printers, choose Page
Setup and confirm the settings
you want before you choose
Print.
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The AppleTalk connection
setting should always match
whether you're connected to
AppleTalk o r not. When you
physically connect or
disconnect AppleTalk, always
come here immediately and
click the appropriate box.
3. Type you r name in the User
Name box so the network can
let other users know when
you're using a shared device.

-

To choose a printer
connected directly to your
computer

To choose a device on an
AppleTalk network

1. Click the icon that represents
the printer you want to use.

1. Click the icon that represents
the type of device you want to
use.

When you click the icon, a
box appears that presents
icons for the Printer and
Modem ports.

If necessary, use the scroll bar
to find the icon you wa nt.
When you dick an icon, a
Select box appears and lists
the names of all the devices
available on your network.

2. Click the icon that represents
the port your printer is
connected to-either the
Printe r port or the Modem
port.

3. Type your name in the User
Name box so the network can
let other users know when
you're using a shared device.
For more information, see
"AppleTalk Personal
Network" in Chapter 5.
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AppleTalk networks can be
linked together to form an
interconnected series of
AppleTalk zones. If your
network is linked with other
AppleTalk networks and you
have access to multiple zones,
use the Chooser to scan for
devices on those zones.
1. Click the icon that represents
the type of device you want to
use.

2. Click the device name to
select the device you want.

The ports on the back of your
computer are marked with
icons to let you know which
one is for the printer and
which one is for the modem.

To choose a device on
another AppleTalk
network

If necessary, use the scroll bar
to find the icon you want.
When you click an icon, two
new boxes appear. The Zones
box lists all zones you have
access to, and the zone that
first appears highlighte d is the
one your computer is on. The
Select box lists the names of
all devices (of the type you
just chose) that are connected
to the highlighted zone.
2. Scan each zone by clicking on
its name until you fmd the
device you want to use.
3. Click the device name to
select the one you want.
4. Type your name in the User
Name box so the network can
let other users on the network
know when you're using a
shared device.
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Using the Control
Panel

To set Desktop Pattern

To set Rate of Insertion
Point Blinking

You use the Control Panel
from the Apple menu to
personalize your computer to
your way of doing things. In
the Control Panel, you select
icons that represent parts of
your computer system.
Selecting an icon brings up a
box of features for you to
choose among.

You can customize your
desktop by selecting from a
variety of desktop patterns or
designing your own.

When you click the pointer to
insert text in a document, the
insertion point blinks so it's
easie r to see on the screen.
You can adjust the rate of its
blinking.

Make sure you update each of
your startup disks to have the
current Control Panel.
See "Control Panel" in
Chapter 4 for more
information.

1. Click the General icon if it
isn't already highlighted.
The Control Panel shows a
miniature desktop where you
can look at a pattern and a
magnified view of the pattern.
2. Change the pattern as you
wish.

o Click (or drag through) dots
to change them from black to
white or vice versa.
oClick the white "menu bar"
in the miniature desktop to
see a sample pattern. (Click
on the right to see the next
pattern; click on the left to see
the preceding pattern.)
o Set the pattern by clicking
the miniature desktop below
the white bar.
oWith a color monitor,
change the colo r of the dots
in the pattern by selecting the
dots and clicking one of the
eight colors in the color bar.
To choose different colors,
double-click on a color in the
color bar to bring up a color
wheel.
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1 . Click the General icon if it

isn't already highlighted.
Use the scroll bar if necessary
to bring the General icon into
view.
2. Click any button from Slow to

Fast to set the rate at which the
vertical bar marking the
insertion point blinks.

To set Menu Blinking

To set the Time

""""

To set the Date

""""
1 . Click the General icon if it
isn't already highlighted.
Use the scroll bar if necessary
to bring the General icon into
view.
t"""";

1. Click the General icon if it
isn't already selected.

1. Click the General icon if it
isn't already selected.

2. To select a time format, click
either 12 hr. or 24 hr.

2. Click the digits you want to
change; then click the up or
down arrow to scroll the
numbers higher or lower.

3. Click the digits you want to
change; then click the up or
down arrow to scroll the
numbers higher or lower.

2. Click any button from 1 to 3 to
determine the number of
times menu items blink
If you don't want menu items

""""

to blink, dick Off.
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Using the Control Panel

To use RAM Cache

To set Speaker Volume

3. Use the arrows to scroll to the

Using the RAM cache can
greatly speed up your work,
allowing an application to
store some of the information
it needs in a part of memory
you reserve just for this. When
the application needs the
information again, it doesn't
have to go to the disk but can
get it much more quickly from
the RAM cache in memory.

amount of memory you want
to use for the RAM cache.
Because the RAM cache takes
some space in memory, you
may not want to use it with
applications that require large
amounts of memory. A rule of
thumb is to use no more than
one fourth of the computer's
available me mory (no more
than 256K if your system
doesn't have a RAM
expansion kit).

1 . Click the General icon if it
isn't already highlighted.
2. Set RAl'v1 Cache On.
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1. Click the General icon if it
isn't already highlighted.
2. Adjust for the volume you

want by dragging the knob up
or down.
Setting the lowest volume
makes the computer alert you
subtly by blinking the menu
bar rathe r than by making an
Alert Sound.
For more control over sound,
click the Sound icon to set
preferences for the Alert
Sound. (Scroll the menu on
the left side of the Control
Panel to see the Sound icon.)

To set Key Repeat Rate

When you press and hold
down a character key, the
Macintosh II begins repeating
that character. You can set
the rate at which a key you
press will repeat.

~

...
,....

1. Click the Keyboard icon if it
isn't already selected.
If necessary, use the scroll bar
to bring the Keyboard icon
into view.

~

,_

To set Delay Until Repeat

2. Click any button from Slow to
Fast to set the rate.

__ o

Control Pdnel

1'-~'1
=

1 . Click the Keyboard icon.
Use the scroll bar if necessary
to bring the Keyboard icon
into view.
2. Click any check box from
Long to Short to set the length
of time the computer waits
before repeating a key you're
pressing. Click Off to turn off
key repeating.
Set a longer delay if you're
getting a lot of repeated
characters when you don't
intend them.

----

L.r

~

Ktoy Reput Rate

Delay Until Rep&at

r--

00®00

0 0®00

Slow

C•-:-r.·~·r":, 1

--

Fast

Off Lonq

Short

11!!!!11
-

li--11

f ~ ·~· r11 t •:, r · :

Ell

I
r

k~u:~-:-

:n:

~. II

Using the Control Panel

101

~
'

I

I

To set Monitor Status for a
single monitor

If you have a single monitor
connected to your computer,
you spedfy whether you want
to see colors or grays and how
many of either your monitor
will display.
1 . Click the Monitor icon if it
isn't already highlighted.
The monitor controls will
appear.
2. Click Color or Monochrome.
With a color monitor, even
though you may prefer color
most of the time, you might
want monochrome when
you're doing a lot of word
processing.
Monochrome monitors won't
show color, of course, but you
can click either Monochrome
or Color to vary the quality of
the grays on your screen.
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Clicking Monochrome gives
you a true gray scale-evenly
spaced shades of gray.
Clicking Color gives you the
gray equivalents of colors.
(1he grays you see depend on
the luminance of the colors
represented. It's like watching
a color show on a black-andwhite television set.)

3. Scroll to the number of colors
or shades of gray you want.
If you clicked Monochrome in
step 2, the heading will say
No. of Grays. If you clicked
Color, it will say No. of
Colors.
With the standard video card,
you can get a maximum of 16
colors or grays. With the
video card expansion kit
installed, you can get a
maximum of 256. (More
colors or grays means
drawing to the screen will be a
bit slower.)
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If you choose to limit the
number of grays to two, you
will not be seeing a true gray
scale. Black and white will be
the only colors on your
screen. (This will look the
same as the screen on earlier
versions of the Macintosh.)
4. If your monitor is color, click
the Convergence Test button
to check the convergence
pattern.
This will help you verify that
the red, green, and blue light
beams are aimed correctly for
the best color picture. (If you
don't know how to adjust
color convergence, see the
monitor manual.)

With a monochrome
monitor, convergence
pattern is not an issue, but it's
OK to click the Test button if
you're curious.
Once you've completed these
selections, your monitor is
set. And you can always come
back and change your choices
when your needs change.

....

. I

To set Monitor Status for
multiple monitors

~

~

-~

~

With multiple monitors (all
connected to your Macintosh
II), you make the same
choices as you would with a
single monitor-and you
repeat some parts of the
process for each of your
monitors. You also position
your monitors to suit your
needs, select a Main Monitor,
and fine tune the way your
monitors relate to each other.
(For more information, see
"Monitors and the Control
Panel" in Chapter 4.)
1 . Click the Monitors icon if it
isn't already highlighted.
The monitor controls will
appear.
The box at the bottom of the
panel shows an icon for each
of the monitors connected to
your main unit. The first time
you bring up the panel,
monitor 1 will be highlighted
to show that it is the "selected
monitor." (You will select
each monitor in tum when
you are ready to make choices
about that monitor's status.
See step 5.)

2. Click Color or Monochrome
for the selected monitor.

With the standard video card,
you can get a maximum of 16
colors or grays. If you ha~e
installed the video card
expansion kit, you can get a
maximum of 256. (More
colors or grays means
drawing to the screen will be a
bit slower.)

With a color monitor, even
though you may prefer color
most of the time, you might
want monochrome when
you're doing a lot of word
processing.
Monochrome monitors won't
show color, of course, but you
can click either Monochrome
or Color to vary the quality of
the grays on your screen.
Clicking Monochrome gives
you a true gray scale-evenly
spaced shades of gray.
Clicking Color gives you the
gray equivalents of colors.
(The grays you see depend on
the luminance of the colors
represented. It's like watching
a color show on a black-andwhite television set.)
3. Scroll to the number of colors
or shades of gray you want.
If you clicked Color in step 2,

the heading will say No. of
Colors. If you clicked
Monochrome, it will say No.
of Grays.

If you choose to limit the

number of grays to two, you
will not be seeing a gray scale.
Black and white will be the
only colors on your screen.
Obis will look the same as the
screen on earlier versions of
the Macintosh.)
4. If the selected monitor is
color, click the Convergence
Test button to check the
convergence pattern.
This will help you verify that
the red, green, and blue light
beams are aimed correctly for
the best color picture. Of you
don't know how to adjust
color convergence, see the
monitor manual.)
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If the selected monitor is
monochrome, convergence
pattern is not an issue, but it's
OK to click the Convergence
Test button if you're curious.

5. In the box at the bottom of the
panel, click an icon to select
the next monitor for which
you want to defme
characteristics.
•:• Repeat steps 2 through 5 for
each of your monitors.

6. Identify the positions of your
monitors.
In the lower part of the panel,
drag each icon to the correct
position according to the
actual location of the
corresponding monitor in
your work area. That is, if
monitor 2 sits on a shelf
above monitor 1, drag its
icon to sit on top of the icon
for monitor 1, and so on.
Continue placing the icons
until you've reproduced your
entire monitor setup.

Put simply, in order to
coordinate activities among
multiple monitors, your
computer wants to know where
they are. You create a replica
of your setup by positioning
monitor icons to correspond
to the physical arrangement
of monitors in your work area.

8. If you have changed the
positions of any monitor
icons or identified a new main
monitor, close the Control
Panel and choose Restart
from the Special menu.
You must restart the compuler
for these changes to take
effect.

7. Identify your main monitor
by dragging the menu bar to
the appropriate icon.
The Main Monitor is the one
on which you'll find the
standard menu bar. In effect,
it's your base of operations.
You can designate any one of
your monitors as the Main
Monitor.
When you first use this panel,
monitor 1 will automatically
be selected as the main
monitor. You can change that
setting or leave it as is.

~
I
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To set Your Double-Click
Speed

To set Mouse Tracking

1. Click the Mouse icon.

1. Click the Mouse icon.

Use the scroll bar if necessary
to bring the Mouse icon into

Use the scroll bar if necessary
to bring the Mouse icon into

view.

view.

2. Change the Mouse Tracking
speed to meet your style.
o Click a button from Slow to
Fast to make the pointer
movement speed variable.
If you set the mouse speed
faster, you won't have to
move the mouse as far as you
othetwise would when you
want to jump to another part
of the screen.
OR

oClick the Very Slow (Tablet)
button to keep the pointer
speed constant.
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o Click the middle button if
you're somewhere inbetween.

(Moust)
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oClick the rightmost button if
you've got a fast mousebutton finger.

Moun Tracking

(Tablet)

•

oClick the leftmost button for
the computer to interpret
fairly slow successive clicks as
a double-click.
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2. Change the double-click
speed to match your own
speed.
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To set Startup Device

To set the sound controls

, ~It
,
I

1 . Click the Sound icon.

2. Set the volume you want by
dragging the knob up or
down.
At the lowest level, the
computer blinks the menu bar
to alert you (with no sound).

There are several choices
available. The speaker plays
back each sound as you click
it, and you can try them all to
find the one you prefer to
hear when the computer wants
to get your attention.

This control is the same one
that appears when you click
the General icon. Setting the
volume in either place moves
the knob in both places.
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Use the scroll bar if necessary
to bring the Startup Device
icon into view.
The icons that appear
represent all the devices that
might contain the information the computer needs to
get started.
2. Click the device you want your
computer to start from.

jlllll..
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Until you change it, this will

3. In the Alert Sound Setting
box, click the sound that suits
you best.

-----::

1. Click the Startup Device icon.

be the disk drive your

computer will start from each
time you turn your computer
on (assuming there's no
startup disk in one of the
3.5-inch disk drives).
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Using Find File

-

To use Find File in a search

You use the Find File desk
accessory to find any folder
o r file (a document,
application, resource, o r
system file) on the disk.

When you see the name of the
file you want and select it,
Find File also tells you when a
file was created, when you last
changed it, how big it is, and
how much space it takes up on
the disk. In addition, Find File
will show you where in the
hierarchical file system it
found the file you wanted.
Find File will even move the
file to the desktop for you.

The hierarchical file system
makes it easy to store dozens
of documents away in
d iffe rent folde rs-especially
on a hard disk. You can even
store several docume nts or
folders w ith the same name in
diffe re nt places, or in folders
within folders w ithin folders.
(See "Managing Documents,
Folders, and Applications"
later in this chapter.) 13ut with
all that flexibility you may
sometimes lose track o f where
you've stored a particular
docume nt. Find File locates
the me or folder you ask for.

The Find File box comes up,
and a new menu title, Find
File, appears on the me nu
bar.
2. Type the name (or part o f the

name) of the file you're
looking for.
If you type apple, Find File
will look for any folder or file
that has the word apple in any
part of its title-for example,
Letter to Apple or applesauce.

You can use Find File e ither
from the Finder or from
within an application.
Find File will make an Alert
Sound when it's finished
searching.

frl

Current disk name

r rl

P

-
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Find Fil e
=' syste m Too ls

Click here to chang e drives.

-

1 . Choose Find File from the
Apple menu.

Searc h for: .1app l~
Type title to look fo r here .
10

Click here to start search .
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Matching titles app ear here.
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If you type several words (or
partial words) separated by
spaces, Find File will look for
titles that have all of the words
in them. (Technicall y
speaking, it does an AND
search.) For example, apple
letter finds Letter to Apple, but
not applesauce or Letter to
mom, because only Letter to
Apple contains both apple and

letter.
o To search for a file on a disk
in another drive, click on the
current disk's icon in the topleft corner of Find File's
window.

3. To focus the search, choose
Search Here from the Find
File menu.
You will sec a standard file
dialog box. With largecapacity hard disks, it's
possible to create multiple
files with the same (or similar)
names. This d ialog box lets
you select drives, eject disks,
and limit the search to suit
you r needs.
o To change disks, d ick Eject.

o To open a selected folde r,
dick Open folde r (or double
click on the folder's name.)
oTo close an opened folder
and drop back one leve l in the
directory, click on the disk
named above the Eject
button.
o To select the current folde r
or disk for searching, click
OK.

oTo cance l limited
searching, click Cancel.

o To change d rives, click
Drive.

\1•<11

r:E:J

r h:

\lj\ tr•m""j"ij(ij'\1

CJ S stem Folder.

\lJ\Iern Tool\

C; Updole lnlrler

Ulilrloe \ I ohll•r

Click here to close
on opened folder. - - - - - - - - - : - - - - - - - - - - /

yect

... -DIIll(?
Open roldPI

OK
( am el

108

Chapter 3: Your Macintosh II Step by Step

-

To stop the search, click the
Stop butto n. Once you click
Stop, the search is cance led
(and clicking the running man
again will not resume the
search)_

4. Click the Running Man icon
(or press Re turn)_

-

Find File starts a systematic
search of all the folders and
files on the current disk,
looking fo r titles that match
what you've typed into the
Search for box.

When Find File has finished
searching, it makes an Alert
Sound.

Each time it finds a match ,
Find File displays the name of
that file or folde r.

I

Click here to change d isks.
Here's who t you wanted.
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5. Select the file or folder you're
interested in.
In the bux at the bottom right,
Find File shows you the path
to that file or fo lder.
In the box at the bottom left,
you'll find valuable
information about the file o r
folder you've selected.
You don't have to wait for
Find File to stop searching to
get information; just click the
title you're interested in at any
time.

6. Choose Move to Desktop
from the Find File menu.
The file selected (in step 5)
will be moved automatically
from where it was stored to the
desktop where you can easily
work with iL
If the file stays on the desktop
while you work on it, you can
use the Put Away command to
put it back exactly where it
came from. Of course, you
can put it into any window or
folder you choose.
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Here's information about it.
Here's where it is.
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Using the Scrapbook

You can paste your favorite
pictures and text into the
Scrapbook and retrieve them
whenever you want to use
them again. You can cut,
copy, and paste images
among the Scrapbook, your
documents, and any desk
accessory that uses text. (For
example, you might keep your
letterheads there.)
The contents of the
Scrapbook are stored in the
Scrapbook file on the current
startup disk. You can move
these Scrapbook files among
your startup d isks to customize
the disks with the contents you
want. (See "Copying or
Moving a Document, Folder,
or Application" late r in this
chapter and "The Current
Startup Disk" in Chapter 4.)
Depending on the size and
contents of the image you
paste into the Scrapbook, you
might not see the entire image
until you paste it somewhere
else.

To add an image to the
Scrapbook

4. Choose Paste from the Edit
menu.

1 . With a document or desk
accessory open, select the
text or pictures you want to
add to the Scrapbook.

The image is pasted in front of
the curre nt image in the
Scrapbook. 'The text on the
bottom left tells you the
position this image has in the
Scrapbook. The text on the
bottom right tells whethe r the
image is text or a picture. On
certain cases it may indicate
which application the image
came from.) You can use the
scroll bar to look at the
different items in the
Scrapbook. (See "Scrolling"
earlier in this chapter.)

See each application's
manual for how to select using
that application.
2. Choose Cut or Copy from the
Edit menu.
Choosing Cut removes the
original; choosing Copy just
copies it. What you selected is
placed on the Clipboard,
where it remains unti l you
next choose Cut or Copy.
3. Choose Scrapbook from the
Apple menu.
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To remove an image from
the Scrapbook

To move or copy an
image from the
Scrapbook to a document

1. Open the Scrapbook and
make it active.

1. Open the Scrapbook and
make it active.

2. Scroll to the image you want
to remove. (See "Scrolling"
earlier in this chapter.)

2. Scroll to the image you want to
move or copy.

As each image appears in the

Scrapbook window, it is
automatically selected.
3. Choose Cut or Clear from the
Edit menu.

The image is removed from
the Scrapbook.

'Ine current image is
automatically selected.
3. Choose Cut or Copy from the
Edit menu.
The image is placed on the
Clipboard, where it remains
until you next choose Cut or
Copy.

4. Open the document you want
to add the image to.
If the document is already
open, just dick in it to make it
the active window.
5. Select the place you want the
image pasted into.

6. Choose Paste from the Edit
menu.
The image is paste d into the
docume nt.

E. D. Christopt
Architect
855 Spr uce Dri\
Hillsdale, OH 44
(5 13) 555- 164
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Managing documents, folders,
and applications
This section summa rizes how to use the Finde r to manage your
documents, folders, and applications-how to copy, move,
discard, re name, lock, or just rearrange the m. It also includes a
summary of how to manage your documents when you 're using an
application. It shows you how the folders you create in the Finder
appea r whe n you're saving and opening documents w ithin
applications.
!-low you organize your work on the desktop is u p to you. You can
nest folders o ne inside the other to create as many hie rarchical
levels as you want, and you can view the contents of each folder
arranged by icon , name, date the file was last modified, size, or
type. Choosing a different view from the View menu instantly
rearranges the active directory window in the view you choose. For
example, you can quickly see which document is taking the most
space or w hich is the latest version of a report you're preparing.
The desktop itself is always arranged by icon.

-

You can do any of your desktop work with the directories in any
arrangement, and you can have different directories in different
arrangements at the same time. Every item in a directory is
represented by an icon, no matter what arrangeme nt you have the
directory in. In any of the text views, the icon is small and appears
to the left of each name. You can click, doub le-click, drag, or Shiftclick this icon just as you would its counterp art in an icon view of the
directory.

Ma na ging docum e nts. folders. and a pplic ations
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Creating and
opening documents

You create a new document
by opening the application
you want to use.
When you're using an
application, you can create
more documents by choosing
New from the File menu. Sec
"Managing Documents
Within an Application" later
in this chapter.
You open an existing
document from the finder by
opening the icon that
represents the document you
want to work on. The
application you'll use with
that document starts
automatically.

1. Select the icon for the
application you want to use.
If necessary, insert the disk
that contains that
application, open the disk
icon and any folde rs you
need, and scroll until you see
the application icon.
2. Choose Open from the File
menu.
The appropriate application
starts. Usually a new, untilled
document appears; you'll
name it the first time you save
it.

1 . Select the icon that represents
the document you want to
work on.
If necessary, insert the disk or
disks that contain that
document and the
application you used to create
it, open the disk icon and any
folders you need, and scroll
until you sec the document
icon.

n

-

2. Choose Open from the File
menu.
You can also double-click the
icon to open iL

You can also double-click the
icon to open the application.

You can also open an existing
document while worki ng in an
app lication. See "Managing
Documents Within an
Application" later in this
chapter.
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To open an existing
document

To create a new
document
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Using folders

Folders let you create a
hierarchy of system files,
applications, and documents
so you can arrange your work
in whatever way you want and
get at what you need qu ickly.

To create a new folder

To place a folder and its
contents inside another
folder

• Choose New Folder from the
File menu.

• Drag the folde r to the folder
icon or window you want it in.

A folder named Empty Folder
appears in the active window.
You can rename it by typing.

If you work with just a few
applications and a moderate
number of documents, you
may prefer not to nest many
levels of folders within
folders. It's easie r to see
everything that's on a disk
without having lots of folders
w rummage through. But if
you have many documents,
and especially if you have a
hard disk, folders help you get
rid of clutter you're not
interested in at the moment,
and they greatly speed up
access to what you do want.

-

The folder you drag (the
source folder) and its
contents are placed inside the
folde r you drag to (the
destination folder). If the
destination folder is on a
different disk, the source
folder is copied rather than
moved.
If the destination folder
already contains a folder with
the same name , you'll be
asked whether you want to
replace the existing folder.
Clicking OK replaces the
existing folder and its
contents with the source
folder and its contents,
whether or not the folders'
contents include duplicate
names.

No matter how deeply you
nest folders, you can always
find a document by using the
Find File desk accessory. See
"Using Find File" earlier in
this chapter.
For more information on the
hierarchical file system, sec
"The Hierarchical File
Syste m" in Chapter 4.

. ,, ,
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To move a document,
folder, or application from
one folder to another

• Drag the item you want to
move from the folder it's in to
the folder icon or window you
want to move it to.

To use folders within an
application

See "Managing Documents
Within an Application" later
in this chapter.

If the destination folder is on
a diffe rent disk, the item is
copied, rather than moved,
to the new folder. If the
destination folder already
contains an item with the
same name, an alert box will
appear, asking you to rename
the item you're moving.
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Renam ing

You can re name a document,
folder, application, o r disk
whenever its icon is visible in
the Finder. (You may need to
insert the dis k that contains
w hat you want to rename,
open the disk icon and any
fo lders you need to, and
scroll until you see the icon.)
If you rename a disk, write the
name on the dis k label. That
way, when the computer asks
you to insert a specific d isk,
you'll know which one it
needs.
You can usually use the Save
As command within an
application to save a
document after assigning it a
differe nt name. See
"Managing Docume nts
Within an Applicati o n" late r
in this chapter.

To rename an icon

1 . Select the icon that represents

what you want to rename.
You need to click an icon o r
its name to re name it, even if
the icon is already selected.
(This prevents your re naming
something when you don't
intend to .) There are some
exceptions: when you create a
new folde r by choosing New
Folder from the File menu o r
w hen you duplicate a n item
on the same disk o r copy it to
a d ifferent disk, typing
renames whatever's selected,
without your having to click
on it.

2. Type the new name.
The selected text (the old
name) is replaced by the new
text you type.
Use names that will help you
identify the contents (the
more specific, the better).
Document and folder names
can be up to 31 characters
(though a name that long is a
little unwield y), and disk
names can be up to 27
characters. You can use any
character on the keyboard,
except a colon(:). You can
use uppercase o r lowercase
letters and put spaces between
words.
3. If necessary, use the Edit
menu to edit the text
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Copying or moving a
document, folder, or
application

To copy to the same disk

You can use the Finder to
copy a docume nt, folde r, or
application to the same disk
whe never you can see its icon.
You might do this to make a
backup copy. (See also
"Copying an Entire Disk"
late r in this cha pte r.) Or you
might want to make a copy of
a docume nt to work on
without alte ring the original.
For examp le, you might do
this to create forms,
letterheads, o r te mplates.

1 . Select the icon that rep resents
the docume nt, folder, or
application you want to copy.

You can copy a docume nt,
folder, or application to
anothe r disk whe never both
disk icons-the one that holds
the source and the one that
represents the
destinatio n-are present. The
source disk must be opened
into a directory window so
you can select the docume nt,
folde r, o r application you
want to copy; the destination
disk can be either in icon
form or opened into a
di rectory window.

2. Choose Duplicate fro m the
File menu.

To make a copy of a
document while using an
a pplication, see "Managing
Docu ments Within an
Application" la te r in this
chapte r.
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If necessary, insert the disk or
disks that contain what you
want to copy, open the disk
icon and any folders you need
to, and scroll until you see the
icon.
See "Selecting Icons" earlier
in this chapte r for how to
select mo re than one icon to
duplicate.

A new icon appears. The
du plicate icon has the same
name as the original, preceded by the words Copy of
You can drag the duplicate
copy to any fo lde r, disk icon,
or window.

3. Rename the duplicate.
You can rename any
duplicate copy of a docume nt
or folder by typing
immediate ly after you create
the copy. Any o the r lime, you
must click the icon that
represents what you're
renaming before you type the
new name. See "Re naming"
earlier in this chapter.
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To copy or move to a
different disk

1. If necessary, insert the
destination disk (so its icon
will be present).
2. If necessary, insert the disk
that contains what you want to
copy.
If you're using a one-drive
system, eject the destination
disk before you insert the
source disk.

3. Open the disk icon and any
folders you need to, and
scroll until you see the icon
that represents what you want
to copy.
See "Selecting Icons" earlier
in this chapter for how to
select more than one icon to
copy.

-i. Drag what you want to copy to
its destination.

You can drag it to a disk or
folder directory window, o r Lo
an icon (even a hollow icon)
that represents the dis k or
folder you want it to be in.
In an open directory window,
you can place the icon
wherever you wanL If you drag
to an icon, the Finder p laces
the item in the next available
spot.
If you're using a one-drive
system, the computer will
presenL a series of dialog
boxes, asking you to insert
alternately the source dis k and
the destination d isk.

If the destination d isk already
contains an item with the
same name, you'll be asked to
confirm that you want to
replace the current contents
with what you're copying.
The copy appears in the
window you dragged to. (If
you dragged to a disk or folder
icon, the copy will appear in
the directory window when
you open the icon.)
5. If you're moving (rather than
copying), drag the original to
the Trash.
\Vhenever you drag from one
disk to another, a copy of
what you move is left behind
for safekeeping. lf you want to
reclaim the space on the
original disk, you can drag the
remaining icon to the Trash
and choose Empty Trash
from the Special menu.

Copying or moving a document. folder. or application
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Removing or
recovering an item

You can throw away a
document, folder, or
application whenever you can
see its icon. The Trash can be
visible as an icon or opened
into a directory window.
\'Vhen you put an item in the
Trash, the Trash icon
"bulges" to let you know
there's something in ir.
What you put in the Trash is
not immediately gone
forever. If you open the Trash
and can see the icon for a
document, folder, o r
application in the Trash
window, you can recover ir.
Things won't stay in the Trash
indefinitely, but you can
usually recover what you've
thrown away unless one of
these events occurs:

To remove a document,
folder, or application

1. Open the window that
contains what you want to
remove, and scroll until you
see the icon or icons.
2. Drag the icon or icons that
represent what you want to
remove to the Trash icon or
window.
Discard the contents of an
entire disk by choosing Select
All from the Edit menu and
then dragging any item to the
trash; the rest will follow.
To reclaim the space
immediately, choose Empty
Trash from the Special me nu.
(But be aware that you won't
be able to recover anything
once you've emptied the
Trash.)
--~

oYou choose Empty Trash
from the Special menu.
DThe Finder needs the space.
o You start an application.
o You eject the disk the items
came from by dragging it to
the Trash.
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To recove r a document,
folder, or application

You can recover an item as
long as you can see its icon in
the Trash window.
1 . Open the Trash window and
scroll until you can see the
icon that represents what you
want to recover.
2. Drag the icon out of the Trash
window onto the desktop or
into another window.
If you can't remember where
items in the Trash came from,
you can select what you want
to recover and choose Put
Away from the File menu.
This puts the item back where
it came from originally.

r

-

Locking a document
or application

To lock a document or
application

Locking a document or
application prevents it from
being renamed, thrown away,
or changed. You can,
however, open and print
locked documents.

1 . Select the icon for the
docume nt or application you
want to lock.

1 . Select the icon for the

2. Choose Get Info from the File
menu.

2. Choose Get Info from the File

The information window
appears, filled with
information about the ite m.

The information window
appears, filled with
information about the ite m.

See "Disks" in Chapter 4 to
learn how to lock disks
physically.

To unlock a document or
application

document o r application you
want to unlock.
menu.

3. Click the checked Locked box.

3. Click Locked.
The Locked box is checked.
Directories in text views
indicate whlch of your
documents and applications
are locked by displaying a
small padlock (to the right of
the document's name).
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Kind : Mo~cPaint docum•nt
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Printing

In the Finde r, you can print a
docume nt, a group of
documents (if they were
cre ated by the same
application), the contents of
the e ntire screen, or a disk or
folder directory. (With an
ImageWriter® II, you can also
print the conte nts of the
active window .) You can print
a document wheneve r you can
see its icon and a disk that
contains its application is
currently inserted. When you
print from the Finder, the
document's application is
opened automatically.

To choose a printer

To print a document from
within the Finder

1 . Choose the Chooser desk
accessory from the Apple
menu .

1 . Select the icon that represents
the docume nt you want to
print.

2. Make sure the printer named
and selected in the Chooser
list box is the one you want to
print to.
If the printer named is not
correct, select the one you
want. See "Using the
Chooser" earlier in this
chapter.

If you're using a printer other
than the ImageWriter II, if you
have more than one printer,
or if your printer is attached
somewhere other than the
Printer port, use the Chooser
desk accessory to tell the
compute r which printer to
use. See "Using the Chooser"
earlier in this chapter.
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2. Choose Print from the File
menu.
One or more dialog boxes
might appea r, with options
for printing your document.

To print a document while
using an application, see
"Managing Documents
Within an Application" later
in this chapter.
If you're using an ImageWriter
II, make sure that the printer is
ready, the select light is on,
and the pape r is at the top of a
fo rm.

If necessary, insert the disk or
disks that contain the
docume nt and the
application you used to create
it, open the disk icon and any
folders you need to, and
scroll until you sec the
document icon.

-

When you are printing
docume nts from the Finder,
Page Setup (from the file
menu) does not apply.
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To print a group of
documents from the
Finder

1 . Select the document icons.

-

See "Selecting Icons" earlier
in this chapter to see how to
select mo re than one
document to print.
If necessary, insert the disk or
disks that contain those
documents and the
application you used to create
them, ope n the d isk icons a nd
any folders you need to, and
scroll until you sec the
document icons.

To print the current
contents of the entire
screen

To print the current
contents of the active
window

1. Make sure you are connected
to an ImageWritcr IT.

1. Make sure you are connected
to an ImageWriter II.

You can't use this method
with a LaserWriter®.

You can't use this method
with a LascrWritcr.

2. With Caps Lock down, hold
down the Apple and Shift keys
while you press 4.
If you're also pressing the
mouse button, the actio n will
start whe n you release the
button.

2. Hold down the Apple a nd
Shift keys while you press 4.
If you're also pressing the
mouse button, the action will
start whe n you release the
button.

2. Choose Print from the file
menu.
The selected documents will
be printed.

Ul I l'\JIOillll'IH I'
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To print the first-level
directory of a disk or folder

1 . In the Finder, select the disk
or folder icon whose
directory you want to print, or
make the directory window
active.
2. Choose Page Setup from the
File menu to set paper size,
printing orientation, and
other options.

3. Choose Print Catalog from
the File menu.
A dialog box will appear.
4. Select printing options from
the choices that appear in the
dialog box, and click OK or
press Return.

Anderson et al.
Name

D
D
D
D

Anderson contract
Celebration Invitations
Kudos
Permits

Size Kind

La~l

Mgdi[i§d

14K MacWrite document Thu. May 21, 1987 7:37 AM
9K MacPaint document

Wed, May 20, 1987 9:19 PM

folder

Tue, May 19, 1987 5:23PM

folder

Wed, May 6, 1987

9:14AM

Thu, Apr 23, 1987

5:16PM

D
D

Presentation Cover Art

13K MacPaint document

Anderson Proposal Final

15K MacWrile document Thu. Apr 23, 1987 2:19PM

D

Status Reports

D
D

Anderson Plan Additions

14K MacDraw document Fri, Apr 17, 1987

7:04 PM

Anderson Proposal Ill

16K MacWrite document Thu, Feb 26, 1987

6:45 PM

D

Subcontractors

D

Anderson Proposal

D

Financial Analysis

D

Anderson proposal II

D
D

Evaluations

folder

Fri. Jan 9, 1987

10:11 AM

Transmittals

folder

Wed, Jan 7, 1987

12:28 PM

D

Anderson Site Plan

D

Miscellaneous Notes

folder

folder

Fri, Apr 17, 1987

Sal, Feb 7. 1987

7:09 PM

3:23PM

17K MacWrite document Mon. Jan 26, 1987 4:53 PM
folder

Thu, Jan 15, 1987

10:37 AM

17-K MacWrite document Wed, Jan 14, 1987 9:35 PM

27K MacDraw document Tue, Dec 2, 1986
folder

Mon. Jul 7, 1986

9:45 PM
1:26PM

The directory is printed in
whatever view you have it
arranged.

.....
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Using the MiniFinder

-

You may want to install the
documents and applications
you use most often in the
MiniFinder. It's less cluttered
than the Finder, but it has few
of the Finder's features.
You can install the
MiniFinder on any disks that
contain applications, whether
or not they're startup disks.
The computer always starts up
with, and applications quit to,
any MiniFinder on the current
startup disk.

To install what you want in
the MiniFinder

1. In the Finder, select what you
want to place in the
MiniFinder.

2. Choose Use MiniFinder from
the Special menu.

You can select up to 12 mixed
or matched documents and
applications, as long as they
are in the same directory
window (drag them there if
necessary). Any applications
needed to work on documents
in the MiniFinder must be on
the same disk, but don't have
to be in the MiniFinder. If you
move an application to a
different folder after you've
installed the MiniFinder,
however, the MiniFinder
won't be able to find it.

If the command is dimmed,
the disk may be locked.
3. Click Install.
A MiniFinde r icon is placed
in the System Folder.
The next time you start your
computer using this disk, or
quit an application on this
disk, the MiniFinder will
appear instead of the usual
desktop.

See "Selecting Icons" earlier
in this chapter.
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To use the MiniFinder

1. Open an application or
document in the MiniFinder
by selecting it and clicking
Open or by double-clicking
its icon.
2. When you are finished with
that application or
document, you have several
choices:

o Return to the Finder by

To change what is
included in the MiniFinder

1. In the MiniFinder, click
Finder.

2. In the Finder, select what you
want to place in the
MiniFinder.

2. Choose Use MiniFinder from
the Special menu.

See ''Selecting Iconsu earlier
in this chapter.

o Open other applications on

The documents and
applications you select must
be in the same directory
window. Drag them there if
necessary. Any applications
you need to work on
documents in the MiniFinder
must be on the same disk, but
they don't need to be in the
MiniFinder. If you move an
application to a different
folder after you've installed
the MiniFinder, the
MiniFinder won't be able to
find it.

o Eject any inserted disks and
restart the computer by
clicking Restart.
o To see MiniFinders
installed on other disks, use
the Eject and Drive buttons.

Finder.
Use the Drive button frrst if
necessary.

You can select up to 12 mixed
or matched documents and
applications.

A dialog box appears. It's the
same dialog box you see when
you choose Open within an
application, but in the
MiniFinder you see and open
applications rather than
documents. See "Managing
Documents Within an
Applicationu later in this
chapter.

1 . In the MiniFinder, click

Use the Drive button flrst if
necessary.

clicking Finder or pressing
Enter. (Click Drive to change
drives, if necessary.)
the same or different disks by
clicking Open Other.

To remove the MiniFinder

3. Click Remove.
Dragging the MiniFinder icon
to the Trash also removes the
MiniFinder.

~

I

3. Choose Use MiniFinder from
the Special menu.
4. Click Install.

_...
I
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Managing
documents within an
application

-

-

-

You can do quite a 10[ of
document management
without leaving the
application you 're using. You
can open documents, close
them, save them, and print
them. And you can orga.r1ize
your work using the same
folde rs you create in the
Finder.

To create a new
document

1 . If necessary, save any unsaved

changes and then choose
Close from the File menu to
close the current document.
With some applications, you
can have just one document
open at a time.
2. Choose New from the
application's File menu.

Usually when you choose
Open or Save As within an
application you can see the
names of folders you created
in the Finder.

A new document appears. In
most applications, you name
the document the first time
you save it; in a few
applications, you must name
the document as soon as you
create it.
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To open an existing
document

1. If necessary, save any unsaved
cha nges and then choose
Close from the File menu to
close the current document.
With some applications, you
can have just one document
open at a time.
2. Choose Open from the
application's File menu.
A dialog box appears, with a
directory of the current folder
or disk. The directory name
(and a folder or disk icon) is
above the alphabetized list of
the directory's contents; the
name of the current disk (and
a disk icon) appears to the
right.
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The folders in this dialog box
correspond to the folders you
create in the Finder. You
open them by selecting them
and choosing Open, or by
double-clicking them.
Within applications, folde rs
show only the documents the
current application can open,
even if the corresponding
folders in the Finder contain
other documents or
applications .
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o To see the contents of a
folder in the current
directory, select its name and
click Open, or just doubleclick on its name.
You see the contents (both
folders and documents) of the
folder you open. You can
move through the entire
hierarchy of folders in this
same way, opening folders
within the currently open
folder, until you reach the
document you want to open.

o To trace your way back
through the hierarchy of
folders, press on the
directory name and choose
the folder you want.

-

A list appears below the
directory name when you
press on the name or
anywhere in the bar that
contains the name. Each
folder in the hierarchy is in
the list, and the disk directory
(which includes anything on
the disk that's on the desktop
or not in any folde r) is at the
end of the list.

o To close the currently
opened folder and drop back
to the preceding level in the
directory, click on the disk
icon that appears above the
Eject and Drive buttons. (You
can re peat this until you get to
the top of the hierarchy.)
o To see documents and
folders on other disks, use the
Drive and Eject buttons.
Clicking Drive (or pressing
the Tab key) always brings you
to the top level of any disk
inserted in a second drive.

3 . Open the document you want
to work on by clicking on its
name and then clicking Open
(or just double-dick on its
name).
To select a document or
folder in the current directory
quickly, type the character or
characters you want to find
and to select. If you pause
while typing, the next
character you type is
considered a new request
rather than a continuation of
the old. The Delay Until
Repeat setting in the Control
Panel de termines how long
the pause can be before
subsequent typing begins a
new request.
You can also use the directio n
keys to move up and down the
list of names.

I!g) Projects '87 l
D Project Schedule~
D System Folder

~ !g)

Proj e cts '87

You always enter the
hierarchy of documents and
folders at the place you last
opened a document from or
saved a document to.

Eject
!IIIli(!
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To save a document

A document is stored only
temporarily until you save it
on a disk
• Choose Save from the
application's File menu.
Use the Save rathe r than the
Save As command fo r
routine, periodic saving of
your document. The Save
command saves a document
with its original name on the
same disk. Choose Save As
when you want to save the
current document with a
different name, o r to copy it
to a different folder or disk.

To save a document with
a different name, or in a
different folder, or on a
different disk
1. Choose Save As from the
application's File menu.

o To see folders or
documents inside a folder in
the directory, double-click on
the folder's name. You see
any folders within the folder
you opened.

A standard file dialog box
appears, with a directory·of
the folde rs contained in the
current folder or disk. The
directory name (and a folder
or disk icon) is above the
alphabetized list of the folders
it contains; the name of the
current disk (and a disk icon)
appears to the right.

You can move through the
entire hierarchy this way.
Open folders within the
currently open folder, until
you open the one you want to
save your document in.

The folder names in this
dialog box correspond to the
folde rs you create in the
Finder.

When you're saving (rather
than opening) documents,
you see the entire contents of
the destination folder. All
items except folders appear
dimmed.

If this is a new document that
hasn't yet been saved, you see
the same standard file dialog
box that appears when you
choose the Save As
command. See "To Save a
Document With a Differe nt
Name, or in a Different
Folder, or on a Different
Disk" in the next column.
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oTo move back through the
hierarchy of folders, press on
the directory name and
choose the folder you want.

~

A list appears below the
directory name when you
press on the name or
anywhere in the bar that
contains the name. Each
folder in the hierarchy is in
the list, and the disk directory
(which includes any folder on
the disk that's on the desktop
or not in any other folder) is
at the end of the list.

...

~

....

~

--.

oTo see folders on other
disks, use the Drive and Eject
buttons.
oTo close the currently
opened folder and to drop
back to the preceding level in
the directory, click on the disk
name.
Clicking Drive or pressing the
Tab key always brings you to
the top level of any disk
inserted in a second drive.

2. Type a new name for the
document if it's a new
document or if you want to
change the current name;
otherwise it will be saved with
the same name.
You can use any character or
symbol on the keyboard
except a colon(:). You can
use uppercase or lowercase
letters and put spaces between
words. Names can be any
length up to 31 characters, but
long names can become
.unwieldy. It's usually best to
limit them to the space you
have to type them in.

Even though more than one
document on a disk can have
the same name as long as
they're in separate folders, it
may be easier to keep track of
documents if you give each
version a different name.

3. To save the current document
in the folder named at the top
of the list, click Save.
You always enter the
hierarchy of documents and
folders at the place you last
opened a document from or
saved a document to.

Managing documents within an application

131

To print a document while
within an application

1. Choose Page Setup to set
printing options such as page
orientation and paper size.
If you tend to use the same
setup all the time, you can
usually skip this step.
2. Choose Print from the File
menu.
In most applications, one or
more dialog boxes appears.
You can click the various
options to control the way
your printed document will
look. See uPrinting" earlier in
this chapter for information
about printing from the
Finder.
If you're using a printer other
than an ImageWriter II, if you
have more than one printer,
or if your printer is attached
somewhere other than the
Printer port, use the Chooser
desk accessory to tell the
computer which printer to
use. Some applications may
not let you use the Chooser;
choose Quit and use the
Chooser in the Finder. See
"Using the Chooser" earlier
in this chapter.
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Managing disks
You'll use the Finder to manage entire disks as well as the
documents, folders, and applications on mem. Renaming disks
works the same as renaming any icon. See "Renaming" earlier in
this chapter.
Chapter 4, "Macintosh II Reference," contains additional
information about disks.

-

-

-
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To initialize both sides of a
double-sided disk

Initializing a 3.5-inch
disk

Whenever the computer
encounte rs a disk it can't
inte rpret, a dialog box
appears and asks whether
you'd like to initialize the disk.
With an BOOK disk drive, you
have three choices: to
initialize the disk with a onesided format, to initialize with
a two-sided format, or to eject
without initializing.
Initialize single-sided disks to
be one-sided and doublesided disks to be two-sided.
(Single-sided disks hold 400K
worth of information;
double-sided disks hold
800K.) Disks that are
initialized o ne-sided don't
use the hierarchical file
system and don't show any
folder names when you use
the standard file from within
applications, as you do
whenever you choose Open
or Save As from the
application's File menu. To
use folders within
applications, you need both a
double-sided disk initialized
two-sided and a startup disk.

No matter how you initialize
them, you always insert disks
in the same way-metal end
first, label side up.
In the Finder, you can
initialize disks that have
information on them by
choosing Erase Disk from the
Special menu. This erases
everything on the disk (after
giving you the appropriate
warnings, of course) and gives
you the same initialization
choices you get with a new
disk.

2. In the dialog box that
appears, click Two-Sided.
Initialization w ill begin, and
you'll have to wait a few
seconds.
3. Type a name for the disk.

You can initialize disks from
within an application without
losing any information in
memory, so you can initialize
them as you need them.

D

To avoid confusion, be sure
to give disks different names.
Initializing a disk this way
installs the hiera rchical file
system, letting you use folders
within an application as well
as in the Finder. Whenever
you choose Open or Save As
or save an u ntitled document
while you're in an
application, you'll see and be
able to use the same folders
you use in the Finder. See
"Using Folders" and
"Managing Documents
Within an Application"
earlier in this chapter, and
"The Hierarchical File
System" in Chapter 4.

-Th-1~ dl~k I~ Untl'-a-da_b_l~l'.
Do you want to rnrtralr z e rl?
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1. Insert a double-sided (800K)
disk you want to initialize.

One - Srded
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To initialize a disk so you
can use it in a 400K disk
drive

....

Once you've initialized a disk
with the two-sided format,
you can't use it in a 400K disk
drive; the 400K disk drive
won't be able to read it. You'll
be asked if you want to
initialize the disk, and clicking
Initialize will erase everything
on the disk.

Never initialize a single-sided
disk with the two-sided
format. The second side of
the disk has not been tested
for reliability, and you could
lose all the information on
the disk.

1. Insert the disk you want to
initialize.
2. Click One-Sided.
Initialization will begin, and
you '11 have to wait a few
seconds.
3. Type a name for the disk.
To avoid confusion, be sure
to give disks different names.
You can initialize an BOOK disk
to be one-sided so you can
use it in a 400K disk drive. But
it makes only half the disk
space available to you and
doesn't install the
hierarchical file system, so
you won't be able to use
folders within applications on
the disk.

Initializing a 3.5-lnch disk
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Ejecting a d isk

To get information from or
save information onto a disk
not currently inserted, you
sometimes first need to eject a
disk.
If the computer needs the
ejected disk later, it will ask for
it.

To eject a d isk

1 . Select the icon that represents
the disk you want to eject
Or you can make the disk
directory window active if
you've opened the disk icon.
2. Choose Eject from the File

menu.
Or hold down the Apple key
and press E.

Dragging a disk icon to the
Trash both ejects the disk and
removes the icon from the
desktop. (The computer won't
ask for it again.) If you drag
the current startup disk to the
Trash, the computer ejects
the disk but doesn't remove its
icon. Nothing on the disk is
e rased, in either case.

Choosing Eject usually ejects
a disk (if one's inserted and
it's not a hard disk), even if
none is selected. The Finder
looks for an inserted disk to
eject.
Choosing Restart from the
Special menu also ejects any
inserted disks and restarts the
computer. Choosing Shut
Down ejects any inserted disks
and shuts the computer off.
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Creating a startup disk

-

-

-

Your computer needs certain
information to be able to start
up properly. Disks that
contain this information (in
system files such as System
and Finder in the System
Folder) are called startup
disks. Because this
information can take a fair
amount of room on a disk,
you probably won't want to
have all your disks be startup
disks-especially if you're
using more than one disk
drive. But unless you're using
a hard disk, you need to use a
startup disk each time you
start your computer.
In the Finder, the curre nt
startup disk's icon appears in
the top-right corner of the
desktop.
See "Startup Disks" in
Chapter 4.

•:• Hard disk users: Use your
hard disk as your startup disk.
See Appendix A, "Working
With Hard Disks."

To create a startup disk

1. Insert a startup disk.
If you're using a one-drive

system, eject this disk before
going on to the next step, by
choosing Eject from the File
menu.
2. Insert a new disk (or any disk
with enough space for the
System Folder you want to
add).
If the disk isn't initialized for a
Macintosh computer, you'll
be asked if you want to
initialize it. See "Initializing a
3.5-Inch Disk" earlier in this
chapter.

To make a startup disk a
nonstartup disk

You may want to tum a startup
disk into a nonstartup disk (a
disk just for storing
documents), especially if
your're using a hard disk as
your main startup disk.
1 . Start the system using any disk
other than the one you want to
be a nonstartup disk.
2. Insert the disk you want to
change to a nonstartup disk.
3. Drag the System Folder to the
Trash.

3. Drag the System Folder to the
new disk icon.
Startup disks can also contain
applications and docume nts,
depending on how much
space you have on the disk.

•
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Copying an entire
disk

You can copy an entire disk
whenever you can see both its
icon (the source disk icon)
and the icon of the disk you
want to copy to (the
destination disk icon).
Give each disk a unique,
meaningful name (either
when you're asked to name a
new disk or after you fmish the
copying process). If each disk
has a unique name, it will be
easier to keep track of your
documents, and you'll know
which disk to insert when the
computer asks you for a
specific d isk. See "Names of
Disks and Documents" in
Chapter 4.
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To copy a disk

1 . Insert both the source disk
and the destination disk.
If necessary, first eject any
othe r disk by selecting its icon
and choosing Eject from the
File menu . If you're using a
one-drive system, insert and
eject the destination disk, and
then insert the source disk.
If the destination disk is a new
disk, you '11 be asked if you
want to initialize it. See
"Initializing a 3.5-Inch Disk"
earlier in this chapter.
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2. Drag the source disk icon to
the destination disk icon.
You'll be asked to confirm
that you want to replace the
existing contents of the
destination disk with the
contents of the source disk.
The computer will tell you if
there's not enough room on
the destination disk-if you're
trying to copy a full 800K disk
to a 400K disk, for example.
If you're dragging to a hard
disk, items with the same
name on the hard disk aren't
replaced. Instead, the system
creates a folder with the name
of the source disk, and its
contents are copied into that
folder.

Using the Installer

-

-

-

You use the Installer to
update startup disks and to
install resources on startup
disks. Printing resources are
system files that usually have
the same names as the
printers themselves.
Peripheral devices such as
hard disks and file servers also
have resources.
It's a good idea to use the
Installer to keep all of your
startup disks current with the
latest system files available.
You can see which version of
the Finder you're using by
choosing About the Finder
from the Apple menu. The
version number should be 5.4
or later. Check with your
authorized Apple deale r for
possible further updates.
With a startup disk that uses a
Finder version 4.1 or earlier,
folders and all their contents
may not appear when you
choose Open or Save As
within an application, or
folders may appear empty in
the Finder. Don't worry if this
happens. Just use the Installer
to update the startup disk.
You r "missing" folders and
their contents will reappear
the next time you choose
Open or Save As.

To use the Installer to
update or install resources
on startup disks

If you don't update your
startup disks, characters you
type on your keyboard may
produce the wrong results in
certain applications. For
example, typing "=" may
generate "," instead.
Although the Macintosh II lets
you move items in and out of
System Folders just as with any
other folder, leave the System
and Finder together in the
same System Folder. Use the
Installer to keep each of your
startup disks current rather
than dragging these files
among startup disks.
Applications you purchase
may not include the latest
system files on their startup
disks. If your system doesn't
include the internal hard disk,
update each startup disk you
use with your Macintosh II in
this same way. If you have a
hard disk, just copy all your
applications to the hard disk
and start your computer from
the hard disk.

1. Start the Macintosh II with the
System Tools disk.
You can't replace the system
files on the current startup
disk because the system is
using them.
The Installer is in the Utilities
Folder on the System Tools
disk. Use it there or copy the
Installer, the System Folder,
the Font!DA Mover, and the
Installation Scripts folder to
another disk.
2. Open the Installer.
Either select the icon and
choose Open from the File
menu or double-click the
icon.
3. Insert the startup disk you want
to update.
If you have only one 3.5-inch
drive, first eject the disk that
contains the Installer.
The Installer will update the
disk named at the top right. If
that is not the disk you want,
click Drive to search for other
disks.

Using the Installer
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4. Select Macintosh II Update
and any other printing
resources you want.
Shift-click to select more than
one item in the list.
As you select each resource,
the Installer checks the disk's
available memory and
informs you how much free
space will be left on the disk
after the update is complete.
('This takes a few seconds for
each selection.)
5. Click the Install button.
Installing Macintosh II
automatically updates any
existing system resources on
the disk. You can also select
any printing resources you
want to add.

If you intend to use the disk
you're updating on an
Macintosh II and on another
model of Macintosh
computer, select Universal
System Update instead of
Macintosh II. Universal
System Update requires more
disk space, but it lets you use
the disk on most models of
the Macintosh computer
(except the Macintosh 128K).
You can use the Font/DA
Mover to customize the disk
with the fonts and desk
accessories you want to use
with it. See the Macintosh
System Utilities User's Guide
for information on the
Font/DA Mover.
Disk to be up dated

Installer
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The first half of this chapter describes your Apple Macintosh II
computer in general. Although some details may change from
application to application, this is the way your computer usually
works.
"Finder Reference" and "Finder Menus" provide specific
information about the Finder, the application for organizing and
managing your documents. These sections of the chapter describe
the functions and effects of windows, icons, and menus in the
Finder, and also discuss the things the Finder manages.
The last part of this chapter describes some shortcuts you can use
when you are working with your Macintosh II.

What Macintosh II is: Its parts
The basic Apple Macintosh II computer system includes the
monitor, the main unit, the keyboard, and the mouse. The
monitor is where you keep track of what you're doing. The main
unit is really the heart of the computer and contains
o the processor-which does the actual work of the computer
D

1 megabyte (1MB) of memory-where the computer stores the
information you're currently using

o a built-in BOOK disk drive-which records and retrieves the
information that's stored on a disk
o an optional hard disk (internal or external)-for added disk
space (20, 40, or 80 megabytes) and greater efficiency and speed
o slots that will accept expansion cards-which allow you to add to
the capabilities of your Macintosh II
Besides getting information from the disk drive, your computer
can also get information directly from you when you use the
keyboard or the mouse, or from other peripheral devices (through
the SCSI port or the serial ports on the back of the main unit).
These computer parts that you can see and touch are called
hardware.
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Software is the collective term for all the programs your system
uses. For example, the Macintosh II comes with system software
and utilities programs, many of which work behind the scenes
keeping your desktop organized and making it easier for you to do
your work. In addition, there are a great many application
programs you can use-such as MacWrite for words, MacPaint for
pictures, MacDraw for structured graphics, MacTerrninal™ for
e lectronic communications, and MacProject™ for project
management.
You can add to your basic computer system as your needs grow,
choosing from a large and constantly growing family of hardware
and software products. See Chapter 5, "Expanding Your Macintosh
II System," for a few ideas.

Where does your information go?
When you open an existing document so you can revise it (the
perfect first draft has yet to be created), the computer leaves the
original on the disk and brings a copy into the computer's
memory. When you've finished making changes on the copy, you
dedde whether you want to keep the new version or not.
You usually have the option of saving the new version with the
original name, saving it with a different name, or not saving it at all.
If you save the new version with the same name as the original, it
replaces the original on the disk. If you don't use the same name,
with most applications the original on the disk isn't changed. It's
like having an original document and making photocopies of it to
edil. When you've tried diffe rent changes and are satisfied with a
particular version, you can change the original.
Any docu ment you're working on is being held-temporarily-in
the computer's memory. If you accidentally trip over the power
cord or the electricity goes off, everything you've done-but
have n't saved-vanishes forever. So that your work will be there
when you need it, save it on a disk (by choosing Save from the File
menu) every 15 minutes or so. That way you'll never lose more than

Where does your Information go?
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a coffee break's worth of work. (With certain data base programs you
can lose everything-even what you've saved-if there's a power
failure of any sort If the work you're doing in a data base is
important, it's a good idea to make frequent backup copies of your
work on a 3. 5-inch disk for insurance.)

•:• Automatic saves: Some applications save changes you make to
a document as soon as you make them; the manual that comes
with the application lets you know if this is the case.

Original on disk

Original on disk

Figure 4-1
Where Information goes

The keyboard
Your computer's keyboard includes character keys, numeric keys,
arrow keys, and other special keys. This section gives a brief
description of what the keys do.
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Figure 4 -2
Keyboard

.....

Character keys
The character keys are just like keys on a typewriter. Use them to type
any character, including numbers and symbols such as=, (, and $.
Character keys repeat when held down. Use the Control Panel to set
the rate of repeating; see "Using the Control Panel" in Chapter 3.

Numeric keys
In addition to the numerals 1 through 0 along the top of the
keyboard, there is also a built-in numeric 10-key pad on the right
side of the keyboard. For accountants and others who enter a lot of
numbers and use calculators frequently, this pad will be familiar.

-

Arrow keys
The arrow keys (sometimes called cursor keys) let you use the
keyboard to move around the compute r screen when it's
inconvenient to use the mouse.

The keyboard
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Special keys
Some keys are used in combination with character keys to produce
different characters or to issue menu commands. Others perform
more specific actions. These keys are described below, starting at
the top of the keyboard and moving counterclockwise.

~
I

,....
I

Power On
This is the long key at the top of your keyboard. You press it to turn
on your system when it's been turned off.

Esc
Esc stands for Escape~ and that's what this key is usually for. Ot
generally means the opposite of Return or Enter.) Pressing Esc
usually cancels a choice or gets you out of tight spots. Not all
applications use Esc.
Tab

The Tab key moves the insertion point horizontally to the next
stopping place (such as a tab stop). In dialog boxes, pressing Tab
usually selects the next place to supply information.

~
I

Control
Like the Apple key, the Control key works in combination with other
keys to provide shortcuts or to modify other actions.

.~

Shift
When you hold down the Shift key, character keys produce
uppercase letters or the upper character on the key. Sometimes Shift
modifies other actions: for instance, in the Finder holding down
the Shift key while you click lets you select more than one icon.

Caps Lock

~
I

The Caps Lock key is a Shift key for letters only. When the Caps Lock
key is engaged, letter keys produce uppercase letters, but number
and symbol keys aren't affected.
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Option

Generally, if you hold down the Option key while you press other
character keys, the result will be an optional character set of
accented and special characters. If you press the Option key along
with the Shift key (or Caps Lock), you'll get another version of some
optional characters. Figure 4-3 shows the optional characters in the
Chicago font.

~GJon

l0[] [) GJ
l~~~ r:-IGJ
[][J~1 Ll1
[o

! 1_.]_.

Figure 4-3
Optional characters
White

=

Characters produced by holding down the Option key while you
type another character

Red

=

Characters produced by holding down the Option key and the
Shift ke y while you type another character

You can use the Key Caps desk accessory to see the optional
characters in any font installed in the current startup disk's System
file . See "Desk Accessories" later in this chapter.
Using the Option key with certain character keys lets you enter
accented characters:

-

Option-'
Option-e
Option-i
Option-u
Option-n

' (grave accent)
' (acute accent)
~ (circumflex)
··(umlaut)
- (tilde)

-

The keyboard
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Typing the Option key combination followed by another character
produces that character accented with that diacritical mark. (For
example, if you hold down the Option key and press the grave key,
then release those keys and type a, you'll get a- as in a Ia carte.) If
for some reason a character can't be accented by the mark you've
chosen, you get the mark, followed by the character. Typing the
Option key combination twice gives you the diacritical mark alone.

Apple
Holding down the Apple key (it's the one with the 0 and the
cloverleaf symbols) in combination with another key is often a
shortcut to choosing a command from a menu. When there is an
Apple key equivalent to a command in a menu, it will be listed in the
menu. Sometimes the Apple key modifies other actions: for
instance, holding down the Apple key while typing a period (.)
sometimes cancels a long operation in progress-such as printing.
Important

The Apple key has 1wo icons on it: one looks like a cloverleaf.
and the other is an apple. Earlier Macintosh keyboards had just
the cloverleaf, and many applications refer to this key as the
Command key. If your application tells you to press the
Command key, this is the key It means.

Enter
In a dialog box, pressing Enter is the same as clicking the button that
confirms the default command (such as OK) or the outlined button
if there is one. In this context, Enter and Return operate the same
way. Certain software applications (such as spreadsheet programs
or data base managers) will require that you press Enter (not Return)
when you want to put data into specific fields.
Clear
Clear deletes the current selection, just as the Delete key does. In
some applications, Clear may have other functions. See each
application's manual.

~
'
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Delete

The Delete key deletes the current selection. When the selection is
simply the insertion point, Delete backs over and deletes text.
Return

The Return key moves the insertion point to the beginning of the
next line. In a dialog box, pressing Return is the same as clicking the
button that confirms the default command (such as OK) or the
outlined button if there is one.

Disks

-

Disks store information and come in different sizes and shapes. The
next few sections apply mostly to 3.5-inch disks. Hard disks are
discussed in more detail in Chapter 5, "Expanding Your Macintosh
II System," and in Appendix A, "Working With Hard Disks."
Apple 3.5-inch double-sided disks store 800 kilobytes (800K), o r
about 160 pages per disk, and are labeled Double Sided. Some
space on each disk is used for keeping track of the disk's contents.
(This is where the disk's directory information is stored.) The
amount of space set aside for the directory depends on how much
information is on the disk.

-

-

Initializing disks
Before your Macintosh II can get information from or save
information to disks, the disks need to be initialized in a format
your computer understands. (A blank disk is like a parking lot
without divider lines. Before it can "park the cars," your computer
has to "draw in the white lines.") Any time you insert an

Disks
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uninitialized disk or a disk your computer can't read (because it's
damaged or it's initialized for a different kind of computer), a
message appears asking you (1) if you'd like to initialize the disk for
the computer and (2) whether you want to iriitialize the disk to be
one-sided or two-sided.
The Macintosh II's BOOK disk drive(s) can read disks initialized with
either a one-sided or a two-sided format, and can use the olderstyle 400K disks. In other words, it's all right to use a combination of
one-sided and two-sided, 400K and BOOK disks.
If you're using BOOK disks, you'll usually initialize them with a twosided format. This kind of initialization gives you the full 800K of
space on the disks so that you can use both sides of the disk to store
applications and data. It also gives you the hierarchical file system
(letting you use folders within applications as well as in the Finder).
The one-sided format gives you only 400K of storage and normally
gives a "flat" directory system, in which the titles of folders don't
show up in the directory window when you store or retrieve
documents within applications.
Important

Be sure to Initialize 400K disks to be one-sided only. Although
the computer will sometimes let you initialize a 400K disk to be
two-sided. the second side of the disk has not been tested for
reliability, and you'll regret the decision to Initialize both sides
the day you lose all the Information on the disk.
If you've Initialized an BOOK disk two-sided, you cannot use it in
a 400K disk drive. If you try, a dialog box asks if you want to
initialize the disk with a format the drive can read. Clicking
Initialize erases all the Information on the disk.

If you are using an application and insert an unformatted disk, you
can initialize the disk from within the application without losing any
information currently in the computer's memory.
You can also initialize disks that have information on them by using
the Erase Disk command in the Special menu in the Finder. This
erases everything on the disk and asks whether you want to
reinitialize the disk.
Table 4-1 shows specific information on which disks to use in which
drive.
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Table 4-1
Disks and drives
400K disk drive

800K disk drive

400K disk
initialized
one-sided

yes

yes•

BOOK disk
initialized
one-sided

yes

yest

BOOK disk
initialized
two-sided

no

yes

• You might want to copy applications from 400K disks to two-sided 800K
disks. Some applications, however, may be copy-protected. You can
continue to use these applications from one-sided 400K disks. You can
always copy a 400K data disk to an 800K disk, and gain the extra 400K
for your own work.
t

800K disks can be initialized to be one-sided, but you'll be able to use
only 400K on the disk and you won't see folders within applications on
this disk.

Locked disks

-

You can prevent any information on a 3.5-inch disk from being
changed by sliding the colored tab toward the edge of the disk
(revealing a small hole). This is called locking a disk. You can lock
specific documents and applications (and folders, if you're using a
file server such as AppleShareTM) by choosing Get Info from the File
menu. See Locking a Document or Application" in Chapter 3 for
instructions.
11

When a disk is locked, you can't add new information to it or change
any information on it. You can open (and usualiy print) the
documents it contains, but you won't be able to save, delete,
rename, move, duplicate, or change any information on it.
To allow the disk to be altered again, slide the tab to cover the hole.

....
Disks
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•!• Locked disks and applications: Some applications might not

work with a locked disk, and the Finder can't remember
anything you've done on the desktop when you're using a locke d
disk. Some desk accessories might not work properly if the
current startup disk is locked.

-

Figure 4-4
Locking and unlocking a disk

Names of disks and documents
Every disk, document, application, and folder has a name. You
name disks when you initialize them, you name documents when
you save them for the first time (some applications make you name
a document as soon as you create it), and you usually name folde rs
when you create them. You can change a name at any time with the
Finder.
There are a few restrictions to the names you can give. A disk name
can contain up to 27 characters (including spaces); a document or
folder name can contain up to 31 characters.
A name can't contain a colon (:). O ther than that, you can use any
characters you can type on the keyboard.
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You can have multiple documents or folders with the same name as
long as they're in separate folders and the disk is initialized twosided (or is a hard disk) and allows fo r the hierarchical file system.
You can't have two items with the same name in the same folder.
When comparing names, your computer considers uppercase and
lowercase letters to be equal, so saturday and Saturday are the
same.
Important

Don't g ive documents the same name as applications. If you
move a document named MacWrlte to a folder that has the
MacWrite application in it. you'll be asked if you want to
replace the existing MacWrite. Clicking OK w ill destroy the
application and replace It with the document.

It's a good idea to give disks unique names. Sometimes you r
computer will ask you for a specific disk by name, and it's confusing
to have a lot of disks with that same name. (Your computer can be
very picky about which one it wants.) It's also a good idea to write
each disk's name on its labe l.

Startup disks
The System Tools disk that came with your computer contains
system files the computer needs to get itself started. Disks that
contain these files are called startup disks.
These system files are stored in the System Folder. Because the
computer expects to find them there w hen it needs to use them, you
should keep them in the System Folder.
A startup disk always includes in the System Folder at least a System
file and a Finder file (both represented by Macintosh icons). It also
usually includes at least one printing resource, such as the
ImageWriter, AppleTalk ImageWriter, LaserWriter, or LaserWriter
Prep file. You should also find other files on a startup
disk-Scrapbook file, Clipboard file, and so on. These files contain
information that's used only by certain applications and desk
accessories.

Startup d isks
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Besides giving your computer the information it needs to get itself
started, the System Folder on the startup disk determines
o which fonts you have available when you use an application (in
the System file on the startup disk you're using)
o which desk accessories are in the Apple menu (also in the System
file)
o what's in the Scrapbook desk accessory (whatever's in the
Scrapbook file on the startup disk)
o which version of the Finder you're using
o which devices can be controlled by the Control Panel

~
I

~
I
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If you don't have a hard disk
If you don't have a hard disk, you may need to use the Installer on
the System Tools disk to update the system files on your application
disks before using them as startup disks. After you update an
application's startup disk, you will be able to use it as a startup disk
on most earlier models of the Macintosh computer (the exception
is the Macintosh 128K).
•:• 400K disks? If you have applications on 400K disks, do not try
to convert those disks to startup disks. (1bere probably isn't
room.) Instead, you'll have to start the computer from another
disk, then insert the 400K application disk and start the
application.

See "Using the Installer" in Chapter 3 for instructions on how to
update disks with the latest system software.

Customizing startup disks
Fonts and desk accessories are kept in the System file (inside the
System Folder). You can use the Font/DA Mover (Font and Desk
Accessory Mover) to customize the System file on a startup disk so
that it contains your most useful fonts and desk accessories. (You
can't just open the System files and drag things back and forth.)
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An application you purchase might have spedal fonts or desk

accessories suited to that particular application. The Font/DA
Mover lets you copy these to the System file on any other startup
disk (as long as there's room on the disk, of course). See the
Macintosh System Utilities User's Guide for instructions on using
the Font/DA Mover.
You can also drag other files (not fonts or desk accessories) from
the System Folder on one disk to the System Folder on the startup
disk you are customizing. For example, you might want a copy of a
Scrapbook file-to have different Scrapbook contents available
from time to time.

The current startup disk
When you turn on your compute r, it looks for a startup disk-the
disk whose syste m files the computer will use. Because you can have
startup disks in diiTerent drives at the same time, you r computer uses
an order of precede nce in looking for a startup disk. Searching in
this order, it uses the first startup device it finds:
o right-hand disk drive
o left-hand disk drive (if the re is one)
o startup device set in the Control Panel
o internal hard disk
o devices connected to the SCSI port in declining device priority
number (from 6 to 0)
See "Using the Control Panel" in Chapte r 3 to learn about setting a
startup device .
If you have an external hard disk, see "Drive" in Appendix A and
the manual that came with the disk to read about SCSI device
priority numbers.
Switc hing startup disks

The startup disk is the one whose icon appears in the top-right
corner of you r desktop. Sometimes you want to switch to a diffe rent
startup disk while you're working- another startup disk might have
special desk accessories or fonts you want to use. (And sometimes
the Macintosh II will switch startup disks because of an action you've
taken, whether you wanted to switch or noL)

Startup disks
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The Madntosh II switches to a different startup disk whenever you do
any of the following:

,_.

o You restart the computer using a different startup disk.
o You restart the computer after you've changed the startup device
(from the Control Panel).
o You hold down the Option key while you open an application
that's on another startup disk.
o You hold down the Option and Apple keys while you double-dick
the Finder icon on the disk you want to switch to. (Don't hold
down these keys too long or the Rebuild Desktop dialog box will
appear.)

Arranging your work on disks efficiently
In general, how you arrange your work on disks depends on the size
of your system, the printer or printers you're using, and the way you
want to organize your work. Your computer lets you arrange
documents, folders, and applications however you want on your
disks. (See "Copying or Moving a Document, Folder, or
Application" and "Removing or Recovering a Document, Folder,
or Application" in Chapter 3.)
o If you're using a system with a hard disk, you can keep everything
on it: System Folder, applications, and documents. Use 3.5-inch
disk drives to make backup copies and to hold applications that
can't be moved to the hard disk because of copy protection.
o If you're using a system with two 3.5-inch disk drives (and no hard
disk), you might decide to keep more than one application on a
startup disk in the right-hand disk drive and keep documents you
create with those applications on nonstartup disks in the lefthand disk drive.
o If you're using a one-drive system, you can minimize the amount
of disk-swapping you have to do by keeping just one application
and the documents you create with it on a startup disk. (Your
computer asks you to swap disks when it can't fmd the
information it needs on the currently inserted disk.)
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It's a good idea to keep about 50K available on your startup disks.
Onformation about the space available appears in the window for
that disk, below the title. You can also select the startup d isk and
choose Get Info from the File menu to see how much space is free.)
Applications usually need a little working space on the current
startup disk, even when the document you're working on is on
another disk.
If you need more space on your startup disks-if you have AppleTalk
and a LaserWriter with many fonts installed in your System me, for
example-you can keep applications together with documents on
nonstartup disks in an alternate drive. (Nonstartup disks do not have
a System Folder containing the System and Finder files.)
There are a couple of things you can do to save space on startup
disks:

-

o Drag any printing resources you don't need to the Trash (making
sure you have backup copies of these resources in case you need
them in the future). For example, if you exclusively use an
ImageWriter directly attached to your computer, you can drag
the AppleTalk ImageWriter and AppleTalk LaserWriter files to the
Trash.
o Re move fonts or desk accessories you don't need from its System
file. See the section on the Font/DA Mover in Macintosh System
Utilities User's Guide.
•:• Outgrowing your disks? When the information you need
spreads to more disks than you can easily handle, the best
solution is a hard disk drive. With it, you can keep everything on
the hard disk and use 3.5-inch disks just ro move information to
or from the hard disk. See Chapter 5 for a description of
Apple's hard disk drives.

-

Windows
Windows present information. You can have multiple windows on
your desktop so you can view more than one set of information at
the same time. Most windows can be moved , changed in size,
scrolled through, or closed. Windows can also overlap each other.
When more than one window is open, one is frontmost and that's
where all the action happens. Clicking anywhere in a window brings
it to the front and makes it active.

Windows
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Although a window might be "buried" unde r others, it cannot be
dragged completely off the screen or made so small that you can't
see it

-l1le
- -f dll
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ii
Figure 4-5
Overlapping windows

Windows might behave a little differently within an application. See
each application's manual for an explanation of windows in that
application.

The Clipboard: Cuffing and pasting
You can move information within a document, among documents
created with the same application, among documents created with
different applications, or among desk accessories and documents.
The information you're moving or copying is held on the
Clipboard. The Cut, Copy, and Paste commands in the Edit menu
let you move information between the Clipboard and the active
window. Most applications have a Show Clipboard command in
their Edit menu that shows you the current contents of the
Clipboard.
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Within an application, information sent to the Clipboard keeps
attributes such as text sizes and sryles, or any attributes unique to
that application. When moving between applications, usually o nly
the text or the picture, in a fixed format, is exchanged. Attributes
are often left behind.
The Clipboard contenlS are kept in the computer's memory, as long
as the computer doesn't need the memory for something more
pressing. If the Clipboard's contenlS grow too large, they are
temporarily saved in the Clipboard file on the current startup disk.

Dialog boxes
\Vhenever your computer needs more information from you, it
displays a dialog box with bunons to click and sometimes with space
for you to enter additional information (such as the name for a new
document).

D Letter to linda 12/2
D Letter to Roy 3 / 9

CJ Letters to Carol
CJ Pet sonal Mall

Figure 4-6
A dialog box

If you're about to do something that could make you lose
information, a message in the dialog box alerlS you and asks you to
confirm that you want to go ahead anyway. In boxes with these
messages, one of the buttons-the "safest" alternative-is usually
boldly outlined. Pressing Enter or Return is the same as clicking the
boldly outlined button or, if there isn't one, the button that
confirms the command.

-

Dialog boxes
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A warning message might have one or more Alert Sounds along with
iL If loud sounds annoy you, use the Control Panel desk accessory
to lower the speaker volume. (If you turn the speaker volume all the
way off, the menu bar blinks to warn you even more subtly.) See
"Using the Control Panel" in Chapter 3.

Desk accessories
You choose desk accessories from the Apple menu on the far left
side of the menu bar. Desk accessories are available while you're
using the Finder or most applications.
You can use the Cut, Copy, and Paste commands in the Edit menu
to move or copy text or pictures among some desk accessories (the
Scrapbook and Note Pad, for example) or to or from another
window. See "Editing Text" in Chapter 3.
With most applications, you can keep one or more desk accessories
open on your desktop while you work on documents. Other windows
that are made active may obscure desk accessories. You make
accessories active by clicking them o r choosing them again from
the Apple menu, and you move them by dragging their title bars.
You close them either by clicking their close boxes or by choosing
Close from the File menu.

n

With some applications (MacPaint, for example), you need to close
desk accessories in order to work on a document.
All desk accessories are closed automatically when you open a
document or application from the Finder or when you quit an
application.
The Apple menu usually contains the accessories that arc installed
in the System me on the current startup disk.
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Alarm Clock
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Figure 4-7

Alarm Clock
\Vhen you choose Alarm Clock, a compact clock displays the hour,
minute, and second. To see more, click the lever on the right side
of the time. (Click the lever again to go back to the compact clock.)
With the lever down, two more panels appear. The bottom panel
displays icons fo r time, date, and alarm. Select one of these icons,
then use the middle panel to "set" whatever you selected.

-

Set what's currently displayed in the middle panel by clicking the
digits you want to change. Arrows appear on the right. Click the up
or down arrow to scroll the numbers higher or lower. Or use the
keyboard to type the numbers. Press the Tab key to move to the next
field (for example, from month to day to year).
To set the alarm, first click the Alarm icon. Then click the alarm
button on the left side of the middle panel. You'll notice that the
Alarm Clock icon now displays small radiating lines, signifying that
it's set to make a sound at the appropriate time. The computer
makes an Alert Sound when the alarm goes off, and the Apple menu
title blinks until you unset the alarm by clicking the alarm button off.
(Choosing Alarm Clock from the Apple me nu also turns the alarm
off, but it doesn't unset it.)
When the clock is active, the time and date are automatically
selected (even though they aren't highlighted), so you can copy and
paste them into the document you're working on or into a desk
accessory that accepts text
You can also change the time and date using the Control Panel. See
"Control Panel" later in this chapter and "Using the Control Panel"
in Chapter 3.

-
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Calculator
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Figure 4-8
Calculator

The Calculator works like an ordinary four-function pocket
calculato r. To operate it, click the buttons or use the keyboard.
(You can also use the 10-key pad, of course.)
You can copy the calculation results (which are automatically
selected) and paste them into any document or anolher desk
accessory. You can also copy numbers from a document and paste
them into the calculator's display.

Chooser
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n
Chooser ~-

Select o LaserWntl?r
New York

Chicago
San Franc1sco
New Or~eflr s

AppleTell Zones

Production
Research
Sales

Figure 4-9
Chooser
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A zo ne Is a network that is
port of o series of interconnected networks.
Connecting networks
together makes it possible
to have larger networks
and toke advantage of
more shared devices
(printers. for example). For
m ore information. see
"AppleTalk Personal
Network"ln Chapter 5.

A resource is a system file
that appears on the
startup d isk and makes it
possible for your system
to communicate w ith
devices (such as printers
and the mouse). These
files usually have the
same name as the device
they support.

The Chooser lets you choose devices (usually printers) connected
directly to the Macintosh ll's Printer and Modem ports, or devices
on an AppleTalk network. If you have zones on your AppleTalk
network, the Chooser lets you scan those zones for devices in them.
You also use the Chooser to connect o r disconnect the AppleTalk
network.
The Chooser lets you select any device or print from any attached
printer for which there's a resource on the current startup disk.
The System Tools disk includes printing resources for the
ImageWriter (which work with either an lmageWriter or an
ImageWriter II), LaserWriter, and AppleTalk ImageWriter (which
lets you use an ImageWriter II with an installed AppleTalk card on
AppleTalk). You can use the Chooser to print on any of these
printers.
To use the Chooser to print with a LaserWriter or AppleTalk
ImageWriter, to connect to a file server, or to select a printer on
an Appletalk network (assuming these resources a re available to
you), see "Using the Chooser" in Chapte r 3.
To read more about AppleTalk and about zones, see "AppleTalk
Personal Network" in Chapte r 5.

Control Panel

-

Figure 4- 10
Contro l Panel
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The Control Panel lets you set your preferences for such things as
speaker volume, repeating key rate, location of the startup disk, and
even the background pattern and color of your desktop. The
Control Panel settings are remembered by the computer itself and
aren't affected by the current startup disk. (This is in contrast to the
Chooser settings, most of which are stored in the System file of the
current startup disk.) When you switch your system off, the built-in
battery provides power for the computer to remember the settings.
See "Using the Control Panel" in Chapter 3.

Monitors and the Control Panel
The Monitor part of the Control Panel offers a number of choiceswhether you have one monochrome monitor or six color monitors
connected to your Macintosh II system. Here are some general rules
you should understand:
o The choices you make can be changed when your needs change.
o Some of your choices will depend on whether a monitor is color
or monochrome.
o Some of your choices will depend on how many monitors you
have.
If you have one monitor, you use this panel to specify color or
monochrome, to select the number of colors or grays you want
to see on your screen, and (on a color monitor) to test color
convergence.
If you have multiple monitors (all connected to your Macintosh
II), you make the same choices described above. You can also
position your monitors to suit your needs and fine tune the way
they relate to each other.
This is where having multiple monitors gets to be fun! Depending
on how you've arranged your monitors, you can take advantage
of multiple screens to coordinate a large-scale display of a single
item. For example, with four monitors lined up side by side, you
can display a train-caboose on the leftmost screen, engine on
the rightmost screen, and other cars in between. Or with six
monitors stacked in twos, side by side, you can show one large
spreadsheet.

~
I

For instructions on using this part of the Control Panel, see "To Set
Monitor Status for a Single Monitor" or "To Set Monitor Status for
Multiple Monitors" in Chapter 3.
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Find File
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Figure 4- 11
Find File

Find File helps you locate folders and files on your disks. This desk
accessory becomes more and more useful as the number of files you
have grows-for example, when you have a hard disk.
You type keywords in Find File's Search for box. Find File searches
through your disk, and then displays the names of all files and
folders that have those keywords as part of their name. When you
select a name from the list, Find File gives you information about it:
when it was created and last changed, how big it is, and so on. Find
File also shows you the path through the hierarchical file system that
you take to get to that file.
Because searches on hard disks with lots of flles can take a while,
Find File lets you begin a search and then go back to work on
something else. Ot beeps when it's finished searching.) Once your
search is complete, you can select a me and have Find File move it
to the desktop for you.
See "Using Find File" in Chapter 3.
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Key Caps
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Figure 4-1 2
Key Caps

When !he Key Caps desk accessory is !he active window, a Key Caps
me nu appears in the me nu bar. The menu always contains !he fonL'>
installed in !he current startup disk's System file. (These are the
fonts that will be available in any application you use with this
startup disk.) Choosing a fo nt lets you see its characters in !he Key
Caps window as lhey'd appear as typed text. With any font you
choose, you can use the Option, Shift, and Caps Lock keys to see the
characte rs each key or combination o f keys produces.
Text you type on the keyboard or enter by dicking Key Caps keys
appears in !he text box at !he top of !he Key Caps window. You can
edit this text in the usual way and cut and paste it among ol.her desk
accessories o r any document.
With the Key Caps desk accessory active, press the O ption, Shift, or
Caps Lock key or press the Option and Shift keys together; the Key
Caps desk accessory displays the characters you can type while
holding down that key or combination of keys.
See "The Keyboard" earlie r in this chapter ro learn how to produce
accented cha racters using the diacritical marks in the optional
characte r set.
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Note Pad
--D

1

Note Pad ·

With the Note Pad, you can jot down a few notes and keep them
separate from the document you're working on. Or you can type text
and edit it even if you're using an application that doesn't allow text
editing in the usual way. Use the Edit menu to cut and paste text into
and out of the Note Pad when you want to preseiVe a snippet of
information in a handy place.
You have 8 numbered pages of Note Pad paper, each holding just
over 500 typed characters. Turn to the next page by clicking the
turned-back corner of the top page. Turn to the preceding page by
clicking the bottom-left corner of the Note Pad.

Figure 4-13
Note Pad

-

Notes you type are automatically saved and stored in the Note Pad
file on the current startup disk. You can copy Note Pad files among
disks or remove them to gain space on the disks. You can keep more
than one Note Pad flle on the same disk by renaming all but one of
them or keeping them in other folders. Give the name Note Pad to
the one you want to use, and be sure it's in the System Folder. When
you choose Note Pad from the Apple menu, you always see the Note
Pad whose contents are in the same folder as the System file and
Finder on the current startup disk.
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Figure 4-14
Scrapbook
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Keep in the Scrapbook pictures and text you frequently use. You
might keep your letterhead there, or illustrations from your favorite
graphics program. Paste something you cut or copied from another
desk accessory or a document. And copy or cut the current picture
or text (which is automatically selected) to paste into other
documents or desk accessories. Use the scroll bar to look through
the Scrapbook.
The contents of the Scrapbook are stored in the Scrapbook file on
the current startup disk. You can copy Scrapbook files among disks
or remove them to gain space on the disks. You can keep more than
one Scrapbook file on the same disk by renaming all but one of
them or keeping it in another folder. (Your computer uses the one
named Scrapbook.) When you choose Scrapbook from the Apple
menu, you always see the Scrapbook whose contents are in the same
folder as the System file and Finder on the current startup disk.
See "Using the Scrapbook" in Chapter 3.

TeachText
TeachText is an uncomplicated application that lets you write, read,
and edit your own text documents. If you went through the tutorial in
Chapter 2, you used TeachText and learned some basics.

Figure 4-15
TeachText icon

TeachText also provides a means for Apple Computer and other
software developers to make sure that the information you get on a
new product is as up-to-date as possible. When you open an
application's directory window and see a Read Me document, the
document contains last-minute information that probably couldn't
be included in the application's manual. Cit's a lot quicker to create
a document on the disk than it is to produce an insert for a book!)
You use TeachText to gain access to this Read Me information.
The TeachText application is on the Utilities disk, and any Read Me
documents are contained in an Update Folder, also on that disk.
There are two ways to get to TeachText documents you want to read:
o Open the TeachText application (by selecting its icon and
choosing Open from the File menu or by double-clicking on the
TeachText icon). The first window you see will be empty and will
say Untitled in the title bar. Close the window (by clicking the
close box or by choosing Close from the File me nu). Then
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choose Open from the File menu, and a dialog box appears with
the names of folders and documents (including the Read Me
documents) you can read in TeachText. Select and open the
document you want to read. (You can also use TeachText to read
text-only documents you've created in your favorite word
processor.)
o Ln the Finder, open the Update Folder by selecting its icon and
choosing Open from the File menu or by double-clicking on the
icon. Then select and open any document you want to read. The
TeachText application will start automatically.
You can print any document that appears in the TeachText window,
but you will not be able to change any part of a Read Me document.
When you are using TeachText to write your own documents, you
can use all the normal editing functions. You can cut or copy from
TeachText to the Clipboard, and you can paste what you put on the
Clipboard. However, you will not be able to open up the Clipboard
to see what's on it.
If you want to try using TeachText to write or edit something, go
through the tutorial in Chapter 2.

Finder reference
The Finde r is the application for managing documents and
directing traffic between you and the disk.
Common Finder tasks include
o opening, closing, copying, discarding, moving, and renaming
documents, folders, applications, and disks
o organizing documents, applications, and folde rs on the desktop,
in folde rs, and on disks

-

o ejecting disks
o initializing disks
o write-protecting documents
o getting information about your folders, docume nts, and
applications with the Get Info command from the File menu
o turning off your computer with the Shut Down command from
the Special menu

-
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Some of the Finder's capabilities are also available while you're
using an application. You can open new documents, save work on a
disk (using the same folders that appear in the Finder), examine the
contents of disks and their folders, eject disks, print the current
document, or return to a previous version of a document without
returning to the Finder.

I
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I
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You work in the Finder by selecting and dragging icons, by doubleclicking, and by choosing commands from menus. (See ~~selecting
Icons," "Dragging Icons," and "Finder Menus'' later in this
chapter.)

What the Finder manages
Applications and documents

Applications and documents are represented in their closed state as
icons (or as a list in a text view). You can open, close, rename,
duplicate, discard, or organize applications and documents on
disks and in folders.
Disks

You see the contents of disks in directory windows. Disks can
contain system files, documents, applications, and folders. Each
item is represented by an icon that you can select and drag; you can
choose to see disks' contents arranged in several ways with the View
menu.
A disk newly inserted into a disk drive appears as a black disk icon
(that is, it's automatically selected). The icon becomes dimmed
when you open its window.
Ejected disks

How you choose to eject a disk determines what's there for the
Finder to manage.
If you choose Eject from the File menu, the disk will be ejected and a
dimmed icon will stay on the desktop. The Macintosh II will
remember the contents of that disk as long as the dimmed icon is
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there. You can open the disk icon (or any folder inside it) into a
directory window; however, any items in the window will also
appear dimmed. (You can drag a dimmed icon just as you would an
icon that's not dimmed.)
As long as the ejected disk's icon remains on the desktop, the Finder
will ask you to reinsert the ejected disk any time it is needed. If you

want to avoid this, drag the ejected disk's icon to the Trash to
remove it.
If you drag the disk to the Trash, the disk will be ejected and its icon
will be removed from the desktop. Tills leaves nothing behind for
the Finder to manage, and many times that's exactly what you want
Important

If the disk Icon you drag to the Trash is the current startup disk,
its dimmed Icon will remain on the desktop. You will not be able
to remove or open the Icon without reinserting the startup disk.
(Or you can choose Shut Down from the Special menu, Insert
another startup disk, and press the Power On key to start
again.)

See "Startup Disks" and "Arranging Your Work on Disks Efficiently"
earlier in this chapter for more information about disks.
The desktop
The desktop in the Finder is a handy temporary resting place for
icons. If you're concentrating on only a few documents and
applications at a time, and they're on different disks or in different
folders, you can drag all the documents to the desktop and work on
them there. You can even close the windows for the folders and
disks they came from; the Finder will remember where the
documents belong.

....

You can put icons back where they came from by selecting them on
the desktop and choosing Put Away from the File menu .
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The Trash
The Trash is a receptacle for files and folders you want to throw
away. When you discard a folder, the folder and its entire contents
disappear.
You can't throw away anything on a locked disk or any documents
that have been individually locked; you must unlock the disk or file
first.
When you open the Trash icon, it shows the last few Hles you
discarded. You can recover those files by dragging them out of the
Trash back onto the desktop.
As something goes into the Trash, the icon will "bulge." If you want

to empty it-and reclaim the space the discarded files take
Empty Trash from the Special menu. In fact, whether
you empty it or not, files stay in the Trash only for a short while. The
Finder empties the Trash when it needs the space, as well as any
time you start an application or choose Shut Down or Restart from
the Special menu.
up~hoose

Dragging a disk to the Trash ejects the disk and removes its icon
from the desktop; it has no effect on the contents of the disk. (If the
disk is the current startup disk, dragging its icon to the Trash ejects it
but leaves the dimmed icon on the desktop.)

Folders
Use folders to arrange your applications, documents, and other
files in ways that make sense to you. You can leave your
applications, documents, and other files in the disk window, or you
can put them in folders. (You make new folders by using the New
Folder command in the File menu.) You can even put folders within
other folders. See the next section, "The Hierarchical File System,"
for more information on using folders.
To see the contents of a folder, open the folder just as you would a
disk icon-by selecting the folder icon and choosing Open from the
File menu or double-clicking on the icon. The folder icon opens
into a directory window.
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Figure 4-16
Placing one folder Inside another

The hierarchical file system
Folders let you arrange your applications and docu ments in a
hierarchy. When you open a disk and see a folder (or file) in the
disk's directory window, you're looking at the Lop level of the
hie rarchy. When you open that folder, you see another window that
shows you what's inside-probably more files and folders. Now
you're looking at the second level of the hierarchy. If when you
open one of the folders on this second level you see yet another
fo lde r, that folder will open onto the third level-and so on.
You can nest Hies (that is, place files and folders within other
folders within othe r folders, and so on) as deeply as you like. Most
people, however, find that retrieving a file nested more than four
levels deep becomes tedious.
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Figure 4- 17
Hierarchical file struct ure

Luckily, you don't have to worry about misplacing a file, even a
deeply nested one. If you know its name, you can find any flle or
folde r by using Find File. See "Find File" earlier in this chapter.

Within applications
The hierarchcial file system can be especially he lpful when you're
working within an application. Whenever you choose Open or Save
As from the File menu within an application or save a document for
the first time using the Save command, you see the same hierarchy
of folders you created in the Finder (as long as the disk is initialized
appropriately). See the sections on initializing disks in Chapter 3
and this chapter and "Managing Documents Within an
Application" in Chapter 3.
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A dialog box appears with a directory of the current folder or disk.
The directory name (and a folder or disk icon) is above the
alphabetized list of the directory's contents; the name of the current
disk (and a disk icon) appears to the right.

~

Projett\ 87

ScH•e current document

Cant el

~~===================~

-

Figure 4- 18
Directory dialog box

The folders in this directory dialog box correspond to the ones you
create in the Finder, with one notable difference: these folders show
only the documents the current application can open, even if the
corresponding folders in the Finder contain other documents or
applications.
You open these folders in the same way you open folders in the
Finder-by selecting them and choosing Open or by doubleclicking on them. You can also use the arrow keys (or drag the
mouse) to move up and down the list of names until you find what
you want to select and open.
You can move through the entire hierarchy of folders in this same
way, opening folders within the currently open folder, until you
reach the document you want to open.

•:• A shortcut when you know what you want: If you know the
name of a document or folder in the current directory and want
to select it quickly, type the character or characters you want to
find. As you type each character, the system highlights any
documents or folders that "qualify." For example, as you type
M, the selection bar moves to the first name beginning with M in
the list. As soon as you type a second letter, the system will find
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the first name that begins with both letters, and so on.
However, if you are hesitant and pause too long while typing,
the next character you type is considered a new request rather
than a continuation of the old. (The Delay Until Repeat setting
in the Control Panel controls how long the pause can be before
subsequent typing begins a new request)
When you choose Open or Save As, the first directory you see is for
the folder (or disk if you're at the top level) that you last saved a
document to or opened a document from. You can move up or
down the hierarchy to open or save documents.

·~I

...,
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You can keep documents or folders with the same name on the same
disk, as long as they're in different folders.

Selecting icons
Clicking an icon once selects it (Clicking it twice opens it) Once an
icon is selected, the Edit menu commands operate on that icon's
name (unless it's locked), and the File menu commands work on
what the icon represents.
When more than one icon is selected, the editing commands in the
Edit menu are dimmed.
You can select a group of icons only if they're all in the same
window or all on the desktop. If you want to work on a number of
documents in different folders or disks, drag them to the desktop
and select them all there.

,..
I

Operations on a group of icons are usually performed one by
one-printing a group of documents, for example.

Dragging icons
Dragging an icon from one place to another moves that icon to the
new place. You can drag an icon onto the desktop; to the Trash
icon, a folder, or a disk; or into an open folder, disk, or Trash
window.

'-t
I
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Dragging an icon from one place to another on the same disk
(including to a folder on the same disk) merely moves the icon to
the new place. Dragging an icon to another disk (including to a
folder on that disk) makes a copy and leaves the original behind for
safekeeping. Of you don't want the original left behind, just drag it
to the Trash afterward.)
If you drag an icon to another disk and there's already an item with
that same name on that disk, you're asked if you want to replace it
with the icon you're dragging. an other words, if you drag the
application MacWrite to a disk with a folder named MacWrlte1
you'll be asked to conflrm that you want to replace the folder with
the application. If you say yesl you'll lose what was there.)

,..

Table 4-2 summarizes what happens when you drag icons to
different places on the desktop.

~

Table 4-2
Dragging icons
Dragging ...

...

A

document

A folder

An

~

-

A

application

disk

To a folder on
the same disk

To a folder on
a different disk

loa
different disk

To a hard disk

To the Trash

Moves it there

Copies it there

Copies it there

Copies it there

Discards it

Moves it
there

Copies it and
its contents
there

Copies it and
its contents
there

Copies it and
its contents
there

Discards it and
its contents

Moves it there

Copies it there

Copies it there,
replacing any
duplicate applications in the
root folder

Copies it there,
replacing any
duplicate applications in the
root folder

Discards it (with
a dialog box to
confirm the
discard)

(Alert box tells
you it can't
be done.)

(Alert box tells
you it can't
be done.)

Copies it there,
replacing any
existing
contents

Copies it into
a new folder,
adding to any
existing
contents

Ejects it and
removes its
icon (unless it's
the current
startup disk)

You can drag locked documents, but you can't drag anything to or
from a locked disk. See the Get Info command in "File Menu" later
in this chapter.
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Finder menus
Each application presents its commands in menus that you pull
down from the menu bar. Toge ther with dragging icons, the
Finder's menus allow you to do all your desktop manageme nt tasks.

Apple menu
rile

Edit

liil'U.'

Spe(ial _ __

Abo ut the Fi nder ...
Alarm Clock
Cal cul at or
Chooser
Con tro l Panel
Find Fil e
Key Caps
Scrapbook

Figure 4-19
Apple menu

About the Finder...

This ite m shows the version number and the authors of the Finder,
as well as the memory size of the Macintosh you're using.
Desk accessories

Choosing a desk accessory makes that accessory appear on the
desktop. You can use the Edit menu to cut, copy, and paste the
information in most desk accessories.

n

The desk accessories are explained more fu lly in "Using Desk
Accessories" in Chapte r 3 and in "Desk Accessories" earlier in this
chapte r.
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File menu
.~
d1t

Lliew

Spec 1ul

New Folder HN
HO
Open
Print
Close
Get Info
Ouplicote
Put Awoy

HI
HD

Poge Setup
Print Cotolog

Figure 4-20
File menu

The commands in the File menu operate on icons and windows.

New Folder
New Folder creates an empty folder that can hold documents,
applications, or other folders. New folders appear in the active
window on the desktop (as opposed to on the desktop itselO, and
you can type a name immediately after creating an empty folder. If
no directory windows are open, the New Folder command is
dimmed. See "Folders" earlier in this chapter.

Open
The Open command opens the selected icon into a window. If the
icon represents a document, opening it also starts an application
and loads the document so you can work on it. If the icon represents
an application, opening it usually gives you a new, untitled
document.
In order for you to open a document, the application that created it
must be on a currently inserted disk.
If you select a document and an application, the Finder attempts to
use that application with the document. For example, selecting
MacWrite (the word processing program) along with a text-only
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document that you created with MacTerminal (the telecommunications program) opens MacWrite to work on the text-only
document.
If you select more than one icon and choose Open, the Finder tries
to open the first icon's application to work on all the other selected
icons (assuming the application can handle more than one
document).
~1

Print (from the Finder)
The Print command prints the documents represented by the
selected icon or icons (assuming, of course, your printer is hooked
up correctly). If you select a group of icons, they'll all be printed.
The documents must always be created by the same application.
In order to print a document, you must have the application that
created it on a disk whose icon appears on the desktop. Document
printing from the Finder follows the rules and printing procedures
of that document's application.
With most applications, when you choose Print a dialog box
appears. Select the options you want, and click OK or press Return.
See each application's manual for more information on how to
print with that application. See each printer's manual for
information about using that printer.
Close

The Close command closes the active window, zooming it back
down to its icon. The icon remains selected. Of the active window is
a desk accessory, it just disappears.) The next frontmost window, if
there is one, becomes the active window.

Get Info
Get Info opens a window that displays information about whatever
the selected icon represents. The displayed information includes
o the kind of item (document, folder, or application)
o if it's a document, which application created it
o the date it was created
o the date it was last changed
o the size of it
o which disk and drive it belongs to
182
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You can add text by typing in the text box and editing it as you edit
any text
The Locked check box lets you lock a document or application (but
not a folder). When the Locked box is checked, that document or
application can't be thrown away and its name can't be changed.
You can't save any changes to a locked document.
You can still drag or open a selected icon while its information
window is open.
Duplicate

The Duplicate command duplicates the selected items on the same
disk. The duplicates are named Copy ot followed by the name of the
original.
Duplicating a folder duplicates the folder and all its contents. If you
had previously moved a document, folder, or application from the
folder to the desktop or a window, that item will not be duplicated.
(The system will assume that you meant not to include the item.)
Put Away

Put Away returns any selected documents, folders, or applications
on the desktop or in the Trash window back to the folders and disks
they belong to. This command is dimmed when no icons are
selected on the desktop or in the Trash window.
Page Setup

Page Setup lets you set up the page size, orientation, and other
options for directories that you print using the Print Catalog
command. The Page Setup command doesn't work with documents
that you print from the Finder; each document's page setup is
controlled by the Page Setup command within the application that
created it.
Print Catalog

Print Catalog prints the actual contents of the active directory
window, in whatever view you have the directory arranged. (See
View Menu" later in this chapter.) What you see gets
printed-icons, document names, and so on-as opposed to the
contents of documents.
11
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Eject
The Eject command ejects the selected disk or the disk represented
by the active window. If no disk is selected, the Finder looks for an
inserted disk to eject, starting with the current startup disk.
Whenever a disk has been ejected, its icon and the icons belonging
to it are dimmed to show they're no longer available. (You can also
eject a disk by dragging its icon to the Trash.)

~

~

Edit menu
d:

File

Cut
Copy
Paste
Clear
Select All

88H
XC
XU
XA

Show Clipboard

Figure 4-21
Edit menu

The Finder's Edit menu allows you to edit
o the names of disks, documents, applications, or folders
o text in an information window (opened by selecting the icon and
choosing Get Info from the File menu)
o text or pictures in desk accessories
•!• Icons: You cannot use this menu to cut or copy icons. You
reproduce icons by dragging or duplicating them. See
"Dragging Icons" and "Duplicate" earlier in this chapter.

Selecting an icon also selects its title. Anything you subsequently
type replaces the old text. Clicking the selected text itself makes an
insertion point appear. You can edit this text the same way you edit
any text.
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Undo

This command undoes your last text-editing action in some
applications and desk accessories that use text. It may undo other
actions in some desk applications. For example, if you choose Get
Info from the file menu and type something wrong in the text box,
you can choose Undo to reverse the typing and start fresh.

Cut
Cut removes the selected material and places it on the Clipboard
(replacing the previous contents if any).
Copy

Copy puts a copy of the selected text or picture on the Clipboard
(replacing the previous contents if any). The "original" stays where
it was when you selected it.
See also "Duplicate" earlier in this chapter.
Paste

Paste puts a copy of the contents of the Clipboard at the insertion
point. You can continue to paste copies until you cut or copy a new
selection (which replaces the old contents of the Clipboard).
Clear

Clear removes the selected material without placing it on the
Clipboard. The contents of the Clipboard (if any) remain intact.

...

Select All

This command selects all icons in the active window or, if no
windows are open, all icons on the desktop.
Show Clipboard

Show Clipboard displays a window with the current contents of the
Clipboard-that is, whatever you last cut or copied.
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View menu
~
I

Figure 4-22

VIew menu

You might keep your directory windows arranged by icon most of
the time. But the commands in the View menu also let you view
directories of disks, folders, or the Trash in other arrangements.
In any text view of a disk or folder directory, small icons appear to
the left of each document, folder, or application title. Icons and
text in titles behave the same way in whatever view you choose.
Clicking either an icon or its title selects the item; the pointer then
becomes an arrow when you move it over the icon itself (in case you
want to move or copy the item, or to select something else) and an
1-beam when you move it over the item's title (in case you want to
place an insertion point for editing). Dragging an unselected icon
or title moves or copies the item-depending on where you drag it.
See "Dragging Icons'' earlier in this chapter.
The current view of the active window is marked in the View menu by
a check.
By Small Icon
By Small Icon shows the contents of the active directory window
with small icons to the left of the icon names. This view is especially
helpful when you have large numbers of documents and
applications on a disk-when looking at your hard disk, for
example.
By leon
By Icon shows the contents of the active directory window as icons,
just as on the desktop.
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By Name

By Name lists the contents of the active directory window
alphabetically by name. Uppercase and lowercase are considered
equal.
By Date

By Date lists the contents of the active directory window
chronologically by modification date. The document you changed
most recently is listed first. Folders' modification dates indicate
when you created them or when you changed their contents by
adding or removing items from them.
By Size

By Size lists the applications and documents in the active directory
window by size, largest first. By Size is useful for seeing which
documents are taking the most room on the disk. Folders are listed
alphabetically by title at the bottom of the list, following the
applications and documents (but their size is not shown).
By Kind

By Kind lists the contents of the active directory window by whether
each item is a document, application, or folder. For a document, it
tells which application created it.

Special menu
a

rile

Edit

Lliew

St~t

Sf <1rfup

ll~t~ Minit=ind<~r ...

Res tort
Shut Down

Figure 4-23
Special menu
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Clean Up
Clean Up is only available when you have chosen By Small Icon or
By Icon views of your directories. The command you see will
change slightly, depending on certain variables:
o If you have an active directory window with no icons selected, the
command will say Clean Up Window. If you choose it, the icons
will be arranged in neat rows and columns on an invisible grid,
fllling in from left to right and top to bottom.
o If you have one or more icons selected, the cbmmand will say
Clean Up Selection. When you choose it, each selected icon will
move to the nearest available space on the grid-not necessarily
filling in from left to right and top to bottom. (To deselect all
icons, click in the gray area of the desktop.)
D

If no directory windows are active and no icons are selected, the
command will say Clean Up Desktop and will move .icons on the
desktop to the nearest available space on the grid.

IJIIilll'

I

~
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•!• Neater icons: If you hold down the Option key while you press
on the Special menu, the command will simply say Clean Up.
Choose it (while still holding down Option) to display the icons
in an active directory window (or the desktop if there is no
active window) neatly and compactly.
Empty Trash

Empty Trash permanently discards the contents of the Trash and
makes the space it took on the disk available for you to use
immediately. (The Finder empties the Trash automatically
whenever it needs the space, when you choose Shut Down or Restart
from this menu, or when you start an application.)

r-,
I

Erase Disk
Erase Disk completely erases and initializes the disk whose icon
you've selected. A dialog box will offer the usual choices about
initializing the disk.
You can't erase the current startup disk because your computer
needs information on that disk in order to work. If you want to erase
a startup disk, start your computer using a different disk.
~
\

~

!
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See "Initializing Disks" earlie r in this chapte r for mo re information
about initializing.
Set Startup

Set Startup lets you jump immediately into an application whe n you
start the computer, w ithout going through the Finde r. You set the
startup application by selecting it in the Finde r and choosing Set
Startup. The next time you start your compute r using this disk, you'll
go immediately into the application.
To reset the startup to the Finde r, quit the application , ope n the
System Folde r if necessary, select the Finder icon , and choose Set
Startup again.
Use MiniFinder...

Usc MiniFinder lets you isolate (a nd group togethe r fo r quick
access) the applications a nd docume nts you want to use for a
particular task. Once they're in the MiniFinder, you can get to them
w ithout having to go through everything in the Finder. See "Using
the MiniFinder" in Chapter 3 fo r details on how to use the
MiniFinde r.
Restart

Restart ejects any inserted disks (fi rst saving any necessary
information), empties the Trash , and the n restarts the compute r.
This is not only a shortcut but the best way to restart the Macintosh
when you need to use a diffe rent startup disk.
Shut Down

Shut Down ejects any inserted disks (first saving any necessary
information), empties the Trash, and then turns o ff the computer.

Macintosh II shortcuts
In general, shortcuts are just quicker ways to do things you can
ordinarily do some othe r way. Some shortcuts apply only to a
specific application; each application 's manual explains its own.
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Double-click
Double-clicking an icon opens it. In text, double-clicking a word
selects the entire word.

Shift-click
Holding down the Shift key and clicking adds to an existing
selection. As long as you hold the Shift key down, the first selection
isn't deselected when you make a new selection. For example, in the
Finder when you're selecting icons, you can select more than one
by holding down the Shift key while you continue clicking icons. If
you have a group of selected icons and want to deselect one of
them, you can use Shift-click to deselect it. In some applications,
Apple-dick does the same thing.

.-.
~

Close box
Clicking the close box (in the active window's top-left comer) closes
the window. This is the same as choosing Close from the File menu.
.-r
I

Zoom box
Clicking the zoom box (in the active window's top-right comer)
expands the window to full size. Clicking the zoom box on an
expanded window returns it to its former position and size.

Enter and Return keys
Pressing the Enter or Return key in response to a dialog box is the
same as clicking the button that confirms the command or the
outlined button if there is one.
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Tab key
Pressing the Tab key in response to a dialog box usually selects the
next place to supply information.
In the dialog boxes you see when you choose Open or S.ave As ~ithin
an application, pressing Tab is the same as clicking Drive.

Delete key
Pressing the Delete key with a selection is the same as choosing
Clear from the Edit menu. Unlike the Cut command, the Delete key
doesn't affect the Clipboard.

Apple key
3e
·------

You can issue many commands (including most commands in the
Edit menu) by holding down the Apple key while you press a
character key. Commands that have Apple-key equivalents show the
key to press to the right of the command in the menu.
Holding down the Apple key while typing a period(.) sometimes
stops whatever's happening-printing a document, for example.
Holding down the Apple and Shift keys while pressing the 1 key
ejects the disk in the right-hand drive; holding them down while
pressing 2 ejects the disk in the left-hand drive.

Important

If you're using an application and there are any open
documents with unsaved changes, you may lose those
changes if you eject disks this way. If you're not sure whether
there are unsaved changes, It's better to eject disks In the
normal way-clicking an Eject button, choosing Eject from the
File menu, dragging a disk icon to the Trash. or choosing Restart
or Shut Down from the Special menu.

Holding down the Apple and Shift keys while pressing 3 creates a
MacPaint document with the current contents of the screen.
(MacPaint is the original graphics program for the Macintosh series
of computers; it's available at your authorized Apple dealer.)
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Holding down the Apple and Shift keys while pressing 4 prints the
current contents of the active window on an ImageWriter printer.
With the Caps Lock key down, holding down the Apple and Shift
keys while pressing 4 prints the contents of the entire screen on an
ImageWriter printer.

~

Selecting by typing
In the directory that appears when you choose Open within an
application, any characters you type are matched character for
character to select names in the directory. If you type a b, the first
name beginning with a b (or the first name to follow alphabetically
if there are no lis) is selected. As you continue to type, additional
characters are matched. If you type br, for example, the first name
beginning with br is selected, and so on. The Delay Until Repeat
setting in the Control Panel determines how long you can pause
between characters before the computer considers the next
character a new request. See "Using the Control Panel" in
Chapter 3.

I
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I

,...
i

Finder shortcuts
These shortcuts are specific to the Finder. Most of them let you do
"expert»' functions.
Option key

Holding down the Option key while you choose Close from the File
menu closes all open windows.
If your directory is in an icon view, holding down the Option key
while you choose Clean Up from the Special menu will realign the
icons in the active window to a grid pattern.

,..,
I

Holding down the Option key while you double-dick a disk or folder
icon opens the icon as usual, and you can open an application or
document in the resulting window. The shortcut is that once you
return to the Finder, the window will be closed and the application
or document put away.
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Apple key
Holding down the Apple key while you drag a window moves the
window without making it active.

n
n
n

n
n

n
n

With your directory in an icon view, you can hold down the Apple
key while you drag and then release an icon. When you release the
icon, it will snap into alignment with the grid used by the Clean Up
command (in the Special menu).
Holding down the Apple key while you double-dick a dimmed icon
makes that icon's window active.

Option and Apple keys
Holding down the Option and Apple keys while you double-click a
Finder icon makes the disk the Finder is on become the current
startup disk (if it has a system me on it).

Miscellaneous
Dragging a disk to the Trash is an easy way to eject the disk. If the
disk is not the current startup disk, this will also remove its icon from
the desktop.
If you hold down the mouse button as you press the Power On key
(and continue holding it down), you'll eject any disks in both
drives. This is useful when you insert a 3. 5-inch disk before turning
on the computer, then change your mind and want it back.

n
n
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Applications
No matter what kind of work you have to do, there's an Apple
Macintosh II application to help you do it.

MacWrite
With MacWrite, you create documents that look the same o n the
screen as they'll look when you print the m. Rathe r than working
around a lot of commands embedde d in your text, what you see is
w hat you get. You use the mouse to select text and re move, copy, or
move it. You can customize your docume nts with ma ny fonts and
sty les, and you can control margins or line spacing with a single
click.

•:• MacWrite version: You shou ld use MacWrite vers ion 4.6 or
later with your Macintosh II.

Chapter I
Introc:lucti on
In th iS paper I w i ll di scuss the Bar oque epp l i ca ti ons of the rft orne/lo and
the late - Bar oque rftom£>1/o concerto. 1 wil l t hen present
l ate-ninet eent h- cent ur y explanatt ons of t he concert o form, di scuss how
most of these t heories fa il under anal ysi s, and concl ude wi th a brie f
discussi on of Mozarl"s P1tmo Concert o inC 1"/inor.. K. 49 1, as a cui mi na ti on
of the syn thesis of the ntornel l o pr inci pl e and t he deve l opi ng
sonata -allegr o form

Definition of the Ritornello
Rllornello IS a compost llonal devtce r ather t han a form-a way to gw e
cohesiveness to a wor k, no t a detai led formal struc ture on whi ch to
compose. 1 In thi s w ay 1t r esembles a fugue. In the Baroque period it
ted to s
ntol ass
between
scenes to

Figure 5-1
Mac Write
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You can add pictures from your favorite graphics program to
documents you create with MacWrite or copy MacWrite text to a
graphics program. With your Macintosh II, words and pictures mix
beautifully.

Mac Paint
MacPaint brings out the artist in everyone. \Vhether it's a technical
illustration for a research project or a sketch for a party
announcement, you can do it with MacPaint. You can use
MacPaint's drawing tools to draw perfectly structured shapes or your
own freehand designs. You can type text in distinctive fonts, sizes,
and styles and add text from other applications as well.

-

~

-
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~

L t!lleling Ctlflcepts l or

Sorenson's jams and jellies,
2 x 3" gloss white labels
Each label to be approved by

-

Figure 5-2
MacPalnt
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Mac Terminal
MacTerminallets you communicate with the rest of the world. You
can gain access to information services such as The Source,
CompuServe Information Services, or Dow Jones News/Retrieval;
call electronic bulletin board systems (BBS); exchange information
with other computers; and send and receive electronic mail.

File Transfer Settings

Settings for Posting or Sending TeHt:
Deloy Between Chors

U•

16Dths Second

@TeHt

Deloy Between lines ~ 6Dths Second

0

MacBinary

[8) Word Wrap Outgoing TeHt

0

HModem TeH t
MacTerminol 1. I

Setting s for souing lines orr top :

0
0

[8) Retain line Breaks

0

Saue Screens Before Cl earing

Figure 5-3
MacTerminal
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Straight HMod em

Mac Project
Project management and scheduling have never been easier. You
tell MacProject what tasks are involved in your project and what
resources you have. MacProject calculates the "critical path" to
completion and estimates costs in money and time. If you miss (or
beat!) a deadline, or if your available resources change,
MacProject recalculates everything in a flash.

Begin
manuf acturing et
new site

John--You made tlle deadline!
Keep up tlle good work and
start thinking about tlle
Operations move.

Figure 5-4
Mac Project
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Mac Draw
MacDraw lets you create structured graphics on your computer. You
can prepare perfect flow charts, diagrams, graphs, technical
drawings, and organizatio nal charts, as well as free hand drawings.
You can add text in different fonts, sizes, and styles.

-

Figure 5-5
MacDraw
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AppleS hare
AppleShare™ workstatio n software lets your Macintosh II computer
communicate w ith file serve rs on the AppleTalk network, sharing
information, applications, and storage resources with othe r users.
Alternatively, AppleShare serve r software turns your Macintosh II
into a powe rful file serve r on AppleTalk, sharing its resources with
many users on the network.

Se rver Nom e:
Soles & Merke l1 ng

Volumes :
lnternetionel Seles
Amencen Seles
Users:
Sue Esptnose
Cliff Guren
John Med1ce
Leurle Sheldon
Jon Thompson
Scot tie Zimmerman
<Guest>
Fn , Mey 17, 1987 3:03:53 PM
ACtiYl t y:

I

I

I

I

I

idlt

I

I

I

I

I

bus~

Figure 5-6
AppleShare
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And many more ...
Top software developers have developed many more applications
for your computer. (Contact you r authorized Apple dealer for
availability.) You can choose from
o electronic spreadsheets for budgeting, forecasting, and
answering "What if?" questions
o data base management programs for helping you keep track of
everything from inventories to prospective clients ro your
favo rite restaurants
o charting programs for turning numbers nobody understands into
charts everyone understands
o programming languages, publishing programs, spelling checker
programs, and hundreds more for getting your work done (and
games or educational programs for when you need a break)

Hardware
Your Apple Macintosh II computer is a ve rsatile machine, designed
to grow as your computing needs grow. There are many devices you
can add to your computer system to expand its capabilities, and
many more are on the way.

800K disk drive
With an additional 800K disk drive built into your computer, you
can work much faster and more efficiently. Copying disks becomes
a one-step operation-disk swapping is eliminated. And you can
keep system files and applications on one disk, and all your
documents on another. See "Disks" in Chapter 4.
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Figure 5-7
Second 800K disk drive

-

-

Apple SCSI hard disks
Apple SCSI hard d isks are extremely fast information storage and
retrieval systems. You can store hundreds of applications and
documents all in one place, letting you work much more quickly and
efficiently than with 3.5-inch disks. Hard disks for you r Apple
Macintosh II computer are available in 20-, 40-, and 80-megabyte
configurations, in both built-in and external models.

Internal

-

External

Figure 5-8
SCSI hard d isks

Hardware
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AppleTalk Personal Network
The AppleTalk Personal Network is a low-cost local area network
that's as easy to set up and use as your computer. AppleTalk lets
everyone in you r work group communicate with each other (sending
documents or electronic mail much faster than ordinary
telecommunications). With AppleTalk, you can also share the cost
of high-performance resources su ch as the LaserWriter or powerful
mass-storage devices-at a fractio n of the cost of other networks.
Your AppleTalk network system can grow to serve a virtually
limitless number of computers by linking separate networks
togethe r. (Using a hardware bridge and accompanying software,
you form an interconnecte d series of AppleTalk zones; each
compute r in the entire network can have access to any shared
resource anywhere in the network.) Whatever your networking needs
are, AppleTalk can fill them.

__ I
'=::::c:::::I~-- ~p

n

Figure 5-9
Apple Talk

-
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Apple lmageWriter II printer

-

With an Apple ImageWriter II printer attached to your computer,
you can get high-quality printed copies at a low cost. And with the
AppleTalk option (requiring the AppleTalk card), you can connect
a number of computers to the printer.

Figure 5- 10
lmageWrlter II

Apple LaserWriter printer
The Apple LaserWriter printer gives you near-typeset-quality
printed copies of your work, for a lot less money than you'd expect.
And LaserWriter printers use the AppleTalk Personal Network so you
can share them with the people you work with.

Figure 5 - 11
LaserWrlter

-
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Apple Personal Modem
An Apple Personal Modem lets your computer communicate with

the rest of the world using telephone lines. You can send and
receive messages through electronic mail, subscribe to news
services, find out the latest price of your stocks, or gain access to an
e ntire university library from your computer. Your Apple dealer
can tell you about the Macintosh telecommunications possibilities,
including MacTerminal.

Figure 5-12
Apple Personal Modem

Monitors and video cards
You can choose a monochrome or color monitor for your
Macintosh II system:
o 12-inch Apple High-Resolution Monochrome Monitor
o 13-inch AppleColor™ High-Resolution RGB Monitor
The 12-inch monitor, with a density of 76 dots per inch, lets you see
more than half a page high and a full page wide. It's perfect for word
processing and most business applications.
The 13-inch monitor has a density of 69 dots per inch with full RGB
(red/green/blue) color. Use it for any application where color is a
plus.
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The standard video card will drive either of these monitors and
allow either 16 colors or 16 shades of gray.
With the video card expansion kit, you can select colors from a
palette of millions and display up to 256 colors. See your Apple
dealer for details.

-

-

Figure 5-13

Monitors

Memory expansion
Your compute r comes with 1 megabyte (1 MB) of memory on the
main logic board. You can upgrade your system to 2, 4, 5, or 8
megabytes of memory, letting you work faster, more efficiently, and
with far larger documents. Because there's no system overhead
associated with added memory, you can more than double your
computer's working space. And with Apple Computer's new Single
In-line Memory Module (SIMM), it takes your dealer just a few
minutes to give you all the memory you need for the most
dema nding applications .

.t•··~
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Apple Extended Keyboard
The Apple Extended Keyboard was designed with additional keys to
allow you to run alternate applications and operating systems such
as MS/DOS and UNIX. See the manuals that came with these
programs to learn how to take advantage of the additional keys.

I

~

...
1:"

J; j(; ~;_I; Jl!
lo lw . " 11

a;
1

Ji.• II< II• 111, II•

A: 1 ; .~..I.~ ~..1.: Jlr 11 1 t1 ,. ~ ~~ R\
lib 11, 8 , If, &: &: B -

Figure 5-14
Apple Extended Keyboard

Macintosh Programmer's Workshop (MPW)
If you're interested in developing applications for the Macintosh II,
ask your authorized Apple dealer about the Macintosh
Programmer's Workshop. MPW is a programming environment for
the Macintosh that includes an assembler and C and Pascal
compilers. Version 2.0 supports the Macintosh H.
If you plan to develop applications for sale through retail channels,
you can get valuable support from Apple Developer Relations.
Write to
Apple Developer Services
Mailstop 27-W
Apple Computer, Inc.
20525 Mariani Avenue
Cupertino, CA 95014
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The first thing to know: You'll never damage your Macintosh II
computer by clicking in the wrong place or pressing the wrong key.
Your computer is no more fragile than a television set. And if you
follow the few suggestions here, you and your computer will be
together for a long time.

The main unit
Give your computer plenty of space-enough so air can circulate on
all sides, even the bottom. Make sure air can circulate around each
of the ventilation slots on the top and sides of the main unit. The
vents on the sides of the main unit are exhaust vents (where heat
escapes), and the vent on the top is an air intake (allowing cool air
in). Don't use the main unit on thick-pile carpet or upholstery, or
anything else that will block its ventilation.
Be careful not to spill liquids on your computer. It p robably won't
survive a cup of coffee spilled into it.
The computer can tolerate about the same range of temperatures as
you can, but don't let it sit outside in direct sunlight or expose it to
rain (much less hail, sleet, or snow). The main unit may feel warm
to the touch after it's been on for a while. This is just the heat
generated inside escaping.

Important
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Proper ventilation is Important to the life of the computer. Be
sure to leave a 4- to 6-lnch clearance between the side vents
on the main unit and any object that might restrict air flow.
Always keep your computer's main unit flat. sitting on its rubber
feet. Standing It on edge defeats the cooling design. and Is
likely to make your computer overheat. This will eventually
damage the main unit. (See Figure 6-l .)

Chapter 6: Taking Care of Your Macintosh II

Right way

Wrong way

Figure 6 - 1
How to place the main unit

-

If you choose to leave your computer o n all the time, re me mber to
turn down the brightness o r contrast whe n you're not using it; if your
computer is le ft o n for long periods (days or weeks), the image on
the screen will start to "burn in," and the screen may be
permanently damaged.
Extend hard disk life

If your computer has a hard disk and you plan to be away from
it for eight hours or more , shut off your entire computer system
to extend the hard disk's life. While the computer part of your
system can stay on indefinitely, the disk drive will eventually
wear out.

The monitor

-

There a re a number of ven tilation slots on the top of the monitor.
These vents allow heat to escape, so be sure to leave them
unobstructed. Don't set anything-even a piece of paper- on the
top of the display monitor.

The monitor
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The keyboard
Try not to spill anything on the keyboard. It can be ruined by a
spilled soft drink or anything that leaves a sticky residue. If you spill
something on the keyboard and it stops working:

o If the liquid is sweet or sticky, unplug the keyboard and take it to
your authorized Apple deale r for repair or replacement
o If the liquid is thin and clear, try unplugging the keyboard,
turning it upside down to let the liquid drain out, and drying it for
24 hours at room temperature. If it still doesn't work, take it to
your Apple dealer.

The mouse
Be careful not to drop the mouse or let it hang from a table by its
cable. Just use common sense in treating it as carefully as you can.

n

The surface your mouse moves on s hould be as smooth, clean, and
dust-free as possible.
Clean the mouse once a month to keep it running efficiently:
1. Turn the mouse upside down, and rotate the black plastic
dial counterclockwise as far as it will go.
2. Holding one hand over the ball and dial to catch them, turn
the mouse right side up. (See Figure 6-2.)

The dial and the ball will drop into your hand.
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Figure 6-2
Disassembling the mo use
3. Inside the case are two plastic rollers, similar to those on a
tape recorder. Using a cotton swab moistened with alcohol
or tape head cleaner, gently wipe off any oil or dust that has
collected on the rollers, rotating them to reach all surfaces.
(See Figure 6-3.)
4. Wipe the ball with a soft, clean, dry cloth.

Don't use tissue or anything that may leave lin t, and don't use a
cleaning liquid.

Figure 6-3
Cleaning the mouse

The m ouse
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5. Blow gently Into the case to remove any dust that has
collected there, or use a low-powered vacuum cleaner.

Portable car vacuums are ideal.
6. Put the ball back Into its case, and lining up the Indicator on
the dial with the 0 on the back of the case, reinsert the dial
and turn it clockwise as far as it will go.

It will dick when fumly in place.

Disks
I..

, UJll
50°F (10°C)

Although Apple 3.5-inch disks are pretty rugged, they do have a few
modest physical requirements-about the same as audio cassette
tapes have. Your disks should be kept dry, away from extreme
temperatures (don't lay them on top of your computer or store
them on the seat of your car), out of direct sunlight, and out of
reach of anything that contains a magnet, such as a telephone.
(Magnetic fields can scramble the information on the disk.)
When the disk is inserted into the disk drive, the metal covering on
the disk case slides out of the way so the computer can get
information from and save information onto the disk. When the
disk is out of the disk drive, the metal covering doses by s pring
action to protect the disk underneath it. Never touch the exposed
disk under the metal covering.
Other than that, you don't have to treat disks especially carefully.
You can carry them around in your b riefcase or coat pocket or mail
the m to your aunt in Cooperstown. (Two fit nicely in a business
envelope.)
Be sure to make a copy of any disks you can't do without. (See
"Copying an Entire Disk" in Chapter 3.) It's no fun losing a report
the night before you were going to make final corrections.
You can purchase disks in a 10-pack from your authorized Apple
dealer.
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The clock boHery

-

Your computer has a clock that runs continuously, even when the
computer is switched off. (Choose Alarm Clock from the Apple
menu to see it.) When the computer is off, the clock runs on battery
power. There are two batteries, and they will probably last about
e ight years. If the computer system fails to start or the dock begins
to lose accuracy, see your deale r for a replaceme nt.

Service and support
To help you get the best performance from your computer system,
Apple Computer has established a worldwide network of fullsupport Apple dealers. If you need answers to technical questions or
information about product updates, your Apple dealer can help
you. Apple's Technical Support organization backs each deale rship
to e nsure prompt and reliable assistance.

-

If service is required on your compute r, take it to your authorized
Apple dealer. Each authorized Apple dealer is re quired to employ
Apple-trained service technicians and to use Apple parts in
performing repairs. If you have moved, take your computer to the
nearest authorized Apple dealer. The re are more than 3,000
authorized Apple dealers in the United States alone. For the
authorized Apple deale r nearest you in the United States, call (800)
538-9696; in Canada, (800) 268-7682. Or, if you prefer, write to
Apple Compute r, Inc.
Attn: Custome r Relations
20525 Mariani Avenue
Cupertino CA 95014
Apple also offers the Apple Care® Service Agreement, which keeps
your warranty protection in force for up to three years. Apple Care is
one o f the lowest priced service plans in the industry, and your
Apple Care agreement w ill be honored at all participating
authorized Apple dealers w ithin the country of purchase-an added
benefit if you re locate. Local service means time saved in getting
your Apple system back to work.

Service and suppo rt
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You may purchase AppleCare at any time, but for uninterrupted
protection, it's a good idea to buy the Apple Care along with your
computer system (or within 90 days of the date you purchase your
system). In addition to providing you with complete coverage,
Apple Care purchased along with your computer avoids an ownerpaid inspection of your system if your warranty has expired.
Apple Care is available through your authorized Apple dealer.

If something goes wrong
If your computer stops working, try the suggestions in Table 6-1; if it
still doesn't work, take it to your authorized Apple dealer. See
"Troubleshooting Your SCSI Hard Disk" in Appendix A for help
with hard disk problems.
Warn ing

Any time you detec t a serious problem wit h the o peration of
your computer, unplug the power cord. This is the easiest way
to turn off the power in an emergency. Contact your
authorized Apple d ealer to diagnose and correct p roblems.

Table 6-1
Troubleshooting
Symptom

What's probably wrong

What to do

The screen is dark.

The monitor or computer
isn't getting power, or
the brightness or contrast
controls are turned· way down.

Check the brightness and contrast
controls on the monitor; adjust them to
make the screen brighter. Make sure the
computer is turned on and the power
cord is firmly attached to both the
main unit and the wall outlet. If the outlet
is controlled by a wall switch, see that the
switch is on. If the outlet is controlled by a
dimmer switch, use a differe nt outlet.
(See your monitor's manual.)
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Symptom

What's probably wrong

What to do

\X!hen you insert a
disk, the screen is
b right, b ut the
desk top doesn 't
a ppear.

When you start up the
computer or insert a disk,
the co mputer presents one
of several icons that give
you information about
itself or the disk you inserted .
Each icon gives you information
about p ossible prob le ms.

The question mark means
the compute r is switched
on and ready fo r you to
insert a startup disk.

111 ;11~

The "happy Macintosh"
me ans e verything's fine
to this point.

II'.!J

An X usually means the disk

IIIXIJI·,·.

you inserted to start up the
compute r isn't a startup d isk.
It can also mean the disk
is damaged. Use the power
switch on the back of the
main unit to sw itch off the
computer and try restarting
with a differe nt disk.

-

1===1

1

The "sad Macintosh"
appe ars whe n the compute r
can't go any fu rthe r because
of a prob le m with the
system software. Sometimes
this indicates a hardware
proble m. See you r deale r.
You may have to eject the
disk manually and unplug
the system.
A dialog box w ith a
bomb icon appears.

There's a serious proble m with
the softwa re.

'lhe e rror codes presented in the dialog box
are very te chnical and, unless you're an
expert, won't mean much. Try clicking
the Restart button in the dialog box
(restarting the compute r with the same
disk). If the p roble m occurs again, abando n
that disk and try a different copy of the
software.

If something goes wrong
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Symptom

What's probably wrong

What to do

Moving the mouse
has no effect on the
pointer.

The mouse might not be firmly
connected. If the mouse is
connected to the keyboard, make
sure the keyboard itself is
plugged in. If the connections are
good, the mouse may not be
working properly.

Is the mouse firmly connected to the
computer? Is it moving on a smooth, clean
surface? Does the mouse need cleaning?
(See "The Mouse" earlier in this chapter
for instructions.) If the problem doesn't
seem to be with the mouse, check the
software by first restarting the computer,
then trying another disk. If there seems to
be a software problem you can't solve by
restarting or by trying another disk, tell your
Apple dealer about it.

...

You might be in a situation that
doesn't allow typing. (For
example, while in MacPaint you
have to select the tool for entering
text, or typing won't work.) The
keyboard connection might be
loose, or the keyboard broken.

Make sure you're in a situation that allows
typing. Use the Key Caps desk accessory
to check each key. Make sure the
keyboard is connected securely. Open an
information window and try typing there. If
this doesn't help, see your Apple dealer.

....,

There are several conditions that
might cause this problem:
o The disk is not formatted.
o The disk is full.
o The disk is locked.
o The disk drive isn't working.

Usually a message appears in a box
describing the exact problem. If not, take
the following steps: Eject the disk and see
if the plastic tab is in the locked position.
Of you can't eject it in the usual way, see the
next part of this table.) Reinsert the disk.
Check to see if there's room for more
information on the disk by selecting the disk
and choosing Get Info from the Finder's
File menu. Try using a different disk.

~

Typing on the
keyboard produces
nothing on the
screen.

You can't save
anything on a disk.

If you still have trouble saving anything,
the disk drive probably isn't working
correctly. Take the computer to your
Apple dealer for help.
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Symptom

What's probably wrong

What to do

You can't eject
the disk.

Your computer can't get the
information it needs to eject the
disk in the usual way.

Choose Shut Down from the Special menu.
Then hold down the mouse button while you
press the Power On key. This should eject
the disk. If not, fmd the small hole to the
right of the disk drive. Insert a
straightened paper clip or similar small
object and push. This ejects the disk
if all else fails.

The air vents on the sides and top
The computer shuts
Check the clearance around the air
vents, and remove anything blocking the
down without warning. of the main unit may have been
blocked or covered in some way,
flow of air to the ventilation system. Also
causing the system to overheat.
check the ambient temperature. Give the
(Or the room temperature may
computer time to cool down (at least half
have been too high.) Thermal
an hour), and try starting it again.
protection circuitry may have
shut down the computer to prevent
damage to the hardware.
The fan seems to be
noisier than usual.

If the computer is heating up,
the fan will work harder.

Check the clearance around the air
vents, and remove anything blocking
the flow of air to the ventilation system.
Also check the ambient temperature and
do what you can to cool the room you're
working in. If it is not possible to lower
the temperature, turn off the computer.

_,...
General symptoms and cures
If none of these specific symptoms or cures seem to fit, consider the
three general ways in which your computer could be ailing:
o The application you're using could have failed to run properly
just this once after it was copied from the disk into memory.
o The disk you're using has damaged files on it.
o The computer is on the blink.

If something goes wrong
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If you've checked the specific symptoms in this chapter and you still

can't get any response from your computer, try turning it off briefly
and then on again. If this works and this time you're able to
complete what you tried before, it was just a glitch. (That's a
technical term.) If you find yourself in the same dilemma after
restarting the computer, the problem is with the disk (possibly your
hard disk if it's the current startup disk). Try another disk (one
without any valuable documents on it, so you don't risk losing
them).

'\

-,

Miscellaneous software problems
You can avoid many software problems by always keeping each of
your startup disks current with the latest system software. See "Using
the Installer" in Chapter 3. If you have the same problem with all
disks, the computer most likely has a problem. Take it to your Apple
dealer.
Some applications might require their own customized system files
to work properly. In this case, hold down the Option key while you
double-click the application to force the computer to switch to
another startup disk. This is espedally useful if you're using a hard
disk. See "Startup Disks" in Chapter 4.
Some applications use data files (such as help files) that must be kept
together in one folder. If you drag that folder from a one-sided disk
to a disk that's initialized two-sided or a hard disk, the application
may not be able to find the data files. Try moving the data flles to
the same folder as the application.
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Appendix A
Working With Hard Disks

A hard disk lets you work more quickly and more efficiently. You
work more quickly w ith a hard disk because it transfers information
to and from your computer's main memory faster than a 3.5-inch
disk does; you don't have to wait for your disks to catch up with you
when you store or retrieve information. You work more efficiently
with a hard disk because you can store large amounts of information
on it-from 25 to 100 times as much as you can store on a 3.5-inch
disk, depending on your hard disk's capacity.

1

n

You work with a hard disk and a 3.5-inch disk in the same way; how
you open a disk, copy programs and data, and organize
information in folde rs is identical. In fact, the only real difference
is that you can't eject a hard disk. You can think of a hard disk as an
oversized disk that always stays in its drive. (See "Getting the Most
Out of Your Hard Disk" later in this appendix.)
To prepare your hard disk, you need to initialize it. Then, to make it
a startup disk (so that starting your system is automatic), you need to
install the system software.
•!• External hard disk users: Setting up an external hard disk is

nearly the same as setting up an internal hard disk. The only
differences are that, with an external hard disk, you need to
attach the hard disk to the computer and you need to plug the
hard disk into a power source. See the manual that came with
your external hard disk for details.
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Using the hard disk installer
The hard disk Insta ller Is
identified b y the Apple HD
SC Setup Icon In the
Utilities Folder.

-

Initializing your hard disk
Initializing a hard disk prepares the disk to store information and
installs a file called Driver Resource, which contains a program that
tells your computer how to work with the disk.
Important

-

-

You use the hard disk installer to initialize your hard disk, update
your disk when you get new hard disk resources, and do regular
mainte nance testing.

Someone may have already prepared your hard d isk for you. If
that's the case, you probably won't want to Initialize the hard
disk again; relnitiallzlng a disk wipes o ut any information already
stored on it.
To see If your hard disk has already been prepared . choose
Restart from the Special menu. (If you have an external hard
disk, switch It on and wait about 10 seconds before choosing
Restart.) Any 3.5-inch disks will be ejected from the d isk drives.
and your computer will reset itself and then t ry to restart.
If the hard disk is already prepared. In a few seconds you'll see
the Macintosh II Finder. You can skip to "Getting the Most Out
of Your Hard Disk:
If you see a question mark on the d isplay for more than a
second o r two. you need to prepare the hard d isk. Read on.

Here's how to initialize your hard disk:
1. Shut the computer off using Shut Down from the Special
menu.
2. Insert the System Tools disk into the right-hand drive.
3. Restart the computer by pressing the Power On key at the
top of the keyboard.
4. Select the System Tools icon, and open it by choosing
Open from the File menu or double-clicking the icon.
5. Select the Utilities Folder Icon, and open it by choosing
Open from th e File menu or double-clicking the icon.

Using the hard disk installer
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Among other icons, you see the Installer and Apple HD SC
Setup .
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Utilities Folder

6. Select the Apple HD SC Setup icon, and open it by
choosing Open from the File menu or double-clicking the
icon.

The Apple HD SC Setup dialog box appears:

Appl e HO SC Setup
( Initi ali ze J

UI . I

SCS I Oeuice: 0

Update
Or iu e
Tes t
Quit

Figure A-2
Apple HD SC Setup dialog box
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•!• Multiple hard disk users: If you're setting up an external hard
disk and you have at least one other external SCSI hard disk,
make sure that the device priority number in the dialog box
matches the priority switch number that appears on the back of
your hard disk. The internal hard disk (if you have one) is
priority number 0. See "Drive" in the next section for more
information.
7. Click Initialize.

Another dialog box comes up, giving you a chance to change
your mind; it warns you that the initialization process erases
the whole disk.
8. Click OK to start the process.
As the hard disk begins operating, various messages appear on

the display, explaining what's going on in the meantime. The
initialization process will take about 10 minutes for a
20-megabyte drive.
9. Name the disk.

When initialization is over, a dialog box comes up, asking you
to give your hard disk a name. The name can have up to 27
characters, including spaces. You can use any character except
the colon (:).
10. Click Quit.

Using the hard disk installer
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You return to the Finder, and you see the Hard Disk icon on the
right side of the desktop with the name you've given it.
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Hard Disk Icon on the d esktop

Other hard disk installer functions
The dialog box in Figure A-2 has fou r other buttons besides
Initialize. You already know about the Quit button; the other
three-Update, Test, and Drive- let you perfo rm maintenance
functions on your hard disk.

Update
Click the Update button to install an updated resource on the hard
disk. (From time to time, Apple Computer releases improved
versions of software; your authorized Apple dealer can tell you when
an updated resource becomes available.) Updating your hard disk
software lets you get improved performance without any risk to the
information already stored.
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You also use this function to reinstall the resource if you have
certain kinds of problems with the hard disk. See "Troubleshooting
Your SCSI Hard Disk" later in this appendix.
Test

Click the Test button to start a test of your hard disk. The test takes
about 4 minutes (for a 20-megabyte drive) and checks to make sure
your hardware is working properly. (It doesn't check any software,
and it has no effect on information you've stored on the disk.)
You can run the test any time you want. In fact, it makes sense to run
this test once a month or so to make sure that everything is working
OK. (Sometimes this test can spot a problem before it becomes
obvious, and before any of your data is affected.)

-

If your hard disk fails the test, immediately copy any files you
haven't backed up yet. Then try to reinitialize and retest your hard
disk. If it fails the test again, run Disk First Aid. (You'll find
instructions for runnning this application in the Mactntosh System
Uttltttes User's Gutde.) If it still fails, stop using the hard disk and
contact your authorized Apple dealer. (If the dealer has to work on
the disk, all your files will be erased in the process.)
Drive

Click the Drive button when you want the Macintosh II to search for
the next available disk drive. In other words, this button serves the
same purpose as the Drive button on directory dialog boxes you see
frequently.

•!•

If you have a non-Apple SCSI disk drive: The Drive function
will not include any non-Apple SCSI disk drives in the search.
The updates to system software you will be installing cannot be
guaranteed to work on all third-party hardware.

When you click Drive in this dialog box, the system will tell you the
device priority number for each device it finds. This is simply for
your information; you cannot change the device priority from this
dialog box.

Using the hard disk Installer
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Installing system software
Making your hard disk a startup disk lets you start your computer
without putting a 3.5-inch disk into the drive. You can make your
hard disk a startup disk by installing system software on it.
To install system software on you r hard disk, you have a choice of
two procedures:
o With the computer turned off, inse rt the System Tools disk into a
3.5-inch drive. Then press the Power On key. Open the System
Tools disk icon and then open the Installe r icon (in the Utilities
Folder), and bri ng up the Installer dialog box. Select Macintosh
II Installation and click Install. The advantage of this p rocedure is
that the installation w ill include only the resources re qu ired for
your Macintosh II.

,

-

o Drag the System Folder from the System Tools disk to the hard
disk.
If you're using more than one external hard disk with a System file,
be sure to set the proper startup device in the Control Panel. See
"Using the Control Panel" in Chapter 3.
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Getting the most out of your hard disk

-

While you can approach using your hard disk as though it were a
3.5-inch disk, there are certain precautions you s hould take:
•

Organize your files carefully.

Hard disks let you keep large numbers of applications,
documents, and other files a mouse-dick away. Without careful
organizing, you can scatter your files all over the place. Be sure
to organize your files into folde rs in a way that makes your job
easiest. And if you happen to misfile a docume nt or application
in the wrong place, use the Find File desk accessory to help you
locate it. (See "Using Find File" in Chapter 3.)
• Always choose Shut Down (from the Special menu in the
Finder) to tum off your computer.

When you choose Shut Down, the computer is able to put
everything away safely before it turns itself off.

-

Turning off the compute r by anothe r means (such as pushing the
power switch) while the hard disk is working can cause the disk to
lose information. Sometimes it can damage the disk directory. If
this happens, try using the Disk First Aid program. If that doesn't
he lp, you'll have to reinitialize the hard disk-and in the process
lose all the information on the disk.

-

-

•

Back up everything.

Some people back up information s tored on their hard disks
weekly; more prudent people back up the ir work on a daily basis.
The important thing is to make backup copies regularly. Hard
disks are reliable, but accidents do happe n. Copy individual
docume nts from the hard disk to a 3.5-inch dis k manually. Use
the Hard Dis k Backup program described in the Macintosh
System Utilities User's Guide to back up large groups of
documents.
• Shut off your hard disk when you're not using it.

Mechanical things tend to wear out fas ter than e lectronic things.
Your hard disk contains mechanical devices that are always in
motion. While your hard disk has been designed to give you
thousands of hours of trouble-free use, you can extend its life

-

-

Getting the Most out of Your Hard Disk
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considerably if you shut it down when you're through using it for
the day (that is, if you expect to be away from it for eight hours
or so).
Your hard disk is part of an integrated computer system (even if
your disk is an external one), so shut down the whole system
rather than just the hard disk. (Of course, if you have an internal
hard disk, you must shut off the main unit to shut off the hard
disk.) You needn't bother shutting off the system if you'll be using
it again within a few hou rs.

Adding SCSI terminators
Terminators are sandwichlike devices that fit
between a SCSI cable and
a SCSI device, or between
two SCSI connectors.
There must be no more
than two terminators In a
SCSI chain: one at the
start of the chain, and one
at the end.

l-Iard disks and other devices connected to the SCSI port on the back
of the main unit must have the proper number of terminators for
the devices to work correclly and to prevent damage to the SCSI
chip inside your computer.
Whether or not you need (or don't need) a terminator can be
confusing. Sometimes there is a terminator inside a SCSI device
where you can't see it, as with an Apple internal hard disk. (A
device's documentation will tell you if it has a terminator.) And
sometimes the 18-inch cable that you need to connect external
devices to the SCSI connector acts as a terminator. Find the
situation that applies to you in the following list. In all cases, it's
assumed that you're using Apple's 18-inch SCSI cable to go from
your computer to the first SCSI device.

o Internal hard disk to a single external Apple device. Add a
terminator between the SCSI cable and the SCSI connector o n the
external Apple device.

1______._~--~!
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.

Figure A -5
Connecting an Apple device to a hard disk

234

Appendix A: Working With Hard Disks

-

-

o Internal hard disk to multiple external Apple devices. Add a
terminator between the SCSI cable and the SCSI connector on lhe
last device in the chain.

Figure A-6
Connec ting multiple Apple devices to a hard disk

o No internal hard disk to a single external Apple device. Add a
terminator between the SCSI cable and the SCSI connector o n lhe
external Apple device.

-

,- ,
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Figure A-7
Connecting an Apple device to a
Macintosh II without a hard disk

-

o No internal hard disk to multiple external Apple devices. Add a
termi.n ator between the SCSI cable and the SCSI connector on lhe
first external Apple device in the chain; then add a terminato r
betwee n the SCSI cable and lhe SCSI connector o n the last device
in the chain.

-

-

-

Figure A-8
Connecting multiple Apple devices to a Macintosh II
without a hard disk

Adding SCSI Terminators
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1
o Internal hard disk to a single external non-Apple device. If the
external device does not have a built-in terminator, add a
te rminator between the SCSI cable and the external device's SCSI
connector. If the device has a built-in terminator, you don't
need to add one.

l

Figure A-9
Connecting a non-Apple device to a hard disk

1

o Internal hard disk to multiple external non-Apple devices. If
none of the devices has a built-in terminator, add a terminator
between the SCSI cable and the SCSI connector on the last device
in the chain. If one of the devices in the chain has a built-in
terminator, place that device at the end of the chain and don't
add any terminators.

II
I

I

I

I

I
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Figure A-10
Connec ting multiple non-Apple d evices to a hard disk
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o No internal hard disk to a single external non-Apple device. If
the external device does not have a built-in terminator, add a
terminator between the SCSI cable and the external device's SCSI
connector. If the device has a built-in terminator, you don't
need to add one.

l
l
I

I

-
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Figure A- 11
Connecting a non-Apple device to a
Macintosh II without a hard disk

o No internal hard disk to multiple external non-Apple devices. If
none of the devices has a built-in te rminator, add a terminator
between the SCSI cable and the first non-Apple SCSI device in the
chain. Then add a terminator between the last cable and the SCSI
connector on the last device in the chain. If one of the devices in
the chain has a built-in terminator, place that device at the end
of the chain and e liminate the second terminator.
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Figure A- 12
Connecting multiple non-Apple devices to a Macintosh II
without a hard disk
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Warn ing

You can have no m ore than two terminato rs In the entire SCSI
chain . More than two te rminators In the c hain may damage
yo ur computer. If more than one of the non-Apple devic e s in
the c hain has a built-In terminator, remove that terminat o r or
have your Apple dealer remov e it. Check the manual tha t
c ame with the devic e to be sure.

,...,

Troubleshooting your hard disk
From time to time, you might expe rie nce some problems with you r
hard disk. Here are some common symptoms and what to do about
them. For more symptoms and cures associated w ith an external
hard disk, see the manual that came with your disk.
•

The Hard Disk icon doesn't appear on the Finder desktop.

o Your hard disk might not be initialized.
o All exte rnal hard disks must be turne d on and running for at
least 10 seconds before your computer is switche d on.
o The hard disk resource might be damaged . To find out:
1. Insert the Sy stem Tools disk.

2. Run the Apple HD SC Setu p application.
3. Click Update.
4. Whe n the setup is comple te, click Quit.
If the resource was the problem, the Ha rd Disk icon should
appe ar on the desktop.
o If the ha rd d isk you 're having trouble w ith is a startup disk, the
Syste m file on the hard disk might be da maged. To find out:

-

1. Choose Shut Down from the File me nu.
2. Insert the System Tools disk.

3. Restart the compute r.
4. Open the System Folder on the System Tools disk.
5. Drag the System file from the System Tools disk to the
System Folde r on the hard disk, re placing the potentially
damaged file. (You may lose some fonts and desk
accessories, but you can recopy the m easily using Font!DA
Move r.)
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6. Eject the System Tools disk by choosing Eject from the File
menu.
7. Choose Restart from the Special menu.
If the System file was the problem, the Hard Disk icon should
appear on the desktop. However, this procedure can cause
you to lose some fonts and desk accessories that were in your
original System file.
o You might have lost power while the hard disk was in use. If so,
try using the Disk First Aid program to recover. As a last
resort, contact your authorized Apple dealer.
• An application In a folder won't open.

Move the program out of the folder onto the desktop and try
again.
• When you select the Apple HD SC Setup icon, you see the
message "Drive selection failed. n

An external hard disk isn't connected properly or it isn't switched
on. See "Getting the Most Out of Your Hard Disk" earlier in this
appendix for information about connecting SCSI devices. Make
sure that terminators and cables are seated properly.

Troubleshooting your hard disk
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Appendix B
Macintosh II Specifications

Processor

MC68020, 32-bit architecture, 15.6672 MI-Iz
clock frequency

RAM memory

1 MB, expandable to 8 MI3 on board;
expandable to 2GB in NuBus slots

ROM memory

256K (standard)

Coprocessor

68881 floating-point device (IEEE standards)

Memory
management
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Software, optional 68851 PMMU (Paged
Memory Management Unit)

3.5-inch disk

BOOK per formatted double-sided disk, hardshe ll media (second unit optional)

Hard disk

Options include 20 MB, 40 MB, and 80 MI3
SCSI hard disks, internal and/or external

Monitors

Options include 12-inch, 640-by-480-pixel
monochrome; 13-inch, 640-by-480-pixel
RGB

Interfaces

Two 8-pin mini-circular serial (RS-422) ports,
one DB-25 SCSI port, two Apple DeskTop Bus
(ADB) ports, six NuBus internal slots
supporting full 32-b it address and data lines

-

,....

,...
~

~

....

Sound generator

Apple custom sound chip (ASC) including
4-voice wave-table synthesis and stereo
sampling generator capable of driving stereo
mini-phone jack headphones or stereo
equipment

Input voltage

90 to 140 VAC and 170 to 270 VAC, automatically configured

Frequency

48to62 Hz

Max power

230 watts, not including monitor power

Mouse

Mechanical tracking, optical shaft encoding
3. 54 pulse per mm (90 pulse per in) of
travel

Operating
temperature

10° C to 35° C (50° F to 95° F.>

Storage
temperature

-40° C to 47° C (-40° F to 116.6° F.>

Relative humidity

5% to 95% (noncondensing)

Altitude

0 to 3048 m (0 to 10,000 ft)

,..,

-..
....

...

-

Weight

Height

Width

Depth

Main unit

10.9 to 11.8 kg
(24 to 26lb)

140mm
(5.51 in)

474mm
(18.66 in)

365mm
(14.37 in)

Apple Keyboard

1.0 kg
(2lb 4 oz)

44.5 mm
(1.75 in)

418.3 mm
(16.5 in)

142mm
(5.6 in)

Mouse

.17kg
(6 oz)

27.9 mm
(1.1 in)

53.3 mm
(2.1 in)

96.5 mm
(3.8 in)

1.6 kg

Apple Extended
Keyboard (optional)

(3 lb 10 oz)

56.4 mm
(2.25 in)

486mm
(19.125 in)

188mm
(7.4 in)

Apple High-Resolution
Monochrome Monitor

7.7kg
(17 lb)

255mm
(10.04 in)

310mm
(12.2 in)

373mm
(14.68 in)

Apple High-Resolution
RGB Monitor

15.45 kg
(34 lb)

281mm
(11.06 in)

344mm
03.54 in)

402mm
(15.83 in)

~
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Appendix C
Expansion Cards and
Power Requirements

There are limits to the amount of electrical power available for the
six expansion slots in the main unit of your Macintosh II. Under
most circumstances, this should not create a problem . H owever, if
you plan to install several cards, it is a good idea for you to take time
to assess the power requirements for the combined ca rds. Installing
a group of cards that make excessive demands on avail able power
may cause damage to one or more cards or to the compu ter itself.
forewarned i s forearmed.
There are three k inds of current from which a card can draw power.
They are iden tified as

-

n

o +5V bus current
o +12V bus current
o - 12V bus current
Each card w ill draw power from these sources in varying
combinations and in varying amounts, but that in itself w ill not
cause a problem. You need to determine the requ irements of each
of your cards, add those numbers together, and verify that the
totals do not exceed the limits. Table C-1 defines those limi ts.
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Table C-1
Power limits
Type of current

Recommended total for all six slots

+5V bus

12.8 amps

+12V bus

1.3 amps

-12V bus

1.0 amps

In order to calculate total power requirements, you'll have to
identify the specifications for your cards. You should be able to find
that information on the package or in the instructions that came
with each card. Once you know how much power is required (and
from which type of current), you can add up the figures and
determine whether your cards as a group may exceed the limits.
For example, assume you have four cards with these requirements:
o +5V bus

8 amps total for four cards

o +12V bus

.7 amps total for four cards

o -12Vbus

.632 amps total for four cards

These totals are all within the limits, and you can safely install all
four cards. However, if you should purchase two more cards, you
will have to add in their requirements to be sure that the totals are
still acceptable.

Appendix C: Expansion Cards and Power Requirements
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active window: The frontmost window on the desktop; the window
where the next action will take place. An active window's title bar is
highlighted.

r

Alarm Clock: A desk accessory that displays the curre nt date and
time.
Apple DeskTop Bus: The set of connectors on the back of the mai n
unit that you use to attach the keyboard, mouse, and other Apple
DeskTop nus devices (such as ha nd graphics tablets, hand conuols,
and specialized keyboards).

-

-

Apple key: A key that, when held down while another key is pressed
or a mouse action is performed, causes a command to take effect.
Sometimes called the command key.
Apple menu: The menu on the far left in the menu bar. Its title is
an Apple symbol.
application program: A tool to mani pulate information and help
you perform your work. Sometimes called an application or a
program.
attributes: Info rmation associated with text you type. Text
atlributes include the size and style as well as the font you choose.
bridge: A device that lets you connect ApplcTalk networks together.
See also zone.
button: The places in dialog boxes where you click to designate,
confirm, or cancel an action. See also mouse button.
Calculator: A desk accessory that works like a four-fu nction pocket
calculator. You can cut and paste calculation results into you r
documents.
~~

Cancel button: A button that appears in dialog boxes. Clicking this
buuon cancels the command.
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caps Lock key: A key that, when engaged, causes subsequently
typed letters to appear in uppercase. It works like a Shift key except
that it doesn't affect numbers or symbols.
character keys: The keys on the Macintosh II keyboard for letters,
numbers, symbols, punctuation, Return, Tab, and the Space bar.
check box: The small box or circle associated with an option in a
dialog box that, when clicked, adds or removes the option.
choose: To pick a command by dragging through a menu. Usually
you do this after you've selected something for the computer to act
on.
Chooser: A desk accessory that lets you configure your Macintosh II
system to print on any printer for which there's a printing resource
on the current startup disk. If you're part of an AppleTalk network,
you use the chooser to connect and disconnect from the network
and to choose among devices connected to the network. You can
also specify a user name that the Macintosh II shows when you're
using a network resource-when you're printing on a LaserWriter,
for example.
click: To position the pointer on something, then press and quickly
release the mouse button.

CUpboard: The holding place for what you last cut or copied.
close: To turn a window back into the icon that represents it.
close box: The small white box on the far left side in the title bar of
an active window. Clicking a close box closes the window.
command: A word or phrase, usually in a menu, describing an
action for the computer to perform.
Control Panel: A desk accessory you use to personalize your
computer to your own way of doing things. Use the Control Panel to
change the speaker volume, set the clock, create a RAM cache, and
set many other preferences.
copy protect: To make a disk uncopyable. Software publishers
frequently try to copy protect their disks to prevent them from being
illegally duplicated by software users.

~

current startup disk: The startup disk whose system files the
Macintosh II is currently using. See also startup disk.
cut: To remove something by selecting it and choosing Cut from
the Edit menu. What you cut is placed on the Clipboard.
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daisy chain: A group of devices linked together sequentially. See
also Apple DeskTop Bus.
(---~

I k"•;r

_!

Delete key: A key that removes the current selection or moves the
insertion point backward, removing the previously typed character.
desk accessories: "Mini-applications" that are available on the
desktop from the Apple menu regardless of which application
you're using. Examples are the Calculator, Alarm Clock, and
Scrapbook.

-

desktop: Macintosh's working environment-the menu bar and the
gray area on the screen.

L

~---

dialog box: A box containing a message requesting more
information from you. Sometimes the message is a warning that
you're asking your computer to do something it can't do, or that
you're about to destroy some information. In these cases, the
message is often accompanied by an Alert Sound.
dimmed command: A command that appears dimmed in the
menu. You can't choose a dimmed command.
dimmed icon: An icon that represents a disk that has been ejected,
or a document, folder, or application belonging to a disk that has
been ejected. You can select and open dimmed disk or folder
icons, but you can't open the documents and applications on them.
directory: A pictorial, alphabetical, or chronological list of the
contents of a folder or a disk.
directory window: The window that shows you the contents of a
disk.
disk: The magnetic medium on which the computer stores
information. Your computer can use a 3.5-inch disk or a hard disk.
disk drive: The mechanism that holds the disk, retrieves
information from it, and saves information on it. A hard disk drive
has the disk permanently encased. A 3. 5-inch disk drive requires
that you insert a 3. 5-inch disk.
document: Whatever you create with Macintosh II applicationsinformation you enter, modify, view, or save. See also file.
double-click: To position the pointer where you want an action to
take place, and then press and release the mouse button twice in
quick succession without moving the mouse.

.....
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drag: To position the pointer on something, press and hold the
mouse button, move the mouse, and finally release the mouse
button. When you release the mouse button, you either confirm a
selection or move an object to a new location.

driver: See resource.
encer

Enter key: A key that confirms or terminates an entry or
(sometimes) a command.
expansion slot: A connector inside the Macintosh II's main unit
that lets you install expansion cards to enhance the computer's
performance.

me: A collection of information stored on a disk-a document, a
system me like the System file or Finder, an application, and so on.

.-,

file server: A combination of controller software and a mass
storage device that allows computer users to share common files
and applications through a network.

I

Finder: An application that allows access to documents and other
applications. You use it to manage documents and applications,
and to get information to and from disks.
Find File: A desk accessory that lets you find any folder or file on
the disk. It will also show you where in the hierarchical flle system it
found what you wanted

0

folder: A holder of documents, applications, or other folders on
the desktop. Folders allow you to organize information in any way
you want
font: A collection of letters, numbers, punctuation marks, and
other typographical symbols with a consistent appearance. An
example of a font is Geneva.
Font/DA Mover: A utility program that lets you add fonts and desk
accessories to your System file.
hard disk: A disk drive that has the disk permanently encased. See
also disk drive.

'

'

~
I

hard disk installer: A utility program that lets you initialize your
hard disk, update your disk when you get new hard disk resources,
and do maintenance testing. The hard disk installer is identified by
the Apple HD SC Setup icon in the Utilities Folder.
hardware: Anything about the computer that you can see or touch.

,-,
I
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hierarchical file system: A way of using folders to organize
documents, applications, and other folders on a disk to organize
and look at related information. Folders (analogous to
subdirectories in other systems) can be nested in other folders to
create as many levels of a hierarchy as you need. Opening a folder
presents only the information you've put into that folder, so you
can concentrate on that information without viewing everything on
the disk.
highlight: To make something visually distinct from its
background, usually to show that it has been selected or chosen.
~(

1-bea.m: A type of pointer used in entering and editing text.

icon: A graphic representation of an object, a concept, or a
message. Icons are often objects associated with the Finder.
information window: The window that appears when you select an
icon and choose Get Info from the File menu. It supplies
information such as size, type, and date, and it includes a place for
adding notes.
initialize: To prepare a disk to receive information. You can
initialize BOOK disks on both sides or on just one side.

insertion point: The spot in a document where something will be
added. You select an insertion point by clicking. It's represented by
a blinking vertical bar.

Installer: A utility program that lets you choose an Installation
script for updating your system software.
kilobyte (K): A unit of measurement consisting of 1024 (210) bytes.
In this usage, kilo (from the Greek, meaning a thousand) stands for
1024. Thus 64K memory equals 65,536 bytes. See also megabyte.

local area network (IAN): A group of computers linked physically
by a network of communication cables.
lock: To prevent documents from being edited, discarded, or
renamed, or to prevent entire disks from being altered.
main unit: The computer console, which contains the processor,
co-processor, memory, the built-in disk drive(s), and an optional
SCSI hard disk.

megabyte (MB): A unit of measurement equal to 1024 kilobytes, or
1, 048,576 bytes. See also kilobyte.
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memory: The place in the computer's main unit that stores
information while you're working with it. The Macintosh II includes
at least 1MB of memory you can use for your work, and at least 256K
of ROM (read-only memory) that stores certain system information
permanently. See also random-access memory and read-only
memory.
menu: A list of commands that appears when you point to and
press the menu title in the menu bar. Dragging through the menu
and releasing the mouse button while a command is highlighted
chooses that command.
menu bar: The horizontal strip at the top of the screen that
contains menu titles.
menu title: A word or phrase in the menu bar that designates one
menu. Pressing on the menu title causes the title to be highlighted
and its menu to appear below it
mouse: The small device you roll around on a flat surface next to
your computer. When you move the mouse, the pointer on the
screen moves correspondingly.
mouse button: The button on the top of the mouse. In general,
pressing the mouse button initiates action wherever the cursor is
pointed or inserted. Releasing it confirms the action.
nest: To place folders inside other folders. See hierarchical file
system.
numeric keys: Keys on the right side of the keyboard that let you
do numeric entry and calculation quickly. Sometimes called a 10-

keypad.
open: To create a window from an icon so you can view a document
or directory.
option card: A card that contains electronic circuits that
implement specialized functions. Option cards are installed by
your dealer. Some examples are co-processors and accelerators.
See expansion slot.

...,
(

!

Option key: A key used like the Shift key to give an alternate
interpretation to another key you type. You use it to type foreign
characters or special symbols.
paste: To put a copy of the contents of the Clipboard-whatever
was last cut or copied-at the insertion point.

~
I

~

I
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peripheral device: A piece of computer hardware-such as a disk
drive, printer, or modem-used in conjunction with a computer
and under the computer's control. Peripheral devices are usually
physically separate from the computer and connected to it by wires
or cables.
pointer: A small shape on the screen, most often an arrow pointing
up and to the left, that follows the movement of the mouse.

-

port: A socket on the back panel of the computer where you can
plug in a cable to connect a peripheral device, another computer,
or a network.

Power On key: A key at the top of the keyboard used to turn on the
Macintosh II.
power switch: A switch located on the back of the main unit that
you can use to tum off the computer when the Shut Down command
is not available for some reason. This switch should not be used in
the normal course of events.

press: To position the pointer on something and then hold down
the mouse button without moving the mouse.
printing resource: A system file that lets you print on a
corresponding printer attached to the computer. Sometimes called
a printer driver.
RAM: See random-access memory.
RAM cache: RAM you can designate to store certain information an
application uses repeatedly. Using the RAM cache can greatly speed
your work, but may need to be used sparingly or not at all with
applications that require large amounts of memory. You set the
RAM cache in the Control Panel.

random-access memory (RAM): The part of the computer
memory that stores information temporarily while you're working
on it. RAM can contain both application programs and your own
information. Information in RAM is temporary, gone forever if you
switch the power off. An exception to this is a small amount of
memory used to save settings, such as the Alarm Clock and Speaker
Volume, that's powered by battery when your computer is switched
off. Compare read-only memory.
Read Me documents: Documents (included on application and
system software disks) that provide you with late-breaking
information about the product. You'll usually find Read Me
documents in the Update Folder on the disk.
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read-only memory (ROM): The part of memory that contains
information the computer uses (along with system flies) throughout
the system, including the information it needs to get itself started.
Information in ROM is permanent; it doesn't vanish when you
switch the power off. The Macintosh II contains at least 256K of
ROM. Compare random-access memory.

I~

resource: A me in a System Folder that tells the computer how to
work with a device. Sometimes called a driver.

[
[return _

Return key: A key that makes the insertion point move to the
beginning of the next line. It's sometimes used to confirm or
terminate an entry or a command.

ROM: See read-only memory.
save: To store information on a disk.
Scrapbook: A desk accessory in which you save frequently used
pictures and text.
scroll: To move a document or directory in its window so that you
can see a different part of it. You can also scroll the directory in
some dialog boxes.
scroll arrow: The arrow on either end of a scroll bar. Clicking a
scroll arrow moves the document or dire(:tory one line. Pressing a
scroll arrow scrolls the document continuously.
scroll bar: A rectangular bar that may be along the right or bottom
of a window. Clicking or dragging in the scroll bar causes the view of
the document to change.

~

scroll box: The white box in a scroll bar. The position of the scroll
box in the scroll bar indicates the position of what's in the window
relative to the entire document.
SCSI: An acronym for Small Computer System Interface;
pronounced "skuh'zee."
SCSI port: The port on the back of the main unit to which you
connect SCSI devices. See Small Computer System Interface.
select: To designate where the next action will take place. To select,
you click or drag across information.
selection: The information (including, but not limited to, the
insertion point) affected by the next command. The selection is
usually highlighted.
serial interface: An interface in which information is transmitted
sequentially, a bit at a time, over a single wire or channel.
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serial port: The connector on the back of the main unit for devices
that use a serial interface.
Shift-click: A technique that allows you to extend or shorten a
selection by holding down the Shift key while you select (or
deselect) something related to the current selection.
Shift key: A key that, when pressed, causes subsequently typed
letters to appear in uppercase and causes the upper symbol to
appear when number or symbol keys are typed.

...

size box: A box on the bottom-right corner of most active windows
that lets you resize the window. See also zoom box.
Small Computer System Interface (SCSI): An industry
standard interface that provides high-speed access to peripheral
devices.

software: Instructions for the computer to carry out. The computer
reads these instructions from disks inserted into the disk drive or
from a hard disk.

startup disk: A disk that contains the system flles the computer
needs to get itself started. A startup disk must have at least a Finder
and a System file. It may also contain flles such as printing
resources, Scrapbook, and Clipboard. Most people who have a
hard disk use it as the startup disk.

style: A stylistic variation of a font, such as italic, underline,
shadow, or outline.

system file: A file the computer uses to start itself up or to provide
system-wide information. Although system files are represented by
icons just as documents and applications are, they can't be opened
in the usual way. You can, however, alter the contents of system
flies. For example, you can use the Font/DA Mover to change the
contents of the System file or change the contents of the Scrapbook
or Note Pad files by using those desk accessories. See also startup

disk.
system software: The set of files and resources in the System
Folder that the computer uses to run itself.

System Tools disk: A disk that comes packed with the Macintosh
II. The System Tools disk contains important utilities you can use to
maintain and update your computer system and application disks.
1.'··-

Tab key: A key that, when pressed, moves the insertion point to the
next tab marker or, in a dialog box with more than one place to
enter information, to the next text box.
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TeachText: An application on the System Tools disk that lets you
read Read Me documents.
terminator: A device that fits between a SCSI cable and a SCSI
device, or between two SCSI connectors in a SCSI chain. Sometimes
these are built inside a SCSI device. There should be no more than
two terminators in a SCSI chain-one at the start of the chain, and
one at the end.
text box: The places in any dialog box where you can type
information.

,...,
\

.......
I

tide bar: The horizontal bar at the top of a window that shows the
name of the window's contents and lets you move the window.

I

Trash: An icon on the desktop that you use to discard documents,
folders, and applications.

Update Folder: A folder on the System Tools disk, and on other
application and system disks, that contains Read Me documents.
utillty program: A special-purpose application that alters a system
file or lets you perform some useful function related to a system file.
Examples are the Font/DA Mover and the Installer.
window: The area that displays information on the desktop. You
view documents through a window. You can open or close a
window, move it around on the desktop, and sometimes change its
size, edit its contents, and scroll through it.
word wraparound: The automatic continuation of text from the
end of one line to the beginning of the next. Word wraparound lets
you avoid pressing the Return key at the end of each line as you type.

~

wristwatch: The cursor icon that you see on the screen when the
computer is performing an action for which you have to wait.
zone: A network in a series of interconnected networks, joined
through bridges.

--,

zoom box: The small box on the right side of the title bar of some
windows. Clicking the zoom box expands a window to its maximum
size. Clicking it again returns the window to its original size. See also
size box.

!~
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A
About command (Apple me nu) 77,
180
accenLe d characters 149-150. See
also Key Caps
activating w indows 40-42, 86
/\clive button (Chooser) 96
active w indow 40-42
printing (with ImageWriter) 123,
192
adding
desk accessories 95
images to Scrapbook 111
air vents. See ventilation
alarm , setting. See Alarm Clock
Alarm Clock (Apple me nu) 76, 163
Alert Sou nd 50, 100, 106, 162
alig ning mo nito rs 104
AppleCare 2 17-218
AppleColor High-Resolution RGB
Monitor 102-104, 166,
206-207
Apple DeskTo p Bus 16-17
Apple DeskTo p Bus connectors 4,
16-17
Apple Deve lop er Services 208
Apple-E (eject disk) 136
Apple Extended Keyboard 3, 208,
2'i 1
Apple HD SC Setup 227- 231
Apple High-Resolution Monochrome
Mon itor 102-104, 166,
206-207
Apple key 150, 158
s hortcuts w ith 19 1- 192, 193
Apple Keyb oard 3, 24 1
Apple key equivalents 150,
191-192

Apple me nu 76, 95, 162- 170, 180
About command 77, 180
Alarm Clock 76, 163
Calculator 164
Chooser 96-97, 122, 16'i- 165
Control Pane l 98-106
Find File 107- 110, 167
Key Caps 149, 168
Note Pad 169
Scrapboo k 111- 112, 169-170
Apple-period (cancel command)
150, 19 1
Apple Pe rsonal Modem 206
AppleShare 20 1
Apple-Sh ift-1 (eject disk) 191
Apple-Sh ift-2 (eject disk) 19 1
Apple-Sh ift-3 (dump screen) 191
Apple-Shift-'i (print active window)
123, 192
AppleTalk ImageWriter printing
resource 165
AppleTalk option
(ImageWriter) 205
AppleTalk Personal Network 204
Chooser and 96-97, 165
zones a nd 97, 165
application dis ks 48
updating 77- 78
applicatio ns 22, 172, 196-202. See
also specific application
copying 11 8-119
dragging icons fo r 179
locking 121
manag ing documents
within 127-132
MiniFinder and 125-1 26
moving 11 6, 11 9

naming 117, 154-155
recovering 120
removing 120
renaming 117
s tarting 48-49
troubleshooting 222
unlocking 121
arranging work o n disks 158-159
arrow keys 147
arrow pointer. See pointer
assembling the system 6-19
attributes 161
8

backup copies 118-119, 138, 233
ballery, clock 217
blinking
insertion point, selling rate or 98
m enu , selling 99
blinking question mark icon 23, 27
bli nk ing vertical bar 49
bo mb icon 219
brightness control 2'i , 218
bus. See Apple DeskTo p llus
By Date command (View
menu) 187
By Icon command (View
menu) 73, 186
By Kind command (View
me nu) 187
By Name command (View
me nu) 73, 187
By Size command (View
menu) 187
lly Small Icon command (View
me nu) 186
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c
cables
keyboard 2, 15-17
mouse 15
SCSI 234-238
video 2, 12-13
Calculator (Apple menu) 164
canceling a drag 33, 35, 40, 85
Caps Lock-Apple-Shift-4 (print
screen) 123, 192
Caps Lock key 148
cards. See expansion cards or
specific card
care
of disks 216
of hard disk drive 213
of keyboard 214
of main unit 5, 18, 212-213
of monitor 213
of mouse 214-216
of screen 213
changing
Finder view 73
window size 37-39, 87
character keys. See keyboard
checking version numbers 77-78
Chooser (Apple menu) 96-97,
122, 164-165
choosing. See also Chooser
commands from menus 34-37
printer 122
startup device 106
cleaning
main unit 6
mouse 214-216
screen 6
Clean Up command (Special
menu) 188, 192
Clear command (Edit menu) 94,
185
Clear key 151
clicking (mouse technique) 31-32,
84
Clipboard 54-55, 160-161
clock battery 217
close box 36, 39, 45, 86, 87, 190
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Close command (File menu) 44,
87, 127, 128, 182, 192
closing windows 44-45, 87
Color button (Monitors, Control
Panel) 102, 103
color monitors 102-104, 166,
206-207
Command key. See Apple key
command(s)
About 77, 180
By Date 187
By Icon 73, 186
By Kind 187
By Name 73, 187
By Size 187
By Small Icon 186
choosing from menus 34-37
Clean Up 188, 192
Clear 94, 185
Close 44, 87, 127, 128, 182,
192
Copy 54-55, 93, 185
Cut 54-55, 93, 94, 185
dimmed 35
Duplicate 118, 183
Eject 136, 184
Empty Trash 120, 188
Erase Disk 134, 152, 188-189
Get Info 72, 78, 121, 182-183
Move to Desktop 110
New 114, 127
New Folder 58-59, 115, 181
Open 35, 114, 128-129,
181-182
Page Setup 124, 132, 183
Paste 55, 93, 185
Print 122-123, 132, 182
Print Catalog 124, 183
Put Away 120, 183
Quit 52
Restart 136, 189
Save 50-52, 56, 130, 145-146
Save As 56-58, 130-131
Search Here 108
Select All 90, 120, 185

Set Startup 189
Show Clipboard 185
Shut Down 4, 136, 189, 233
Undo 185
Use MiniFinder 125-126, 189
comment box. See Get Info
command
communications software 198
connecting
AppleTalk Personal Network 96
graphics tablet 16-17
joystick 16-17
keyboard 14-17
main unit power cord 6-7
monitor 7-14
monitor power cord 13-14
mouse 14-17
SCSI devices 234-238
video cable 12-13
connector(s)
Apple DeskTop Bus 4, 16-17
keyboard 15-17
SCSI 234-238
contrast control 24, 218
Control key 148
Control Panel (Apple
menu) 98-106
convergence pattern (Monitors,
Control Panel), testing 102,
103-104
coprocessor 240
Copy command (Edit menu)
54-55, 93, 185
copying
disks 138
images from Scrapbook 112
text 54-55, 93
to different disk 119
to same disk 118
copy-protected disks 48
creating
documents 49-50, 114, 127
folders 58-59, 115
MacPaint documents from
screen 191
startup disks 137

..,

...,
I

...
I

-

-

current startup disk 157-158
desk accessories and 95
switching 157-158
cursor keys 1'17
custom izing, startup disks 156-157
Cut command (Ed it menu) 54-55,
93, 94, 185
cutting text 54-55
D

daisy-chaining 15-17
date, setting 99. See also Alarm
Clock
Delay Until Repeat, setting 101
Delete key 49, 94, 151
shortcuts with 191
desk accessories 76, 95, 162-170,
180. See also FonrJDA Mover
adding 95
Alarm Clock 76, 163
Calculator 164
Choose r 96-97, 122, 164-165
Control Panel 98-106
Find File 107- 110, 167
Key Caps 119, 168
Note Pad 169
removing 95
Sc rapbook 111- 112, 169-170
desktop 29, 173
pattern, setting 98
troubleshooting 2 19
destination disk. See copying
device priority number 157, 23 1
hard disk drive and 229
devices, choosing. See Chooser
d iacritical marks 149- 150. See also
Key Caps
dialog b oxes 50- 5 1, 161-162
dimmed commands 35
dimmed icon 172
directory dialog box 177-178
directory w indow 36, 43-44 . See
also View menu
printing 12'1
discharging static e lectricity 8-9

disconnecting AppleTalk Personal
Network 96
disk(s) 151-159, 172. See also
BOOK disks; 400K disks; startup
disks or specific disk
appl ication 48, 77-78
arranging work on 158-159
care o f 216
copying 138
copy-protected 48
draggi ng icons for 179
ejecting 136, 172-173, 191,
193, 22 1
initializing 134-135, 151 - 153
lock ing 153-154
nam in g 117, 154- 155
renaming 117
startup 48, 77-78, 95, 137,
139- 140, 155-159, 232
troubleshooting 220
disk d irectory, printing 121
disk drives. See also hard disk
drive(s); 3.5-inch disk drive
order of precedence 157
troubleshooting 220
documents 22, 172. See also Edit
menu; icons; text
copying 11 8-11 9
creating 49-50, 114, 127
dragging icons fo r 60-61, 179
edi ting 52-55
lock ing 121
managing w ithin
applications 127-132
memory a nd 145-146
Min iFinder and 125- 126
m oving 116, 119
nam ing 56-57, 117, 13 1,
151-155
open ing 64-67, 114, 128-129,
145- 1'16
printing 122-123, 132
recove ring 120
re moving 120
re naming 117, 131
saving 50-52, 56-58, 67- 69,
130-13 1, 11 5-146
u nlocking 121

double-clicking (mouse technique)
43-44, 84, 85, 190
Double-Click Speed, setting 105
double-sided disks. See BOOK disks
dragging (mouse technique) 32,
84, 85
canceling 33, 35, 40, 85
documents into fo lders 60-61
icons 32-33, 60-61, 178-179
selecting by 54, 70-73, 90
Drive button (d ial og boxe:::) 67
Drive button (Apple HD SC
Setup) 23 1
Drive butto n (MiniFinder) 126
drive r resources. See Install e r
dumping screen 19 1
Duplicate command (File
menu) 11 8, 183

E
editi ng
documents 52-55, 56-57
text in Finder 92-94
Edit me nu 18-1-185
Clear command 91, 185
Copy command 54-55, 93, 185
Cut command 54-55, 93, 911,
185
Paste command 55, 93, 185
Select All command 90, 120,
185
Show Clipboard command 185
Undo command 185
BOOK disk d rive. See 3.5-inch disk
drive
BOOK d isks 151 , 152-153. See also
d isk(s)
initia lizing 134-135
Eject button (dialog boxes) 67
Eject button (M iniFinder) 126
Eject command (File menu) 136,
184
ejecting disks 136, 172-173, 191,
193, 22 1
Empty Folder 58-59, 11 5
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Empty Trash command (Spec ial
menu) 120, 188. See also
Trash icon
Ente r key 150
shortcuts w ith 190
Erase Disk command (Special
me nu) 134 , 152, 188-189
erasing. See Erase Disk command;
initializing
Esc key 148
expand ing me mory 207
expansion cards, installing 8-12
power requ ire me nts 242-243
expans ion cover shield 9-11
removing 10
expansion s lot cover 4
removing 10
expans io n slots 9-11
power require ments 242-213
external hard disk drive 226
F
fan, troubleshooting 221
Fi le menu 34, 181-184
Close command 44, 87, 127,
128, 182, 192
Duplicate command 118, 183
Eject command 136, 184
Get Info command 72, 78 , 121,
182-183
New command 114, 127
New Folde r com mand 58-59,
11 5, 181
Open command 35, 114,
128-129, 181-182
Page Setup command 124, 132,
183
Print Catalog command 124, 183
Print command 122-123, 132,
182
Put Away command 120, 183
Quit command 52
Save As command 56-58,
130- 131
Save command 50-52, 56, 130,
145-146
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files. See applications; documents;
system files
file server. See AppleShare
Finder 28, 155-159, 171 - 179. See
also hie rarchical file system or
specific Finder menu
checking version numbe r of 77
MiniFinder and 125-126
printing documents
from 122-123
shortcuts 192-193
view, changing 73
Finder button (MiniFinder) 126
Find File (Apple menu) 107-110,
167. See also hie rarchical file
system
Fi nd Fil e menu 107-110
Move to Desktop command 110
Search He re command 108
Fine Tune (Monitors, Control
Panel) 104
fo lde r(s) 37, 58-61, 115-11 6,
174-178. See also Find File;
hie rarch ical file system
copy ing 11 8-119
creating 58- 59, 115
dragging from or to 6~ 1 ; 179
e mpty 58-59, 115
moving from o r to 116, 119
naming 117, 154-155
nesting 61-64, 115 , 175-176
recovering 120
removing 120
renaming 59, 117
folder directory, printing 124
folde r icons 36
Font/DA Mover 95, 156- 157
fo nts. See Font/DA Mover; Key
Caps
fo rmatting disks. See initializ ing
400K disk drive. See 3.5-inch d isk
drive
400K d is ks 152- 153, 156. See also
disk(s)
initia lizing 134-135

G
General icon (Control
Pane l) 98-100
Get Info command (File
menu) 72, 78, 121, 182-183
graphics 197, 200
graphics tablet
connecting 16-17
Control Panel a nd 105
gray scale 102, 103
grounded outlets 3, 5
gu ided tour. See train ing disk

H
happy Macintosh icon 219
hard disk drive(s) 203, 226-239,
240. See also Find File;
hierarch ical file syste m
back ing up 233
care of 213
device prio rity number and 229
externa l 226
initializing 227-230
organizing files on 233
precautio ns 233-234
s hutting down 233-234
as startup d isk 232
test ing 231
troubleshooting 238-239
updati ng 230-231
hard disk installer. See Apple l-ID
SC Setu p
hardware 141. See also specific
device
hierarchical file system (HFS)
64-69, 152-153, 174-178.
See also Find File
initializing disks for 134-135
opening doc ume nts
th rough 64-67
saving documents
through 67-69
highlighted icons 32
hollow icons 36, 172

-

-

J

-

-

!-beam 30
icons 23, 27, 28, 52, 172, 219.
See also d ocuments; Edit
menu; text or specific icon
dimmed 172
d ragging 32-33, 60-61,
178-179
highlighted 32
hollow 36, 172
nami n g 117
opening 34-37, 43-44
renaming 59, 117
selecting 31-32, 70-73, 90-91,
178
ImageWrite r 205
printing with 122-124, 192
lmageWriter p rinting resource 165
Inactive button (Chooser) 96
information window. See Get In fo
command
Initialize buuon (Apple l-ID SC
Setup) 229
initializing
disks 134-135, 15 1- 153
hard disk urive 227-230
inserting text 92
insertion po int 49
blinking, setting rate of 98
se lecting 53
Installer 77, 139-140, 232
updating startup disks
with 139- 140
installe r, hard d isk. See Apple l-ID
SC Setup
install ing. See also Installer
expansion cards 8-12
MiniFinder 125
resources on startup
disks 139-140
Syste m Po lde r 137, 232
video card 8-12
internal 3.5-inch disk
drive 202-203
1/0 sh ie ld 9

joystick, connecting 16-17

K
keyboard 2, 3, 49, 146-151, 208
care of 214
connecting 14-17
Control Panel and 101
daisy-chaining mouse to 15-17
specifications 24 1
tro ubleshooting 220
keyboard cable 2, 15-17
keyboard connector 15-17
Keyboard icon (Control Panel) 101
Key Caps (Apple menu) 149, 168
Key Repeat Rate, selling 101

L
LaserWriter 205
printing w ith 122-124
LaserWriler printing resource 165
Le t's Quit button 26
lid (main unit)
re moving 8
replacing 12
local area network. See AppleTalk
Personal Network
Locked box (Gel Info) 121
locking
applications 121
d isks 153-154
documents 121

M
MacDraw 200
Macintosh Programmer's Workshop
(MP\'il) 208

Macintosh Quick Referen ce Card 2
Macintosh System Utilities User's
Guide 2

MacPa inl 197
creating documents from screen
with 19 1
MacProject 199
MacTerminal 198
MacWrite 196-197
main mon ito r (Monitors, Control
Panel) 104
main power input receptacle 4, 7
main unit 2, 4, 144
care of 5, 18, 212-2 13
cleaning 6
lid 8, 12
power cord 2, 6-7, 218
specifications 240-241
ventilation o f 5, 212, 221
me mory 100, 145-146, 240
documents and 145-146
expanding 207
men us 34. See also specific menu
blinking, setting 99
choosing commands from 34-37
pulling down 34-35
Min iPinder 125-126. See also
Pinde r; Use Min iPinder
command
installing 125
removing 126
modems 206
monitor(s) 2, 102-104, 206-207,
240. See also screen
a lign ing 104
care of 213
color 102-104, 166-167,
206-207
con necti ng 7-1 4
monoch rome 102-104,
166-167, 206- 207
positioning 104
power cord 2, 13-14
status, setting 102-104
troubleshooting 2 18
ventilation of 213
video cable 2, 12-13
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Monitors icon (Control
Pane l) 102-101, 166-167
monitor positio ns (Monitors, Control
Panel) 104
monitor power in put receptacle 13
monitor power o u tpu t receptacle 4,

nesti ng 61-64, 115, 175-176. See
also Find File; hierarchical file
system
network. See AppleTalk Personal
Network
New com mand (File menu) 114,

127

14
Mon ochrome button (Monitors,
Contro l Panel ) 102, 103
monochrome monitors 102-104,

166-167, 206-207
mouse 2, 29- 33, 84- 85
care of 214-216
clean ing 214-216
connecting 14-17
Contro l Panel and 105
d aisy-chaining to
k eyboard 15- 17
specificatio n s 24 1
troubleshooting 220
mouse bu tton 29
m o use cable 15
M ouse icon (Control Panel) 105
M ou se T racking, sett ing 105
M ove to Desktop command (Find
File menu) 110
m o v ing
from or to folders 116
images fro m Scrap book 112
pointer 30-31
text 93
to different d isk 119
w indows 39-40, 86
MPW ( Macintosh Programmer's
Workshop) 208

New Folder comman d (File
menu) 58- 59, 115, 181
Note Pad (Apple menu) 169
numeric k eypad 147. See also
keyboard

0
one-sided fo rmat 134- 135,
152-153. See also d isk(s)
Open button (dialog b oxes) 65
Open button ( MiniFinder) 126
Open command (File menu) 35,

114, 128-129, 18 1- 182. See
also hierarch ical file system
open in g
d ocuments 64-67, 11 4,

128-129, 145-1 46
icons 34-37, 43-44
O pen Other button
( MiniFinder) 126
Option key 149-150, 158
shortcuts w ith 192, 193
o rder o f precedence (startup
disk) 157
o rganizing files on hard d isk
drive 233
o utl ets, g ro unded 3, 5
overheating 221

N
nam ing 117
appl ic ations 117, 154-155
d isks 117, 154-155
documents 56-57, 117, 131,

154-1 55
fo lders 117, 154-155
icons 117

p
pack ing list 2
padlock icon 121
Paged Memo ry Management Unit
(PMMU) 240
Page Setup comman d (File
menu) 124, 132, 183
Paste comma nd ( Edit menu) 55,

93, 185
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pasting text 55
peripheral cards/slots. See
expansion cards; expansion
slots or specific card
peripheral devices. See specific

device
p l astic hole cover 1
removing 10
PMMU (Paged Memory Management
Unit) 240
poin ter
movin g 30-3 1
troubleshooting 220
port(s)
SCSI 4, 19, 144, 234-238
serial 4, 144
positio n ing mon itors 101
power 218
power cord
m ain unit 2, 6-7, 218
mon itor 2, 13-14
power icon 13
Power On key 4, 23, 27, 148
Power requirements ( for expansion
cards) 242-243
power strip 3
power supply case 8-9
power switch 4, 23
prepar ing disks. See initializing
pressing (mouse technique) 84
Print Catalog command (File
menu) 124, 183
Pr int command (File
menu) 122- 123, 132, 182
p rinters. See also ImageWr iter;
LaserWriter
choosing 122
p r intin g 122-1 24
active w indow (with
ImageWriter) 123, 192
directory window 124
documents 122- 123, 132
screen (w ith ImageWriter) 123,

192
print ing resources 155, 165. See
also Installer
i nstal ling 139-140

n

priority switch number 229
p roblems 25-26, 218-222,
238-239
processor 240
programs. See applications
project management 199
pulling down menus 34- 35
Put Away command (File
me nu) 120, 183

Q

question mark ico n 23, 27, 219
Quit button (Apple HD SC
Setup) 229-230
Quit command (File me nu) 52
q uitting TeachText 52

R
RAM (random-access memory),
expanding 207,240
RAM Cache, setting 100
Rate o f Insertion Po int Blinking,
setti ng 98
Read Me documents 74- 75,
170-171
recove ring 120
registration card 2, 3
removing. See also Trash icon
applications 120
desk accessories 95
documents 120
expansion cover sh ield 10
expansion slot cover 10
folders 120
images from Scrapbook 112
ma in unit lid 8
Minirinder 126
plastic hole cover 10
System Folder 137
text 94

re naming 11 7
applications 117
disks 117
documents 117, 131
folde rs 59, 117
icons 59, 11 7
re packing 3
repairs 217-218
replacing
main unit lid 12
text 93
resources 155, 165. See also
Insta lle r
installing 139-140
Restart butto n (MiniFinder) 126
Restart command (Special
m enu) 136, 189
Return key 49, 151
shortcuts with 190
RGB monitor. See AppleColo r HighResolution RGB Monitor
ROM memory 240
RS-232 d evices, SCSI port a nd 19
Runn ing Man icon (Find File) 109

s
sad Macintosh icon 219
safety instructions 5-6
Save As command (File
menu) 56-58, 130-131. See
also hierarchical file system
Save button (dialog boxes) 51
Save command (File
menu) 50-52, 56, 130,
145-146. See also hierarchical
fil e system
saving
documents 50-52, 56-58,
67--69, 130-131, 14 5-146
tro ubles hooting 220
scheduling 199
Scrapbook (Apple menu) 111- 112,
169-170
Scrapbook file 111-112, 170

screen 145-146. See also
monito r(s)
care of 213
cleaning 6
dumping 191
printing (with ImageWriter) 123,
192
troubleshooting 218
scro ll arrows 46-47, 88
scroll bars 36, 45-47, 86, 88-89
scroll box 47, 89
scrolling 88-89
SCSI (Small Computer System
Interface) devices
cables fo r 234-238
connecting 234-238
connectors 234-238
te rminators 234-238
SCSI (Small Compute r System
Inte rface) port 4, 19, 144,
234-238
RS-232 devices and 19
Search He re command (Find File
menu) 108
Select All command (Edit
menu) 90, 120, 185
Select box (Chooser) 97
se lecting (mouse techn ique) 31
by clicking 31-32
by dragging 54, 70-73, 90
insertio n point 53
by Shift-clicking 73, 91
text 54, 92
by typing 177- 178, 192
serial numbe rs 3
serial ports 1, 144
se rvice 217-218
Set Startup command (Special
menu) 189
setting
Date 99
Delay Until Repeat 101
Desktop Pattern 98
Double-Click Speed 105
Key Repeat Rate 101
Menu Blinking 99
Monitor Status 102-104

Index
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setting (continued)
Mouse Tracking 105
RAM Cache 100
Rate of Insertion Point
Blinking 98
sound contro ls 100, 106
Speaker Volume 100, 106
Startup Device 106
Tim e 99
settin g up the system 6-19
Sh ift-clicking (mouse
technique) 73, 84, 85, 9 1,
190
Shift key 49, 148, 190
s hortcuts 189- 193
Finde r 192-193
Show Clipboard command (Edit
me nu) 185
Shut Down command (Special
menu) 4, 136, 189, 233
s hutting down 4, 7, 26, 233-234
troubleshootin g 22 1
Single In-line Memory Module
(SIMM) 207
s ingle-sided disks. See 400K disks
size box 36, 37-39, 86, 87
slots. See expansion slots
software 145. See also applicatio ns;
system files
troubleshootin g 222
sound controls , setting 100, 106
Sound icon (Control Panel) 100,
106
sound jack 4
source disk. See copying
Speaker Volume, setting 100, 106
specifications 240-241
Special me nu 187-189
Clean Up command 188, 192
Em pty Trash command 120,
188
Erase Disk command 134, 152,
188-1 89
Restart comma nd 136, 189
Set Sta rtup comma nd 189
Shut Down command 4, 136,
189, 233
Use MiniFind er
command 125-126, 189
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Index

starting up 23-26, 27- 29, 48-49
TeachText 48-49
training disk 23-26
troubleshooting 25-26
tutorial 27-29
Startup Device icon (Contro l
Panel) 106
Startup Device, setting 106
startup d isks 48, 155-159
creating 137
c urrent 157-158
cus tomizing 156-157
desk accessories and 95
hard disk drive as 232
installing resources o n 139-140
updati ng 77-78, 139-140
s tatic e lectricity 6-7, 8-9
Stop icon (Find File) 109
stopping train ing disk 26
structured graphics 200
support 217-218
surge protector 3
sw itching current sta rtup
disk 157- 158
System file 155-159
checking vers ion numbe r
of 77-78
system fil es 37, 43, 155-159
installing 232
System fo lder 37, 43, 155- 159
installing 137
removing 137
Syste m Tools d is k 2, 26, 155-159
desk accessories and 95

T
Tab key 148
shortcuts w ith 191
TeachTexl 37, 170-171
quitting 52
Read Me documents and 74-75,
170-171
s tart ing 48- 49
te lecommunicatio ns 198, 206
te mpe rature 212, 22 1
te rmina to rs, SCSI 234- 238

Test button (Apple HD SC
Setup) 23 1
Test b utton (Monitors, Contro l
Panel) 102, 103- 104
testing
convergence patte rn (Monitors,
Control Panel) 102, 103-104
hard disk drive 231
text. See also documents; Edit
menu ; icons
cop ying 54-55, 93
cutting 54-55
editing 92-94
inserting 92
moving 93
pasting 55
removing 94
replacing 93
selecting 54, 92
13-inch mo nito r. See AppleColor
High-Resolutio n RG!3 Monitor
3.5-inch disk drive 152- 153,
202-203 , 240
time, setting 99. See also Alarm
Clock
title bar 36, 39, 86
training disk 2, 22-23. See also
TeachText; tutorial
starting up 23-26
stopping 26
Trash icon 29, 120, 174. See also
Empty Trash command
tro u bleshoot ing 25-26, 218- 222,
238-239
turning o n or off 4, 7, 23, 233
tutorial 22-23. See also TeachText;
training disk
starting up 27-29
12-inch monito r. See Apple HighResolution Mo nochro me
Monitor
two-s ided fo rmat 134-135,
152-153
typing
selecting by 177-178, 192
troubleshooting 220

n

u
Undo command (Edit menu) 185
unlocking
appl ications 121
disks 153-154
d o cumen ts 121
unpacking 2-4
Update butto n (Apple HD SC
Setup) 230-23 1
Update Folder 37, 74-75, 170-171
updating. See also Insta ller
appl icatio n d isks 77-78
hard disk drive 230-231
startu p disks 77-78, 139-140
Use MiniFinder command (Special
menu) 125-126, 189. See also
M ini Finder
User Name b ox (Chooser) 97
Utilities disk 2
desk accessories and 95
U tilities Fo ld er 37, 44, 227-23 1
utility programs 37, 44

v
ventilation
of main unit 5, 212, 22 1
of monitor 213
versio n number, checking. See
About command; Get Info
command

vertical bar, blinking 49
video cable 2
connecting 12-13
video card 2, 102, 103, 207
installing 8-12
p ower requirem ents 242-243
video card exp ansion kit 102, 103,

scroll arro w s and 46-47, 88
scroll bars and 36, 45-47, 86,

88-89
scroll box and 47, 89
scrolling through 88-89
size box and 36, 37-39, 86, 87
title bar and 36, 39, 86
zoom bo x and 36, 38-39, 86,

207
video icon 12-1 3
v ideo socket 12-13
View menu 186- 187
13y Date command 187
By Icon command 73, 186
13y Kind command 187
By Name command 73, 187
By Size command 187
By Small Icon command 186
volume (speaker), settin g 100,

106

87, 190
word processing 196-197
word wraparound 50
workstation software 201
w r istwatch 30

X
X icon 219

y

Your Apple Tour of Macintosh 11
Applications disk. See training

w
windows 36-37, 86-87, 159-1 60
activating 40-42, 86
active 40-42, 123, 192
ch anging size of 37-39, 87
close box and 36, 39, 45, 86,

87, 190
closing 44-45, 87
directory 36, 43-44
moving 39-40, 86

disk

Your Apple Tour of the Macintosh
II disk. See training d isk

z
zones (AppleTalk) 97, 165
Zones b ox (Chooser) 97
zoom box 36, 38-39 , 86, 87, 190
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il. Tell Apple About Your .... . ... .. . . . . .
0

Please contact your aulhorized Apple dealer when you have
trained by Apple Computer and ar e given the resources to h
you need lhe name of an aulhorized Apple dealer in your ar

0

Would you like to tell Apple what you lhink about this prod
product, we would like to hear from you. You can help us ~
questionnaire below and marking lhe appropr iate boxes on 1
have more lhan one response to a questio n, mark all lhe bo:
Apple. Include additional pages o f comments if you wish.
I. How would you rate the Macintosh II overall? (1 = poor. . . 6

2. Where did you purchase your Macintosh II? (1 = dealer, 2 = c
4 = university, 5 =govemment purchase, 6 =Certified Develor
3. Did you own an Apple computer before buying your Macir
4. How much experience have you had with computers? (1 = n
5. Where is your Macintosh II used most often? (1 =work, 2 =I
6. What software applications do you use most often wilh ym
3 =data base, 4 =communicayons, 5 =business graphics, 6 =•
7. What 3.5-inch disk drives do you use wilh your Macintosh I
4 =two o r more Apple external, 5=non-Apple external)
8. What type and size o f hard disk drives do you use w ilh yo
4 =40 MB, 5 =80 MB, 6 =olher, 7 =shared mass storage)
9. What is the memory configuration of your Macintosh II? (1
I 0. W hat monitors ar e you using with your Macintosh II? (1 = A
2 = AppleColorTM High-Resolution RGB Monitor, 3 =olher m
5 = large screen display, 6 = olher)
1 I . What printer do you use w ilh your Macintosh II? (1 =Laser~
4 =olher dot matrix primer, 5 =daisy wheel primer, 6 =olhe
12. What type of expansion cards are installed in your Macimo:
4 =performance accelerator, 5 = communications or networ~
13. If you are connected to a network , which type is it? (1 = Ap
14. Do you run lhe UNlx® operating system? (1 =no, 2 =yes)
15. What keyboard are you using wilh your Macintosh II? (1 =Ap
16. What olher devices do you use w ith your Macintosh II? (1 '
5= other Apple Desl<fop BusTM input device, 6 =olher)
I 7. How would you rate the product training disks overall? (1 =
18 . How would you rare the Macintosh II owner 's guide overal
19. Please describe any errors or inconsistencies you may have
would be help ful.)

-

20. What suggestions do you have for improving the Macintost

T hanks for your time and effort.
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Tuck end flap inside. back
cover ·when using manual.
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